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Limitation of Liability
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Indemnity
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employees, including its contractors and suppliers, harmless from any claim or demand, including reasonable attorneys' fees, made by any third party
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By using this program you voluntarily accept these terms and conditions. If you do not agree to these terms and conditions, uninstall the program and
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Chapter 1
Introduction

1.1

Welcome to the Hydrologic Engineering Center’s Reservoir Simulation
(HEC-ResSim) computer program. HEC-ResSim is the successor to the
“HEC-5, Simulation of Flood Control and Conservation Systems”

program (HEC, 1998). ResSim is comprised of a graphical user interface

(GUI), a computational program to simulate reservoir operation, data

storage and management capabilities, and graphics and reporting facilities.

The Data Storage System, HEC-DSS (HEC, 1995 and HEC, 2006b) is
used for storage and retrieval of input and output time-series data.

ResSim Modules

ResSim offers three separate sets of functions called Modules that provide

access to specific types of data within a watershed. These modules are
Watershed Setup, Reservoir Network, and Simulation. Each module

has a unique purpose and an associated set of functions accessible through
menus, toolbars, and schematic elements. Figure 1.1 illustrates the basic

modeling features available in each module.

Watershed Setup

Configurations

Projects
(Reservoirs, Diversions, Levees, etc.

Computatian Points

Stream
A l ignmenT

Reservoir Network

Networks
Reservoirs
+ Pool 1]
+ Outlets
+ Operation Sets
Reaches
Diversions
Junctions

Alternatives

Selection of
+ Network
* Operation Set
« Initial Conditions
« Time Series Data

Simulation

Simulations

Time Window
Selected Alternatives

Figure 1.1 ResSim Module Concepts
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1.1.1 Watershed Setup Module

The purpose of the Watershed Setup module is to provide a common
framework for watershed creation and definition among different
modeling applications. This module is currently common to HEC-
ResSim, HEC-FIA, and the CWMS CAVI.

A watershed is associated with a geographic region for which
multiple models and area coverages can be configured. A watershed
may include all of the streams, projects (e.g., reservoirs, levees),
gage locations, impact areas, time-series locations, and hydrologic
and hydraulic data for a specific area. All of these details together,
once configured, form a watershed framework.

When you create a new watershed, =01 My Watersheds
ResSim generates a directory structure =-C1 base

(see figure at right) for all files =-{1 BaldEagle
associated with the watershed. | 1 maps
#-0 res

----- 1 scripts
----- 1 shared

In the Watershed Setup module, you assemble items that describe a
watershed’s physical arrangement. Once you have created a new
watershed, you are able to import maps from external sources,
specify the units of measure for viewing the watershed, add layers
containing additional information about the watershed, create a
common stream alignment, and configure elements. You can also
add projects and create time-series icons within the Watershed Setup
module.

Chapters 3 through 7 describe the Watershed Setup module in more
detail.

1.1.2 Reservoir Network Module

The purpose of the Reservoir Network module is to isolate the
development of the reservoir model from the output analysis. In the
Reservoir Network module, you will build your network schematic,
describe the physical and operational elements of your reservoir
model, and develop the alternatives that you want to analyze. Using
configurations that are created in the Watershed Setup module as a
template, you will create the basis of a reservoir network. You will
then add routing reaches and possibly other network elements to
complete the connectivity of your network schematic. Once the
schematic is complete, physical and operational data for each
network element are defined. Also, alternatives are created that
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specify the reservoir network, operation set(s), initial conditions, and
assignment of DSS pathnames (time-series mapping).

Chapters 8 through 13 describe the Reservoir Network module in
more detail.

1.1.3 Simulation Module

The purpose of the Simulation module is to isolate output analysis
from the model development process. Once the reservoir model is
complete and the alternatives have been defined, the Simulation
module is used to configure the simulation. The computations are
performed and results are viewed within the Simulation module.

When you create a simulation you must specify a simulation time
window, a computation interval, and the alternatives to be analyzed.
Then, ResSim creates a directory structure within the rss folder of
the watershed that represents the simulation. Within this simulation
tree will be a copy of the watershed, including only those files
needed by the selected alternatives. Also created in the simulation is
a DSS file named simulation.dss, which will ultimately contain
all the DSS records that represent the input and output for the
selected alternatives. Additionally, elements can be edited and saved
for subsequent simulations.

Chapter 14 describes the Simulation module in more detail.

1.2 About this Manual

This User’s Manual is the primary reference for providing ResSim users
with detailed instructions for creating ResSim models and analyzing
simulation results. With the exception of the first and second chapters,
(which deal with introductory and core concepts), the chapters of this
manual group tasks according to module. Each chapter provides an
overview of key concepts and a detailed description of screen components
and tools available in the module, and then shows you how to carry out
specific tasks in the module. Appendices cover topics and tasks that
require levels of detail beyond the scope of an individual chapter.

The organization of this manual is summarized in Table 1.1.

The HEC-ResSim Quick Start Guide is a separate document that provides
a brief introduction and overview of the HEC-ResSim capabilities and
includes references to this User’s Manual for detailed information.
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Table 1.1 Summary of Contents of HEC-ResSim User’s Manual

HEC-ResSim Module If you want to find out... Refer to...
7~ Concepts of HEC-ResSim Chapter 2
How to create and manage watersheds Chapter 3
How to work with map layers Chapter 4
How to establish a stream alignment Chapter 5
Watershed Setup < How to create an<_j define watersheo! Chapter 6
elements and projects (e.g., reservoirs,
levees, etc.)
How to create computation points Chapter 6
(hydrograph locations)
\_ How to create watershed configurations Chapter 7
~~ How to develop reservoir networks Chapter 8
How to edit element data (junctions, routing Chapter 9
reaches and diversions)
How to define physical reservoir data Chapter 10
Reservoir Network < How to edit physical reservoir data Chapter 10
How to develop reservoir operation data Chapter 11
How to define reservoir systems Chapter 12
\_ How to define alternatives Chapter 13
How to develop and execute simulations Chapter 14
) ) How to analyze results Chapter 14
Simulation .
How to calibrate model Chapter 14
How to manage simulations Chapter 14
Detailed application settings Appendix A
How to define the coordinate system Appendix B
How to edit maps Appendix C
How to change colors Appendix D
How to use HEC-DSSVue Appendix E
How to copy, export, and print tables Appendix F
References Appendix G
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Chapter 2
ResSim Concepts

Before you begin working with the individual modules available in
ResSim, you will need to understand the concepts that will allow you to
develop, access and interact with watersheds in ResSim.

This chapter begins with the following basics: explaining how to start
ResSim; describing screen components that are common across modules,
including menu items and map/mouse tools; and showing you how to
create a new watershed or open an existing watershed.

Next, you will learn about the following four kinds of schematic elements
in ResSim: Time-Series Icons, the Stream Alignment, Watershed (Study)
Components, and the Model Schematic. This chapter also explains how to
interact with schematic elements using right-click shortcut menus, which
allow you to plot and tabulate data, edit model data, and edit common
components of the watershed.

Layers are another concept in ResSim. This chapter will help you to
understand how layers work in ResSim and describe the six kinds of
layers: Time Series, Study, Stream Alignment, Gridded Data, Model
Schematic, and Maps.

To work with Layers, you will use the Layer Selector. This chapter
describes the components of the Layer Selector, including its menu items
and layout, and shows you how to control layer display using the Layer
Selector. You will learn how to view layer legends, organize layers,
configure toolbar icons to control layer display, and add and remove map
layers.

Each layer has a unique set of properties that you can configure to make
your watershed display look the way you prefer. This chapter shows you
how to use Properties Editors and other tools to configure the properties of
Time Series, Study, Stream Alignment, Gridded Data, Model Schematic,
and Map layers.
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2.1 Starting ResSim

To begin working with the Watershed Data Sets, you must first start
ResSim. Either double-click the HEC-ResSim icon on your PC’s desktop,
or from the Start menu, select Programs — HEC — ResSim. Once you
start ResSim, an information screen (as shown in Figure 2.1) will appear
briefly; then, ResSim’s Main Window will open (Figure 2.2).

HEC-ResSim

Version 3.0

Hydrologic Engineering Center
Institute for Water Resources
US Army Corps of Engineers
609 Second Street

Davis, CA 95616

Ug Army Carps .
ofEngineers www.hec.usace.army.mil

Figure 2.1 ResSim Information Screen

TlﬂelBar Dlsplay Area

% HEC-ResSim 3.0

Menu Bar —»

Tools  Help

Module List —»

Toolbar—

[0 2 BAENMEP [+ (@ [Fol7]) E _

< >
Status Bar —»| | Reary ! = —

Figure 2.2 ResSim Main Window
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2.2 Recognizing Common Screen Components

ResSim offers three modules, each with its own functions and module-
specific tools, menus, and output. However, the modules share common
screen components, as previously illustrated in Figure 2.2.

The Title Bar displays the ResSim title. After a watershed is opened, the
name of the watershed will appear.

The Menu Bar contains menus for the modules. The items on the menus
change as you switch between the modules, offering module-specific
commands. You can select a menu item by clicking on the name of the
menu (such as File), then pointing and clicking on the item you wish to
select. Section 2.2.1 describes the Menu Bar in more detail.

The Module List contains all the available modules of ResSim. Use this
list to move between the Watershed Setup module, the Reservoir Network
module, and the Simulation module. Section 2.2.2 describes the Module
List in more detail.

The Display Area is the geographic-referenced (geo-referenced) map
space where all model schematic objects (reservoirs, junctions, diversions,
etc.), watershed objects (stream alignments, reservoirs, stream reaches,
etc.), and map layers are shown. You can manipulate elements and view
results in the modules through the use of the tools in the Toolbar. Tools
that affect the Display Area can have different functions depending on
which module is selected.

The Status Bar displays map coordinates of the pointer in the display area
when you are interacting with the watershed. When the pointer is outside
of the display area, the Status Bar reflects the status of the program.

The General Message Bar displays a scrolling list of messages. System
output log information appears in this window from the time you start
ResSim until you exit the program. The scroll buttons on the right end of
the Message Bar control the display and allow you to review all messages
received during your ResSim session.

2.2.1 Menu Bar

In the Menu Bar, the File, View, Tools, and Help menus contain
commands you can access from all three ResSim modules. Some of
these menus also contain module-specific commands that appear only
within individual modules. Commands and options that are common
to all three modules are described as follows:
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The File menu (Figure 2.3) allows you to

create a New Watershed, Open an existing New Watershed...  Ctri+
watershed, Save a watershed, Save Map Open Watershed... Chrl+0
(the Display Area) and Exit ResSim. Your Save Watershed  Ctri+5
most-recently-used watersheds are located Save Map As...

at the bottom of the File menu. When a Exik ChrlHG
watershed is opened, the remaining menu 1 BaldEagleDemn

items become active. Figure 2 3 File Menu

In the View menu (Figure 2.4), select Zoom

. WWatershed Repi
to All to restore your watershed view to full

size after zooming in on one portion. Layers Zoom to Al

opens the Layers Selector dialog box which S0

is used to select the spatially referenced Unit System ’
layers (map/coverage). Unit System allows Restore Windows

you to see the current screen view settings.
You can view data using whichever Unit
System you prefer (English or SI); however,
the Watershed (native) Unit System is established when a watershed
is created (see Chapter 3, Section 3.3.3) and cannot be changed
afterward (see Tools menu for Watershed information). Lastly, if a
dialog or editor window is open but inactive, Restore Windows
brings the dialog or editor window to the front as the active window.

Figure 2.4 View Menu

The Tools menu (Figure 2.5) provides Help
access to HEC-DSSVue, which you will use HecDsshue
to view (and possibly edit) dssfiles that are Seripts
used for storing primarily time-series data. Dptim;'

The Scripts command allows you to create,
open and edit scripts (the scheduling of
scripts is accomplished in the Simulation
Module, from the Edit Menu). Figure 2.5 Tools Menu
Options lets you specify the following:

Console Cukput, .

Information. ..

Model Directories (watershed locations for storing your
watersheds); a Cache Directory (for caching map files); Compute
Display settings (set the colors for compute messages and the
format of log files); Debug Levels (set the level of debug
messages); General (choose whether or not you want a
confirmation message to appear when you exit ResSim and choose
whether you want the last watershed reloaded at startup of the
program); and, Fonts (for various window components).

The Console Output displays the messages written to the
“ResSim.log” file (typically found in the User’s Documents and
Settings Local Temporary folder named “HEC_LOGS”).
Information provides details about client, user, and watershed
settings as well as server and system properties.
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In the Help menu (Figure 2.6), the

About command displays

information about the version of Quiick, Skart Guide
ResSim. Also, from this menu you User's Manual
can access user documentation and
Install Example Watersheds (after
you define a watershed location as
described in Section 3.3.1). Figure 2.6 Help Menu

Install Example Watersheds. .

About

In addition to the four common menus described above, the following
two menus appear in all three modules but contain module specific
commands:

Edit — Typically, the edit options will be relevant to data
element(s) for a specific module. The edit options available for
each module are described in more detail in subsequent sections of
this chapter.

Reports — Provides access to reports produced for a specific
module. The reports available for each module are described in
more detail in subsequent sections of this chapter.

2.2.2 Module List

From the ResSim main window (Figure 2.2) the graphical user
interface (GUI) is organized to provide the necessary information to
enter data, review data, edit data, run a simulation, and view results.
The steps are divided into separate sets of functions called modules.
A module has a specific set of commands that are accessed through
menus and toolbars. Each module provides access to specific types of
data or results. The modules of ResSim are as follows:

Watershed Setup — create a stream alignment, define projects
(e.g., reservoirs, levees), define computation points, identify
impact areas, create configurations for the watershed, and define
time-series icons that represent specific locations or time-series
identifiers. Section 2.3 provides more details of this module.

Reservoir Network — create networks, add routing reaches, edit
elements, create and edit alternatives including assigning the DSS
pathnames for time-series references. Section 2.4 provides more
details of this module.

Simulation — define simulations for a watershed. A simulation
consists of a time window and the ResSim alternatives you wish to
execute for the simulation. Within this module, you can also edit
element data. Once a simulation is defined, a compute is
performed and the results are analyzed using graphical and tabular
output. Section 2.5 provides more details of this module.
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Each module has a menu bar and toolbar that are very similar for all

of the modules. Example windows for each of the modules are

presented in subsequent sections of this chapter.

2.3 Watershed Setup Module

The Watershed Setup module is used to create and setup your watershed.

From the Module list, select Watershed Setup. The main window and

the different components for the Watershed Setup module are illustrated

in Figure 2.7.

Title Bar Display Area Setup Lock

l

X HEC-ResSim 3.0 - BaldEagleDemo

Menu Bar —— | File Edit ‘iew ‘Watershed Reports Took Help

Module LiSt_> Module: Watershed Setup Configuration |Existing h @
I 4
[XJ¢—Pointer/Selector Tool
Zoom Tool —»| Q] i
[™}4—Pan Tool Configuration
Stream [@ ——Time-Series Icon Tool List
Alignment ——
Tool [#J¢—— Stream Node Tool
Project __|
Tools s

<4— Impact Area Tool

(@) [

4—— Computation Point Tool

General Message Bar

<

Status Bar —

Coordinates: 1851666 east, 386538 north Local Woarkspace BaldEagleDemo opened v

Figure 2.7 Watershed Setup Module

The Menu Bar (in Figure 2.7) contains the menus for the Watershed
Setup module. In addition to the four common menus described in

Section 2.2.1, the following list is a description of the available menus in

the Watershed Setup module.

Edit — From this menu, you can edit study information and view
watershed information, edit global information for impact areas

and projects, and adjust the colors and fonts used by the individual

projects. Also, you can set the lock for editing the stream
alignment and/or configurations. Available commands are:
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Watershed Data, All Impact Areas, Projects, Drawing
Properties, and Allow Editing.

Watershed — From this menu, you will create and edit
configurations. You can also import and/or export the Stream
Alignment and Impact Areas. Available commands are:
Configuration Editor, Update Computation Points, Import,
Export, and Save Configuration.

Reports — From this menu, you can review reports. These reports
contain information about the streams, watershed elements, and
configurations for the watershed. The available reports are: List
of Streams, List of Impact Areas, List of All Configurations,
List of Computation Points, and Projects.

The Configuration List (in Figure 2.7) shows the current configuration.
Configurations are created, edited, and deleted in the Watershed Setup
module. See Chapter 7 for discussion on Watershed Configurations.

The Setup Lock &' (in Figure 2.7) allows you to edit the stream
alignment and the current configuration. This lock prevents others from
editing the stream alignment and configuration elements while you are
editing.

The Display Area (in Figure 2.7) is where you create and view the stream
alignment, projects, impact areas, and computation points through the use
of the available tools in the Watershed Setup module. The following are
descriptions of the available tools:

M Pointer/Selector Tool —this tool can be used to edit, rename, and
delete elements. To access, select the Pointer/Selector Tool, click
the right mouse button (right-click) on an element, and the
commands are available from a shortcut menu.

g Zoom Tool - this tool allows zooming in and out of the display
area. To zoom in, hold the left mouse button down and outline the
area you want to zoom in on. To zoom out, right-click in the
display area.

ﬂ Pan Tool — this tool can be used to move the display area while
you are zoomed in. To do this, hold down the left mouse button
and drag the mouse in the direction you would like to pull the
display area.

) Time-Series Icon Tool - this tool is used to create, delete, and
rename time-series icons used for plotting and tabulating time-
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series data. To create, select the Time-Series Icon Tool, hold
down the CTRL key and click. To access the available
commands, select the Time-Series Icon Tool, right-click on a
time-series icon, and the commands are available from the shortcut
menu.

Stream Alignment Tool - this tool is used to create, delete, and
edit stream elements that make up the stream alignment.

Stream Node Tool - this tool is used to create, delete, and edit
stream nodes on the stream alignment.

Impact Area Tool - this tool is used to create, delete, rename, and
edit impact areas. To create, select the Impact Area Tool; hold
down the CTRL key while clicking the mouse button. Each click
creates a vertex point, which is the boundary of the polygon.
When reaching the end point, release the CTRL key and double-
click. An impact area element is now visible. To access the
available commands, select the Impact Area Tool, right-click on
the impact area, and the commands are available from the shortcut
menu.

Computation Point Tool - this tool is used to create, edit, rename,
and delete computation points. Computation points are locations
where time-series information is to be exchanged between models.
For ResSim, this might be a control location for reservoir
operations, a location where flows will be input, a location where a
hydrograph is needed for FIA, etc. To create a computation point,
select the Computation Point Tool, hold down the CTRL key
and click on the stream alignment at the appropriate location. To
access the available commands, select the Computation Point
Tool, right-click on the computation point, and the commands are
available from the shortcut menu.

Project Tools:

A

Reservoir Tool - this tool is used to create, delete, and rename
reservoirs and to edit reservoir setup data (e.g. Description, Label
Position, Year in Service, etc), as described in Chapter 6, Section
6.1.1). To create a reservoir, select the Reservoir Tool. A
reservoir has to be created on the stream alignment. Hold down
the CTRL key and click on the upstream end of the reservoir pool,
release the CTRL key, drag along the stream alignment to the
downstream end of the reservoir pool and click, and then name the
reservoir. To access available commands, select the Reservoir
Tool, right-click on the reservoir, and the commands are available
from the shortcut menu.
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Levee Tool - this tool is used to create, delete, rename, and edit
levees. To create a levee, select the Levee Tool. A levee has to be
created on the stream alignment. Hold down the CTRL key and
click on the upstream end of the levee, release the CTRL key, drag
along the stream alignment to the downstream end of the levee and
click. To access available commands, select the Levee Tool, right-
click on the levee, and the commands are available from the
shortcut menu.

Diversion Tool - this tool is used to create, delete, rename, and
edit diversions. To create a diversion, select the Diversion Tool.
A diversion has to begin on the stream alignment. Hold down the
CTRL key and click on the stream alignment. Each click creates a
vertex point, along the diversion. When reaching the end point of
the diversion release the CTRL key, and click. To access
available commands, select the Diversion Tool, right-click on the
diversion, and the commands are available from the shortcut menu.

Channel Modification Tool - this tool is used to create, delete,
rename, and edit channel modifications. To create a channel
modification, select the Channel Modification Tool. A channel
modification has to be created on the stream alignment. Hold
down the CTRL key and click on the upstream end of the channel
modification, release the CTRL key, drag along the stream
alignment to the downstream end of the channel modification and
click. To access available commands, select the Channel
Modification Tool, right-click on the channel modification, and
the commands are available from the shortcut menu.

Off-Channel Storage Area Tool - this tool is used to create,
delete, rename, and edit off-channel storage areas. To create an
off-channel storage area, select the Off-Channel Storage Area
Tool and hold down the CTRL key while clicking the mouse
button. Each click creates a vertex point, which is the boundary of
the polygon. When reaching the end point, release the CTRL key
and double-click. An off-channel storage area element is now
visible. To access available commands, select the Off-Channel
Storage Area Tool, right-click on the off-channel storage area,
and the commands are available from the shortcut menu.

Other Project Tool - this tool is used to create, delete, rename,
and edit other projects. This tool enables the placement of
elements that represent "other" projects, such as pump stations and
gages. To create an “other” project, select the Other Project Tool
and hold down the CTRL key and click. To access available
commands, select the Other Project Tool, right-click on the other
project, and the commands are available from the shortcut menu.
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2.4 Reservoir Network Module

The Reservoir Network module is used for editing element data and
placing additional elements onto the stream alignment. From the Module
list, select Reservoir Network. The main window and the different
components for the Reservoir Network module are illustrated in

Figure 2.8.

Title Bar Display Area Network Lock

? HEC-ResSim 3.0 - BaldEagleDemo

Menu Bar —P File Edit view Network alternative Togls  Help
Module List —» Metwark: | none 5 £ configuration: | none 5
*—Pointer/ Selector Tool l “
Zoom Tool — [Q]
<—Pan Tool Network Box Configuration Box
[A] ¢— Reservoir Tool (“currently opened”  (used by “currently opened”
<+—Diverted Outlet Tool Reservoir Network) Reservoir Network)

[Fle— Routing Reach Tool
E] <4—— Junction Tool

4— Diversion Tool

General Message Bar

< >
Status Bar —¥ | Reay Local Workspace BaldEanleDerno opened v =]

Figure 2.8 Reservoir Network Module

Your network elements will not be shown in the Display Area
until you create or open a network from the Network Menu.

The Menu Bar (in Figure 2.8) contains the menus for the Reservoir
Network module. After a reservoir network has been created or opened
and is shown in the Display Area, the menus and their commands will
become active. In addition to the four common menus described in
Section 2.2.1, the following list is a description of the available menus in
the Reservoir Network module.
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Edit — From this menu, you can edit Reservoirs, Routing Reaches,
Junctions, Diversions, and Reservoir Systems. State Variables can
be created or edited, and Elements can be Imported. Also, you can
set the lock for editing the reservoir network. Available
commands are: Reservoirs, Reaches, Junctions, Diversions,
Reservoir Systems, State Variables, Import Elements, and
Allow Network Editing.

Network — From this menu, you will create, open, save, rename
and delete reservoir networks. You can also update a network to
recognize revisions made to its configuration within the Watershed
Setup module. Available commands are: New, Open, Save, Save
As, Rename, Update Network from Configuration, and Delete
Networks.

Alternative — From this menu, you will open the Alternative
Editor that will enable you to create, edit, save and delete
alternatives. The only command available from this menu is Edit.

Reports — From this menu, you can review reports that list the
elements for the currently opened network. These reports contain
information about the reservoirs, routing reaches, junctions and
diversions. Also, advanced network summary listings are
available. The available reports are: Reservoir List, Reach List,
Junction List, Diversion List, and Advanced.

The Network box (in Figure 2.8) shows the “currently opened” Reservoir
Network. You will not see a watershed schematic in the Display Area
until you create or open a network.

The Configuration box (in Figure 2.8) shows the configuration the
currently opened Reservoir Network is based upon. If you make changes
to the network’s Configuration (within the Watershed Setup module), then
you can update the network(s) that use that configuration to recognize
those revisions by selecting the Update Network from Configuration
command from the Network menu.

The Network Lock &' (in Figure 2.8) allows you to edit the elements
within the Reservoir Network. This lock prevents others from editing the
elements while you are editing.

The Display Area (in Figure 2.8) is where you create the routing reaches
for your Reservoir Network. Also, you can edit the elements through the
use of the available tools in the Reservoir Network module. The
following are descriptions of the available tools:

]

Pointer/Selector Tool —this tool can be used to edit, rename, and
delete elements. To access, select the Pointer/Selector Tool,
right-click on an element, and the commands are available from a
shortcut menu.
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Zoom Tool - this tool allows zooming in and out of the display
area. To zoom in, hold the left mouse button down and outline the
area you want to zoom in on. To zoom out, right-click in the
display area.

Pan Tool —this tool can be used to move the display area while
you are zoomed in. To do this, hold down the left mouse button
and drag the mouse in the direction you would like to pull the
display area.

Reservoir Tool — even though this tool can be used to create and
delete reservoirs (which would normally be done within the
Watershed Setup module) the typical use of this tool in the
Reservoir Network module is for editing reservoir model data.
Editing Physical and Operational reservoir data is discussed in
detail in Chapter 10. To access available commands, select the
Reservoir Tool, right-click on the reservoir, and the commands
are available from the shortcut menu.

Diverted Outlet Tool - this tool is used to create, edit, rename,
and delete diverted outlets from a reservoir. To create a diverted
outlet, select the Diverted Outlet Tool. A diverted outlet must
originate from a reservoir. Hold down the CTRL key and click on
the appropriate reservoir, release the CTRL key, move the mouse
pointer to a location in the watershed that will receive the diversion
from the outlet and click. It is possible to create a diverted outlet
that re-enters the network system. To do this, continue holding
down the CTRL key and click to create vertex points and release
the key when you are ready to place the final point back into the
system. To access available commands, select the Diverted
Outlet Tool, right-click on the diverted outlet, and the commands
are available from the shortcut menu.

Routing Reach Tool - this tool is used to create, edit, rename, and
delete routing reaches. A routing reach must be created between
junctions and will follow the stream alignment. Attempting to
create a reach where junctions don’t exist will automatically
generate junctions at the upstream and downstream ends of the
reach. To create a routing reach, select the Reach Tool, hold
down the CTRL key and click on the junction at the upstream end
of the reach, release the CTRL key, drag along the stream
alignment to the junction at the downstream end of the reach and
click. To access available commands, select the Reach Tool,
right-click on the routing reach, and the commands are available
from the shortcut menu.

Junction Tool - this tool is used to create, edit and delete
junctions. To add junctions (before creating routing reaches),
select the Junction Tool, hold down the CTRL key and click on
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the stream alignment where you want to create the junction. To
access available commands, select the Junction Tool, right-click
on the junction, and the commands are available from the shortcut
menu.

Diversion Tool - this tool is used to create, edit, rename, and
delete diversions. To create a diversion, select the Diversion Tool.
A diversion must begin from a junction. Hold down the CTRL
key and click on the junction from which the diversion will occur.
If you continue to hold down the CTRL key, each click creates a
vertex point along the diversion. When reaching the end point of
the diversion release the CTRL key, and click. Diversions can re-
enter the network or leave the network system entirely. To access
available commands, select the Diversion Tool, right-click on the
diversion, and the commands are available from the shortcut menu.

2.5 Simulation Module

The Simulation module is used to perform a simulation (compute), edit
element data and view results. From the Module list, select Simulation.
The main window and the different components for the Simulation
module are illustrated in Figure 2.9.

Menu Bar —»

Module List —|

? HEC-ResSim 3.0 - BaldEagleDemo
File Edit Wiew Simulation Tools  Help

Zoom Tool —

<

Module: |Simulation 4

4— Pointer/Selector Tool “

Title Bar Display Area Control Panel

v Simulation:
Lookback:

4— Pan Tool Ent

4 Mo Simulation

Scripts
General Message Bar

Status Bar —  Ready

A 4
Local Warkspace BaldEagleDemo opened = :]

Figure 2.9 Simulation Module
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The Menu Bar (in Figure 2.9) contains the menus for the Simulation
Module. After a simulation has been created or opened and is shown in
the Display Area, the menus and their commands will become active. In
addition to the four common menus described in Section 2.2.1, the
following list describes the available menus in the Simulation Module.

Edit — From this menu, you can edit the list of scheduled Scripts,
make an Alternative Active, and edit Reservoirs, Routing Reaches,
Junctions, Diversions, Reservoir Systems, and State Variables.
Available commands are: Script List, Set Active Alternative,
Reservoirs, Reaches, Junctions, Diversions, Reservoir Systems,
and State Variables.

Simulation — From this menu, you can create, open, re-open,
close, edit, save, and delete simulations. You can also get
information about the currently opened simulation and define
release and target elevation overrides. Available commands are:
New, Open, Re-Open, Close, Edit, Save, Delete, Info, and
Release Overrides.

Alternative — From this menu, you can edit alternatives. This
menu only becomes active when a simulation is open. The only
available command is Edit.

Reports — The available reports summarize results and provide
network input summaries for the currently opened simulation.
Available commands are: Reservoir Summary, Flow Summary,
Power Summary, Gates Summary, Stage Summary, Release
Decision, User Reports, Compute, and Network.

The Display Area (Figure 2.9) is where your stream alignment and
watershed elements are displayed. You can view simulation results and
edit projects and computation points through the use of the available tools
in the Simulation Module. The following are descriptions of the
available tools:

]

Q]

o

Pointer/Selector Tool —this tool can be used to edit projects and
computation points, plot hydrographs, and view results. To access
this tool, select the Pointer/Selector Tool, right-click on a location
and select commands from the shortcut menu.

Zoom Tool - this tool allows zooming in and out of the display
area. To zoom in, hold the left mouse button down and outline the
area to which you want to zoom. To zoom out, right-click in the
display area.

Pan Tool — this tool can be used to move the display area while
you are zoomed in. To do this, hold down the left mouse button
and drag the mouse in the direction you would like to pull the
display area.
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The Control Panel (Figure 2.9) shows the time window for the currently
selected simulation in the Simulation Module. Also from the Control
Panel you can manipulate simulations and alternatives.

2.6 Opening an Existing Watershed

With the ResSim main window open, you will need to open a watershed.
In ResSim, a watershed is a data set associated with a geographic region
for which you may configure multiple models and area coverages. A
watershed may include all of the streams, projects (reservoir, levees),
gage locations, impact areas, time-series locations, and hydrologic and
hydraulic data for a specific area. All of these details together, once
configured, form a watershed data set.

You may open an existing watershed from any of the modules (if you need
to create a new watershed, refer to Chapter 3). Three methods of opening
an existing watershed are available:

First, you can specify that your previously opened watershed be
automatically opened by selecting Reload last Watershed at Startup
from the General tab of the Options dialog box (Figure 2.10) from the

Tools menu.
% HEC-ResSim 3.0 Options X]
Model Directories Cache Directory Compute Display
Dehug Levels General Fonts Simulation ResSim Compute
Settings:

Show Confirm On Exit

Feload lastWatershed at Starug

| ok || cancel

Figure 2.10 Tools Menu, Options Dialog Box, General Tab:
Reload last Watershed at Startup

Second, if you have opened the watershed before, you can select it from
the list of most-recently-used watersheds, located at the bottom of the File
menu.
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Third, you may use the Open Watershed dialog to open the watershed, as

follows:
1. On the File menu,
click Open i
WaterShed The Available Locations Bvailabls Watersheds
Open Watershed e
dialog box (Figure Hares®

2.11) will open.

2. Select a watershed
from Available

Watersheds (see
Chapter 3, Figure 2.11 Open Watershed Dialog Box

Section 3.3.1 for

information on

defining Watershed Locations). The Current Watershed box
displays the watershed that is currently open, if any.

3. Click OK. The Open Watershed dialog box will close and the
watershed you have selected will load and appear in the main
window with the watershed name shown in the title bar.

watershed is open and you attempt to open another, the
program prompts you to save the current watershed. If you do
not save, any changes you have made to the current watershed
will be lost.

i You can have only one watershed open at a time. Therefore, if a

2.7 Understanding Schematic Elements

Schematic elements in ResSim allow you to represent watershed, reservoir
network, and simulation data visually in a geo-referenced context. You
create schematic elements and edit their properties in the Watershed Setup
Module (Chapters 3 through 7) and the Reservoir Network Module
(Chapters 8 through 13). In the Simulation Module (Chapter 14), you can
plot and tabulate data by using the shortcut menus associated with the
schematic elements.
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2.7.1 Stream Alignment

The Stream Alignment (Figure
2.12) is a common component of
the watershed. To create it, use
the map (mouse) tools in the
Watershed Setup Module to draw
multi-segmented lines into the
map display and to mark nodes
and stream junctions.

Stream elements (segments),
stream nodes, and stream
junctions are the components of a
Stream Alignment. See Chapter 5 for more detailed information on
creating and editing a Stream Alignment.

2.7.2 Other Watershed Elements

Other watershed elements include Projects, Computation Points,
Impact Areas and Time-Series Icons. Create watershed elements in
the Watershed Setup Module (Chapter 6).

Figure 2.12 Stream Alignment

These watershed elements are common components of a watershed
that multiple models can reference (e.g., ResSim and FIA). To
represent the elements, you use the Watershed Setup Module’s map
(mouse) tools to insert icons and draw polygons and multi-segmented
lines into the map display.

Projects include Reservoirs (Figure 2.13), Levees (Figure 2.14),
Diversions (Figure 2.15), Channel Modifications (Figure 2.16), Off-
Channel Storage (Figure 2.17), and Other Projects like pump stations
and agricultural diversions (Figure 2.18).

r e
Figure 2.13 Reservoir Figure 2.14 Levee Figure 2.15 Diversion

- Lol / s P E
/ ! L‘:_:l_r«.-."”ar: 0l '!'f e ﬂ!:.p!l e

Figure 2.16 Channel Figure 2.17 Off- Figure 2.18 Other
Modification Channel Storage Project
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Computation Points
(Figure 2.19) are common
points where data is
exchanged between
models (e.g., between
ResSim and HEC-FIA).
To represent these points,
you use the map (mouse)
tools to insert icons into
the map display.

Impact Areas (Figure
2.20) are common
elements representing
distinct portions of a
watershed affected by
rising stage in a stream,
river, lake, or reservoir
where flood damages will

hdarsh Chk Jot

MIII Hall

-
Flshlng Ch Jot

Bald Eagle Total

(AN ==

Figure 2.19 Computation Points

Figure 2.20 Impact Areas

be evaluated. Impact areas can be included in your ResSim model for
consistency with your HEC-FIA model; however, the only
computations performed in ResSim are related to the computation
points corresponding to the FIA index locations.

For more information about Impact Areas, refer to the HEC-FIA

User’s Manual (HEC, 2003).

Time-Series Icons (Figure 2.21) indicate

l} Diversion

sites where time-series data is available. You | ®]Junctiona
can use Time-Series Icons to represent the €3 JunctionB

locations of gages or Time-Series locations.

For more information about Time-Series
Icons, refer to the CWMS User’s Manual

(HEC, 2006a).

Reservoir
Sink

Source

Subbasin
@ TimeSeries

| | Ig}It::n b

Figure 2.21
Time-Series Icons

2.7.3 Reservoir Network Schematic

The Reservoir Network Schematic, which you develop in the
Reservoir Network Module (based on a Configuration created in the
Watershed Setup module), is a template for simulation computations.
The graphical elements allow you to access data editors and specify
properties of reservoir network components.
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The Reservoir Network
Schematic (Figure 2.22)
displays geo-referenced ,
graphical representations
of Reaches, Diversions,
Junctions, and
Reservoirs. When you
interact with these
representations in the
Simulation Module, you
are able to view results
from the ResSim
model’s observed and Figure 2.22 Reservoir Network Schematic

computed hydrographs.

“Geo-referencing does not influence ResSim’s model
data (i.e., Routing criteria is not automatically changed
if adjustments are made to the Stream Alignment).

The Schematic is visible in the Reservoir Network module only
when a Network has been opened and in the Simulation module only
when a Simulation Alternative is set as active.

2.7.4 Using Shortcut Menus

Shortcut menus display when you right-click on schematic elements
in the map display and other ResSim components such as plots,
tables, and “tree structures”. In ResSim, shortcut menus offer a
variety of commands and options that allow you to access data
editors, plot and tabulate data, view reports, compute Simulations, and
more. Specific shortcut menu commands and options are described
throughout this manual.

2.8 Printing and Exporting Reports

From each individual report there is a shortcut menu that allows you to
print the report, preview the report before you print, and export the report
to an ASCII delimited file. Right-clicking on the active report accesses
the shortcut menu. Another way to print or export the reports is by
clicking on Export or Print from the report’s Report menu (in the
Reservoir Network or Simulation module) or from the report’s File menu
(in the Watershed Setup module). Either method accesses the same dialog
boxes.

2.8.1 Printing Reports

The output will be a print of the screen image of the active report. If
items in the columns of the report are not printing, you can use the
mouse to resize the column widths and the width of the entire report
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dialog box if you need to see more detail. To do so, roll the mouse
pointer over one of the lines that delimit the columns or over the
dialog box border. You can click on that line with the left mouse
button and drag the mouse from side to side to indicate how wide you
want the columns or dialog box. If you end up highlighting some
cells in the table, then you probably moved the mouse slightly just
before you pressed the button.

To print a report from the Watershed Setup module:

1. You must have a report
selected (opened). For

example, from the Reports

menu in the Watershed
Setup module, select List
of Computation Points
(Figure 2.23).

2. From the File menu of the
opened report, select Print
(Figure 2.24). Or, you can

right-click anywhere within

the tabulated data of the

report and from the shortcut

menu select Print (Figure

2.25).

Module: [Watershed Setup

e

? HEC-ResSim 3.0 - BaldEagleDemo
File Edit View ‘Watershed NS

Tools  Help

List of Streams

List of Impact Areas
List of All Configurations

mputation Points

Projects

L3
S d .

Figure 2.23 Selecting a Report

k) BaldEagleDemo - List of Computation Points

[ |

BaldEagleDemoList of Computation Points

Export

Close

Description
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Inflow for Sayers
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Outflow for Sayers
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| Sayers Inflow Jct
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Figure 2.24 Select Print from
Report’s File Menu
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Stream Project Stream
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Marsh ChkJct Bald Eagle Creek 74,556.0
Beech Ck Station Copy adle Creek 65,314, 2
till Hall agle Creek 28,971.9
Fishing CkJet Select Al agle Creek 26,157.3
Bald Eanle Total agle Creek f,157.1
Milesburg Jct Print Previcw. agle Creek 151,245.4
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Figure 2.25 Select Print from Report’s Shortcut Menu
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3. The Print Properties dialog box will open (Figure 2.26).

= Properties @

| HeaderFonter|| Takle Title

Orientation
®) Paortrait (O Landscape
Scaling

All colurnns on one page
Selection

(%) Entire Table (O Selected Cells
Frint

ASCI Repeat Headers
Gridlines

[ Print ” Cancel ]

Figure 2.26 Printing Properties, Page Tab

4. From the Page tab (Figure 2.26), you can set the orientation
(default is Portrait), make the report columns fit on one page,
print the entire table (default) or print selected cells, repeat
headers on subsequent pages, and display gridlines. By default
the report prints in an ASCII format, if you want a screen
image of the report, unclick ASCII and the report will print
with any shading that you see on the report.

5. The Header/Footer tab (Figure 2.27) allows you enter a
header and/or footer for the report.

6. The Table Title tab (Figure 2.28) allows you to change the
default title of the report, and to determine whether you want
the report title repeated on subsequent pages.

X Properties E| ?Pruperlies E\
Page | HeaderFooter: Taple Title Page | HeadenFooter| Table Title
Header: Title:
BaldEagleDemo - List of Computation Points
Footer.
[] Repeat Title on Every Page
Figure 2.27 Printing Figure 2.28 Printing

Properties, Header/Footer Tab Properties, Table Title Tab
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7. After you have everything set, click Print and the default
system Print dialog box will open (Figure 2.29). Select the
printer, and any other options you wish to set, click OK. The
report will then be printed on the selected printer.

Printer
M arne: HF Lazeret 4 j Froperties. ..
Status: Ready
Type: HF Lazerlet 4
Where:  LPTT:
Comment: [~ Frint to file
Print range Copies
o Al Mumber of copies: m
~
- el ek
ak. | Cancel

Figure 2.29 System Print Dialog Box

2.8.2 Print Preview

You can also preview the report before printing. To do so, do the
following:

1. You must have a report selected (opened).
2. Right-click anywhere within the tabulated data of the report
and from the shortcut menu, select Print Preview (Figure

2.30).
? BaldEagleDemo - List of Computation Points |'._||'E|E|
File Help
BaldEagleDemoList of Computation P oints
Stream Project Stream
Mame Cescription Mame Mlarme Station
Sayers Inflow Jct Inflow for Sayers Bald Eagle Creek  |Sayers 121,400.9
Blanchard Cutflow for Savers Bald Eagle Creek | Sawers a0,066. 4
marsh Gk dot Bald Eagle Creek 74,5580
Beech Ck Station o Bald Eagle Creek 65,3142
Mill Hall ey Bald Eagle Craek 25,971 9
Fishing Ck ot Select All Bald Eagle Creek 26,157.3
Bald Eagle Total Print Bald Eagle Creek 6,157.1
Milesburg Jct Bald Eagle Creek 151,245, 4
Print Preview
Expar...

Figure 2.30 Select Print Preview from Report’s Shortcut Menu




ResSim User’'s Manual Chapter 2 — ResSim Concepts

(98]

The Properties dialog box (Figure 2.26) will appear.

4. Make the same adjustments for printing as described in Section
2.8.1. When you are satisfied, select Print from the
Properties dialog box, and the Print Preview dialog box
(Figure 2.31) will open.

2 Print Preview

Print Close

BaldEagleDemao - List of Computation Paints .
Stream Project Stream
Marne De=cription Marne Mame Station
Sayers Inflow Jot Inflowy for Sayers [Biald Eanle Creek  |Sayers 1z1,400.%9
Elahchard Outflove for Savers Bald Eagle Creek  |Sayers 20,0654
arsh Chodot Bald Eadle Creek 74,558.0
Beech Ck Station Bald Eagle Cresk 55,314.2
ill Hall Eald Eagle Creek Z5,971.9
Fishing Ck Jot Bald Eagle Cresk 76,157.3
Eald Eagle Tatal Eald Eagle Creek 6,157.1
ilesburg Jot |Elald Eagle Creck 151,245 4
v
< | >

Figure 2.31 Print Preview Dialog Box

5. If you like what you see in the Print Preview dialog box, you
can print by clicking Print, which opens the system Print
dialog box (Figure 2.29), or you can close the Print Preview
dialog box by clicking Close.

2.8.3 Exporting Reports to a File

You can also export reports to an ASCII delimited file. To export a
report from the Watershed Setup module, do the following:

1. You must have a

report selected ? BaldEagleDemo - List of Computation
(opened).
Prink BaldEagleDemaolL

2. From the File menu Export

of the opened report, Close . Description

sel‘ect EXpOI’t Sayers Inflave Jct Inflowy for Savers

(Flgure 2'32)' Or, Elanchard Qutflow for Sayers

you can right-click Marsh Ck Jct

anywhere within the Beech Ck Station

tabulated data of the
report and from the

shortcut menu select
Export (Figure 2.33).

Figure 2.32 Select Export from the
Report’s File Menu

2-23



Chapter 2 — ResSim Concepts ResSim User’'s Manual

F— BaldEagleDemo - List of Computation Points

File Help
BaldEagleDemoList of Computation Points
Stream Project Stream
MName Description MName MName Station
Sayers Inflow Jet Inflow far Sayers Bald Eagle Creek Sayers 121,400.9
Elanchard Outflow for Savers  |Bald Eagle Creek |Savers 80,066.4
Marsh Gk Jct Bald Eagle Creek 74,558.0
Beech Ck Station Rald Eagle Creek B5,314.2
il Hall Copy Eagle Creek 28,971.9
Fishing Ck Jct Eagle Creek 26,157.3
Bald Eagle Total SelectAll Eagle Creek 6,157.1
Wilesburg Jct Frint... Eagle Creek 151,245.4
Print Preview:...
Export...

Figure 2.33 Select Export from Report’s Shortcut Menu

3. The Table Export

OptiOl’]S dialog box Table Export Options [z|
(Figure 2.34) will Field Delimiter: | TAR |
open. [ Fixed Width Colurnns

[] Gunted Strings
4. You can select the

Field Delimiter from

[«]include Column Headers:

the list to be TAB,
SPACE, COMMA, [ Print GridLines
or COLON. N
[ Print Title: | |
5. By default, the export Lok J[ came |
does not use fixed Figure 2.34 Table Export Options
width columns; Dialog Box

however, if you want
to do this you can
click in the Fixed Width Columns checkbox.

6. You can also include the Column Headers of the report
(default), include Gridlines, and include the Title of the report.

7. Once you have chosen your desired options, click OK and the
System Save Browser (Figure 2.35) will open.
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£ Save

Save in: I[h BaldEagleDema

My Recent
Cocuments

=
L
Desktop
ity
Documents

iy Computer

.«

=) maps

I ras

I0) scripts

I shared

I study

I supplemental
BaldEaglewksp.bak
BaldEagleDemaowksp
strearm.alian
stream.aliogn.bak
TimeSeries.icons
TimeSeries.icons. bak

File name: |

| Save

Files oftype:  |all Files

v| [ Cancel ]

Figure 2.35 System Save Browser (for Saving a File)

8. You will need to select where you want the file to be saved and
a filename. If you want the file to have an extension, you must
enter your own; there is no default file extension.

9. Click Save and the System Save Browser will close. The
filename that you entered will now be saved on your computer.
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Chapter 3
Creating and Managing Watersheds

A watershed is a data set associated with a geographic region for which
you may have configured multiple models and area coverages. A
watershed may include all of the streams, projects (reservoir, levees, etc.),
gage locations, impact areas, time-series locations, and hydrologic and
hydraulic data for a specific area. All of these details together, once
configured, form a watershed data set.

In the Watershed Setup Module, you will set up your watershed’s
physical arrangement including: background maps, the Stream
Alignment, geo-extents, projects, and other geo-referenced data.

You define Configurations when you initially create a watershed. This
should enable modelers to develop data explicitly for a specific
configuration and reduce the possibility that incompatible model data sets
will be used for multiple program applications (e.g., HEC-ResSim and
HEC-FIA).

You can also use the Watershed Setup Module to define Projects and
Computation Points associated with specific configurations in your
watershed. Projects can include Reservoirs, Levees, Diversions, Channel
Modifications, Off-Channel Storage Areas, and “Other” Projects.
Computation Points are locations where time-series information is
exchanged between models (e.g. ResSim and FIA).

3.1 Recognizing Watershed Setup Screen Components

The Watershed Setup Module provides tools for setting up your
watershed’s physical arrangement, including maps, the Stream Alignment,
geo-extents, projects, and other geo-referenced data. Figure 3.1 shows the
components of the Watershed Setup Module main window. Tools unique
to this module are described in the following sections.
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Title Bar Display Area Setup Lock

X HEC-ResSim 3.0 - BaldEagleDemo

Menu Bar —»| Fle Edt View Watershed Reports Tools Help
Module |_|5'[ —| Module: Watershed Setup v Configuration |Existing b @
+
'k 4— Pointer/Selector Tool —
Zoom Tool —| [Q T
[{™j4— Pan Tool Configuration
[@ ¢— Time-Series Icon Tool List
Stream Alignment Tool —»
Stream Node Tool —
Reservoir Tool —»
Levee Tool —»| [£}]
Diversion Tool —p
Channel Modification Tool —»| |t
Off Channel Storage Tool —» @
Other Project Tool —, @
General
Impact Area Tool —» @ Message
. . Scroll
Computatlon Point TOO| —> @ General Message Bar Buttons
< \ >
Status Bal’ — | | Coordinates: 1851666 east, 386538 north Local Workspace BaldEagleDermo opened “ :]

Figure 3.1 Watershed Setup Module Main Window

3.1.1 Menu Bar

The following is an overview of menus unique to the Watershed
Setup Module. These tools will be described in more detail in the
context of specific tasks later in this chapter.

Refer to Chapter 2 for information about the View, Tools, and Help
menus, which are common to all three modules.

The File menu (Figure 3.2) allows
you to create a New watershed, Open New Watershed. . CEN
an existing watershed, Save a

watershed, Save Map (saves the Open Watershed...  Crl+O

display area) and Exit ResSim. Your Save Watershed  Chr+5
most-recently-used watersheds are Jave Map As...

located at the bottom of the File Exit ChH-0
menu.

1 BaldEagleDema

Figure 3.2 File Menu
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Use the Edit menu (Fig_ure 3_.3) to T i Waterched
access the following editors in the

Watershed Setup Module: the RIS (DR
Watershed Data Editor, All Impact All Tmpact Arsas ...
Areas Editor, Projects Editor, and Projects...
Drawing Properties Editor. You Drawing Properties. ..
must select Allow Editing if you wish allows Editing

to make changes to your watershed (or =

toggle the Lock above the display Figure 3.3 Edit Menu
area).

Using the Watershed menu

(Figure 3.4), you can create and edit
Configurations, Update
Computation Points, Import and
Export Stream Alignments, and
Impact Areas, and Save
Configurations.

GIEIEREER N Reports Tools  Help
Configuration Edikar, ..
Ilpdate Computation Poinks
Import ]
Export ]

Save Configuration

Figure 3.4 Watershed Menu

The Reports menu (Figure 3.5) CESEN Tools  Help
gives you access to reports for your List of Strears
watershed. Reports include the List List of Impact Areas
of Streams, List of Impact Areas,
List of All Configurations, List of
Computation Points, and Projects
listings by project type.

List of All Configurations
List of Computation Points
Projects ]

Figure 3.5 Reports Menu

3.1.2 Configuration Selector and Lock/Unlock

When you add a schematic element to the map display, you must
choose its Configuration using the Configuration Selector. The
default Configuration, Study, contains the entire set of all projects and
Computation Points defined in the watershed. You can also associate
projects with custom configurations.

Before you can add, remove, or edit schematic elements in your

watershed, you must lock the Configuration by clicking on the =)
symbol to the right of the Configuration Selector. When the
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Configuration is locked, the =] symbol appears. If the Configuration
is unlocked, the &' symbol appears.

3.1.3 Map (Mouse) Tools

In the Watershed Setup Module, Map (Mouse) Tools allow you to
access and configure objects within your watershed. Project Tools
help you to create and edit the various project types. After you have
created a project, ResSim adds it to the active Configuration. The
following are descriptions of the available tools:

il Pointer Tool
Right-click with the Pointer Tool to select and access a shortcut menu
for any schematic element in the watershed map display.

g Zoom Tool

Use the Zoom Tool to zoom in and out of the display area. To zoom
in, hold the left mouse button down and outline the area you want to
zoom in on. To zoom out, right-click in the display area.

ﬂ Pan Tool

Use the Pan Tool to move the display area while you are zoomed in.

o

= 1 Time-Series Icon Tool

Use the Time-Series Icon tools to create, delete, and rename time-
series icons that are used for plotting and tabulating time-series data.
To create, select the Time-Series Icon Tool, hold down the CTRL
key and click. To access the available commands, select the Time-
Series Icon Tool, right-click on a time-series icon, and the commands
are available from the shortcut menu.

ﬂ Stream Alignment Tool

Use the Stream Alignment Tool to draw the multi-segmented lines
that comprise a Stream Alignment representing river systems in the
map display.

ﬂ Stream Node Tool

The Stream Node Tool allows you to create and edit stream nodes and
junctions, two of the primary components of a Stream Alignment.

£ Reservoir Tool

Use the Reservoir Tool to select and add reservoir projects to the map
display and access editors for reservoirs.
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ﬂ Levee Tool

Use the Levee Tool to select and add levee projects to the map display
panel and access editors for levees. In the Watershed Setup Module,
only the name and description can be edited.

ﬂ Diversion Tool

Use the Diversion Tool to select and add diversions to the map
display and access editors for Diversions.

E Channel Modification Tool

Use the Channel Modification Tool to select and add channel
modifications (such as channel straightening, concrete walls,
dredging, and widening) to the map display and access editors for
Diversions.

ﬂ Off Channel Storage Tool

Use the Off-Channel Storage Areas Tool to select and create Off-
Channel Storage Area polygons in the map display and edit their
properties.

m “Other” Project Tool

Use the “Other” Projects Tool to place icons representing “other”
projects, such as pump stations and gages, etc., and edit their
properties.

ﬂ Impact Area Tool
Use the Impact Area Tool to create and edit impact areas representing
regions in the watershed where flood damages will be evaluated.

ﬂ Computation Point Tool

Use the Computation Point Tool to create and edit Computation
Points. Computation Points are locations in the watershed where
individual models will share information. Typically one model will
produce results at a Computation Point that another model will use as
input.
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3.2 Using Shortcut Menus

Shortcut menu commands vary
according to the schematic
elements with which they are
associated. Figure 3.6 shows
the shortcut menu for a
reservoir named “Sayers”.

Sayers

Edit Reservoir...

Rename Reservair,..

If your watershed is locked =3 ke Area  Remove from Configuration
the shortcut menu will allow Delete Reservoir

you to edit, rename, and delete Configuration Notes. ..
the object (depending on the &

object type), as well as view its  Figure 3.6 Reservoir Shortcut Menu
properties. If your watershed

is unlocked &I, some of the
options will be unavailable.

3.3 Watershed Creation

The first thing you must do to create a new watershed is to specify its
directory location, give it a name and description, and establish the Units
of Measure and Time Zone. Once you have created your new watershed,
ResSim generates a new directory hierarchy in the “base” working
directory. Your new watershed becomes active in the main window and
the tools needed to create the watershed data become available. At this
point you may continue to configure the new watershed by adding layers
and schematic elements, setting preferences for the map display, etc., as
described later in this chapter.

3.3.1 Defining a Watershed Location

A Watershed Location is your working directory--the place on disk
where you create and edit your watershed data. You can have
multiple watershed locations, although an individual watershed
cannot span multiple locations. Each watershed location should have
a logical name, such as CWMS or General Projects.

Before you can create or open a watershed, you must define at least
one watershed location. To define a Watershed Location:

1. From the Tools menu, select Options. The HEC-ResSim
Options dialog box (Figure 3.7) will open.

3-6



ResSim User’'s Manual Chapter 3 — Creating and Managing Watersheds

X HEC-ResSim 3.0 Options 3

|| Cache Directory| Cornpute Display| Debug Levels | General | Fonts

Watershed Locations
MNarme Location
ExampleWWatersheds CIUHEC Data/ResSim
W30 tests GIHEC DatalHEC-ResSim_v3.0
ResSimv3_UserDocumentation GIHEC Datall _ResSim_va_forldserDocumentation
vl.d GIHEC DataiResSimy1.4
[ Add Location ... ] [ Remove Location ] [ Edit Location ... l

[ ok ][ cancer |

Figure 3.7 HEC-ResSim Options Dialog Box

2. Select the Model Directories tab. The Name and Location of
any watershed locations you have previously defined will
display in the list.

3. To add a new location to the list, click the Add
Location...button. The Add Watershed Location dialog box
will open (Figure 3.8).

Add Watershed Location

Marne: |

Location: | | I Browse ... l

’ Ok ] [ Cancel l
Figure 3.8 Add Watershed Location Dialog Box

4. Enter a logical Name for the new location, then click the
Browse... button to select the area on disk where you want to
build your watershed. This directory is the “holder” of the
“base” directory and the “base” directory is the “holder” of
your watershed. In other words, the Watershed Location
contains a directory named base, which contains the
directory(s) for your watershed(s).

5. Click OK to close the Add Watershed Location dialog box.

The new location will now appear in the list of watershed locations on
the Model Directories tab.

Refer to Appendix A for information about other options available in
the Options dialog box.
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3.3.2 Creating a New Watershed

Once you have established the working directory, you can create a
new watershed.

To create a new watershed:
1. Select New Watershed from the File menu. The Create New

Watershed dialog box (Figure 3.9) opens.

Create New Watershed f@
Marne: |
Cescription: (J
Location: ExampleWatersheds 4
Units: () Englizh O sl
’ Titne Zones... ]
[ Ok l ’ Cancel ]

Figure 3.9 Create New Watershed Dialog Box

. Type a Name for the new watershed. The watershed name

must be less than 32 characters and cannot contain any of the
following characters: |/:*?7<>-\.

. Type a Description for the new watershed that clearly explains

what it is.

Select a Location (working directory) for the new watershed’s
directory from your list of available locations.

Specify either English (U.S. customary units) or SI (System
International) as the Units of Measure. You will not be able
to change this after you click OK (see Section 3.3.3,
Specifying Units of Measure, for more information).

Specify the Time Zone of the new watershed by selecting from
the list of standard time zones. Note that the watershed Time
Zone does not recognize Daylight Savings Time (see Section
3.3.4, Specifying Time Zone, for more information).

Click OK to close the Create New Watershed dialog box.
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3.3.3 Specifying Units of Measure

All modeling data, time-series data, geometric and reservoir
information, model parameters, and flow-, elevation- and stage-time-
series data must use the same unit system when saved. Therefore, it is
crucial that you specify either English or Sl as the Units of Measure
for your watershed when you set it up. NOTE: You cannot change
the watershed units of measure once the watershed setup is complete,
but you can at any time customize the display of data using the View
menu.

3.3.4 Specifying Time Zone

When a new watershed is created, the user must select the appropriate
time zone for the watershed. This typically would be the time zone
for the outlet or major portion of the watershed. Internally, ResSim
will store all time-series data using the fixed “standard time offset
from GMT” for the selected watershed time zone. Thus, internally,
the data will be held in standard time only.

You cannot change the Watershed Units of Measure or the
Time Zone once the watershed setup is complete.

3.4 Setting Up New Map Layers

Layers in ResSim are like transparencies laid one on top of the other, with
static physical images such as roads, county and state boundaries, rivers,
subbasins, etc., layered in the display as color pictures. Each of these
images, along with its associated data, is a map layer. Access to the
Layers Selector is available from the View menu. Refer to Chapter 4 for a
more detailed description of Map Layers.

3.4.1 Importing Maps into ResSim

The background maps you will use in your watershed will come from
sources outside of ResSim. To import a map file for use in your
watershed, copy the appropriate map files to the “maps” directory of
your watershed (see Appendix A for information about the ResSim
directory structure). ResSim does not perform coordinate
transformation for background maps. Therefore, all of the map layers
you use in a watershed should be referenced to the same coordinate
system (see Appendix B for more information on coordinate systems).
Table 3.1 shows the file formats ResSim supports and each format is
described in the paragraphs that follow. Appendix C describes how to
access the map editors for configuring each type of map format.
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Table 3.1 Map Layer Formats Supported by ResSim

Description Common File Name Extension
ArcView® Shapefile shp

AutoCAD® DXF dxf

Raster image .img, .gif, .jpg

USGS* Digital Line Graph dlg

USGS* Digital Elevation Model | .dem

ASCII NetTIN net

Arcinfo® DEM .asc

*US Geological Survey

Arc Shapefiles (.shp)

This layer type is the native data structure for the ArcView® GIS
program. Shapefiles store non-topological geometry and attribute
information for the spatial features of a data set. Usually there are
three files: *.dbf, *.shp, and *.shx. The .shp file contains the shapes
(point, polylines, or polygons) that display in the layer. Each shape
has a record in the .dbf file containing descriptive data called
“attributes.” The .shx file contains an index that links each shape to
its record in the .dbf file.

AutoCAD® DXF (.dxf)

A Drawing Interchange file (.dxf) is created by a Computer-Aided
Design (CAD) package, AutoCAD®. This format is a tagged data
representation of an AutoCad® drawing file. In tagged data, a group
code precedes each data element. A group code is an integer number
indicating the type of data element. The file created is a vector-based
graphic. The DXF format is commonly used for data exported from
other CAD and GIS programs.

Raster Image

ResSim supports JPEG (.jpg) and Graphics Interchange (.gif) raster
image formats. Before ResSim can access these file types, you must
first create an .img (ASCII text) file containing the following lines:

Image West=2051443. )
Image North=355443 These are image boundaries that are
Tmage East=2054925 6 determined by the user and usually

calculated using a program such as
Image South=351947.4 Arcinfo®.

Image URL = path and filename of raster image
(i.e., maps/lh 2m.gif)

The raster image boundaries must match the easting and northing
parameters stated in the Geographic Region Dialog (see Section 3.4.3,
“Specifying the Geographic Referencing and Coordinate System”).
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USGS Digital Line Graph (.dlg)

USGS Digital Line Graph (DLG) files are created from two sources
using manual and automated digitizing methods. The two sources are
aerial photographs and cartographic sources. DLG files are vector
representations of the data. When ResSim interacts with a .dlg file, it
automatically creates a .dlgbin file, which is a binary representation of
the ASCII .dlg file.

USGS Digital Elevation Model (.dem)

The USGS Geological Survey publishes the raster file format USGS
Digital Elevation Model (DEM). DEM files usually contain terrain
elevations, but the file format can be used for representing any
surface. The format, published by the USGS, allows internal
documentation of coordinate system, date of publication, etc.

ASCII NetTin (.net)

This is an ASCII file format used to represent a Triangulated Irregular
Network (TIN). The TIN data is stored in a simple format that
defines the nodes, edges, and triangles contained in the TIN. This
format is common for transferring TIN data between software
packages.

Arcinfo® DEM (.asc)

This is an ASCII file format representation of a grid generated by
Arcinfo®. The file consists of keywords followed by values defining
the number of columns, number of rows, lower left corner, cell size,
no data value, and each cell value.
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3.4.2 Adding a New Map Layer

To make map files accessible

in the watershed, first make = BaldEagleDemo - Layer Selector [=|[E][X]
sure that the map files are in EEl G G

the “maps” directory of the & | ayers

watershed, as previously UL

Study

Stream Alignment
strearmOutlines.dighbin
subbasinCutlines.dlabin

53]

described in Section 3.4.1.
Also, ensure all maps you add
to a watershed share the same
coordinate system before you
add them to the watershed.

B B B

To add a map layer to your
watershed:

1. Select Layers from the
View menu. The Layer
Selector dialog box will
appear (Figure 3.10).

2. From the Edit menu,

select Allow Layer Apply I

Editing. - -
3. Next, from the Maps Figure 3.10 Layer Selector Dialog Box

menu, select Add Map
Layer. The Open File
dialog box (Figure 3.11)
will open.

_'-i()pen File

Drive:  |ae Gy w

Folder: | GHEC Datail _ResSim_v3_forUserDocumentation/base/BaldEagleDemoimaps |

7 ~Folder ~File
m EaldEagletWatershed.dbf

Watershed BaldEagleWatershed.shp
B BaldEagletvatershed.shx
&

hec_subw.dlg
CWMS_HOME

bec_subw.dighin
hydro.dlg

hydro.dlghin
raingage.dhf
raingage.shp
raingage.shy
streamOutlines.dlg
streamOutlines.dlghin
subbasinOutlines.diy
subbasinOutlines.dighin

File name : | | [ 0K 1

Files of Type : Cancel
Figure 3.11 Open File Dialog Box to Add Map Layer
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4. Locate the map file you wish to use on your local computer (for
example, “raingage.shp”).

5. After you have selected the map you wish to use, click OK. The
new map will now appear in the Layer Selector dialog box.

3.4.3 Specifying the Geographic Referencing and

Coordinate System

To maintain a geographic reference, you must specify a coordinate
system for each watershed. To establish the grid size and coordinate

system:

1. Select Layers
from the View
menu to open the
Layer Selector
dialog box.

2. From the Maps
menu, select
Map Display
Coordinates to
open the
Geographic
Region dialog
box (Figure 3.12).

? Display Coordinate Information @

Coordinate Systemn: | State Plane Coordinates

Extents:

Easting: Morthing:
Minimurm; 1853233 minimum:; 201313
Maximum: 2137797 Maximum: 393111

Grow to Map Extents [ Set Map Coordinates to Display l

Lo ]
Figure 3.12 Geographic Region Dialog Box

Cancel ]

The Geographic Region dialog box includes the following

information:

Coordinate System

This box identifies the coordinate system established for the
watershed. The coordinate system can be edited, but remember that
all maps and data must exist in one unified coordinate system.
Therefore, some layers or data might require the use of a GIS program
to transform coordinate system information. For additional
information about editing the Coordinate System, see “Editing the
Coordinate System” paragraph below.

Extents

The values of Easting Min, Easting Max, Northing Min, and
Northing Max indicate the location of the left, right, bottom and top
borders (respectively) of the grid in the display area. ResSim displays
coordinates in the Status Bar as you move the cursor within the map

display panel.
Grow to Map Extents

When you check this box, ResSim automatically sets the geographic
region to define the smallest rectangle that encompasses all of the
objects (maps, icons, alignments, etc.) in the display area. If you add
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any objects to the watershed that lie outside the geographic region,
ResSim automatically updates the extents to include the new objects.

carefully to ensure that all map layers in your watershed
setup are included. The extents you specify and the
coordinate system you use must be consistent for all layers
in the watershed. You should use GIS tools to transform
layers from one coordinate system to another before you
use them in ResSim.

i You must select the geographic extents of your watershed

Setting Map Coordinates to Display

You can automatically set the geographic extents to the coordinates in
your current view. First, zoom in or out in the display area to
determine a preferred geographic region, then open the Geographic
Region dialog box and click Set Map Coordinates to Display.
ResSim will set the extents to the current view in your map display.
Obijects beyond the geographic extents remain in the watershed, but
they are not included in the grid of the display area.

Editing the Coordinate System

You can edit the Coordinate System of the Watershed by selecting
Edit in the Geographic Region dialog box. This opens the Map
Coordinate Information dialog box, where you can configure the
System, Units, Spheroid, and other system-specific data. See
Appendix B for more information on configuring map coordinate
information.
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Layers in ResSim are like transparencies laid one on top of the other, with
static physical images such as roads, county and state boundaries, rivers,
subbasins, etc., layered in the display as color pictures. Each of these
images, along with its associated data, is a layer.

4.1 Understanding Layers

Layers are hierarchical. Primary (top level) layers include the Time-
Series Icon Layer and the Study Layer (available only in the Watershed
Setup Module), the Stream Alignment Layer, and Map Layers. These
primary layers can contain component layers. For example, the Stream
Alignment Layer contains the Stream Nodes, Stream Segments, and
Stream Junctions. The Study Layer contains layers for all Reservoirs and
other Projects, Computation Points, and Impact Areas contained within the
Study.

4.1.1 Time-Series Icon Layer

The Time-Series Icon Layer includes all of the time-series icons for
your watershed, and it allows you to separate different types of data in
your map display. For example, a gage may report stage and
precipitation (and compute flow from stage). If you create time-series
layers named “Stage,” “Flow,” and “Precipitation,” you can then
place each data set in the appropriate layer.

ResSim does not use Time-Series Icons for any program needs. Refer
to the CWMS User’s Manual (HEC, 2006a) for additional details
about Time-Series Icons.

4.1.2 Study Layer

The Study Layer appears in the Watershed Setup Module only. The
Study layer is comprised of all of the projects, impact areas, and
computation points contained in the watershed.

The Layer Selector displays Study as a primary layer in the Layer
tree. When you click on the root handle for the Study branch, there is
a layer for Computation Points, Diversions, Names (labels for the
projects, computation points, and impact areas), Reservoirs, Channel
Modifications, Levees, Off Channel Storage, Other Projects, and
Impact Areas. ResSim creates a layer for each of these items even
before you have defined any projects, computation points, or impact
areas.
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4.1.3 Stream Alignment Layer

The Stream Alignment Layer contains the Stream Alignment
representing the river system in the watershed. The Stream
Alignment layer includes three component layers: Stream Nodes,
Streams Segments (also referred to as stream elements), and Stream
Junctions. This layer is available in all ResSim Modules but is only
available for editing within the Watershed Setup Module.

4.1.4 Map Layers

ResSim can display various types of maps and elements in the geo-
referenced map display area. These maps, displayed as map layers,
are static physical images. Examples of map layers include roads,
county and state boundaries, rivers, subbasins, etc. Some maps are
static images, which display as color pictures in the display area.
Map Layers are not interactive. Instead, you interact with data
associated with schematic elements you place in your map display.

For a description of the map layer formats supported by ResSim, see
“Importing Maps into ResSim” in Chapter 3, Section 3.4.1.

4.2 Exploring the Layer Selector

The Layer Selector is the main - .
controller for the organization of

the various layer types described Layers Edt Maps View

above, including the Study 2 | ayers
Layer, Stream Alignment Layer, [4] Time Series lcons
and Map Layers. = [4] Study

+ Computation Points
To access the Layer Selector 4 [ Diversians

from any module, from the View Mames
menu, select Layers.... Resenoirs
Channel Madifications

The Layer Selector window, *
+ [v] Levaes
"

shown in Figure 4.1, opens as a
separate frame that you can
minimize to the Windows
taskbar.

Off Channel Storage
Other Projects
= Impact Areas
+ Stream Alignment
7 [v] streamoutiines. dighin
% [¥] subbasinOutlines.dighin

[cana |

Figure 4.1 Layer Selector
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4.2.1 The Layer Selector Menus

Menus in the Layer Selector offer a variety of tools to assist you in

managing layers.

The Layers menu (Figure 4.2) offers a
Close command to close the Layer
Selector.

The Edit menu (Figure 4.3) provides
tools for rearranging layers, viewing
and editing layer properties, and adding
and reloading default toolbar buttons for
access to individual layers.

To see all of the available commands in
the Edit menu, you must first select a
layer and activate Allow Layer
Editing. When editing is enabled, a
checkbox appears next to the menu item
as shown in Figure 4.3.

Figure 4.4 shows the Edit menu as it
appears with Allow Layer Editing
turned off and with no layer selected.

Also note that the current position of an
individual layer will determine which
commands are available in the Edit
menu. When a layer is already at the
top, the Move to Top and Move Up
options will be unavailable. Likewise,
if a layer is at the bottom, the Move
Down and Move to Bottom options
will not be available.

B

L

Close |

Figure 4.2
Layers Menu -
Layer Selector

Mowve bo Top
Mowve Lp
Move Down

Mowe ko Bokkomn
Properties ...

Add Toolbar Butkon ...
Reload Defaulk Button

v Allow Layer Editing

Figure 4.3 Edit Menu -
Layer Selector

&dd Toolbar Button ...
Reload Default Button

Allow Layer Editing

Figure 4.4 Edit Menu -
Allow Layer Editing
Turned Off and

No Layer Selected
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The Maps menu (Figure 4.5) allows Maps

you to add and remove map layers. Map Display Coordinates ...
The Map Display Coordinates
option opens the Geographic Region
dialog box. These processes are
described in “Adding a New Map Figure 4.5 Maps Menu -
Layer” in Chapter 3, Section 3.4.2. Layer Selector
You must select a map layer to access

the Remove Map Layer command.

add Map Layer ...
Rernove Map Laver

The View menu (Figure 4.6) gives you

control over display of the Layer Selector. Expand

The Expand option expands the “tree” of Always On Top

a layer to display its sub-layers (same _ _
functionality as clicking on the layer’s Figure 4.6 View Menu -

plus- sign box in the tree). Once you have Layer Selector

expanded a layer, Expand changes to

Collapse to close the layer to show only

the primary layer (same functionality as

clicking on the minus-sign box in the tree). Always on Top keeps the
Layer Selector on top of your desktop so you can leave it open while
you work, if desired.

4.2.2 The Layer Selector “Tree”

The Layer Selector uses a tree metaphor for controlling the display
and organization of layers in the watershed. The tree metaphor
represents the hierarchical arrangement of layers in ResSim.

The top level of the tree is the Layers folder, which contains all of the
layers in the watershed. Beneath the Layers folder is a tree branch for
each primary layer, beginning with a plus/minus box, followed by a
checkbox, then the layer name.

When you expand a layer (“Controlling Layer Display” , Section
4.2.3), its sub-layers display. If no sub-layers exist, you will see a
legend for the layer.

In following sections you will learn how to interact with layers in the
Layer Selector by using the Menu items, shortcut menus, plus/minus
boxes, checkboxes, and properties editors.
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4.2.3 Controlling Layer Display

Beside each Layer branch is a
plus/minus box, or root
handle, that serves the same
function as the
Expand/Collapse options in
the View menu. A plus means
the layer can be expanded.
You can click on a plus to
expand a tree branch to
display component layers; if
no component layers exist,
you will see a legend for the
layer. When the root handle is
a minus, you can click on it to
collapse the tree branch. You
can also expand and collapse
layers by double-clicking
them with your mouse. Figure
4.7 shows the Layer Selector
with some of the layers
expanded.

The checkbox turns the
display of the layer on or off
(checked indicates the layer is
active in the display area).
When not checked, neither the

Lavers Edit Maps Yiew

= Study
+ Computation Points
+ Diversions
Names
Reservoirs
Channel Modifications
Levees
Off Channel Storage
Other Projects
T Impact Areas
= Strearn Alignment
+ Stream Junctions
e Streams
e Strearn Modes
[¥] Time Series lcons
 [v] streamOutlines.dighin
+ [¥] subbasinOutlines dighin

H B B B E

Cancel

o ) mm ]|

Figure 4.7 Layer Selector -
Layers Expanded

primary layer nor the components beneath it will display. When
checked, the primary layer and all checked component layers will

display; however, any unchecked component layers beneath it will not

display.
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4.2.4 Viewing Layer Legend

When you click on the - ;
root handle of a layer

with no components, the Layers Edt Maps View

legend for the map 4 Layers
displays. 5[] Study

+ Cormputation Points
The type of legend 4 [7] Diversions

displayed is determined
by the various file -
formats. Figure 4.8
shows the legend for
Reservoirs.

Channel Modifications
Levees
Off Channel Storage
Other Projects
i Impact Areas
s Stream Alignment
Tirme Series lcons
5 [v¥] streamOutlines.dighin
+ [¥] subbasinCutlines.dlabin

+ F OFH =

[ 0]:4 ” Anply ” Cancel II

Figure 4.8 Layer Selector -
Map Legend for Reservoirs

4.3 Controlling Layer Organization

The Layer Selector also controls how layers are arranged in the display
area. When you add map layers to the watershed (“Adding a New Map
Layer” in Chapter 3, Section 3.4.2), the map layer is added to the bottom
of the list of maps in the Layer Selector. You can use the Layer Selector
to rearrange the order of the primary layers:

1. Select the layer you would like to move.

2. From the Edit menu, select Allow Layer Editing.

3. From the Edit menu, select Move Up to move the layer towards
the front of the map display, or click Move Down to move the
layer to the back.

4. To see your changes, click Apply (to keep the Layer Selector
open) or click OK to close the Layer Selector.

Continue to change the position of each layer until the necessary map
features are visible in the display area.
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4.3.1 Configuring Toolbar Icons to Control Layers

In the Layer Selector you can also add controls to the Toolbar of the
main window. Toolbar buttons provide a shortcut for turning layers
on and off without having to open the Layer Selector. Toggling on
and off the toolbar button functions the same as the checkbox in the
Layer Selector. When the button is depressed, the layer is selected for
display in the map panel. When the button is up, the layer is turned
off in the display. This shortcut is useful when you might want to
have frequent control over layers that are being displayed.

Additionally, right-clicking on the toolbar button gives you access to
various properties editors and allows you to select and deselect layers
being displayed. The options available from the shortcut menu
depend upon the layer type.

If you hover your mouse over a Toolbar Button, a Tool Tip appears
with a description of the button.

Adding toolbar buttons is an optional configuration step, and if you
want to use toolbar buttons, you must configure them separately in
each module. Toolbar buttons are saved when you exit the watershed,
so you will only have to set them up once.

To add a toolbar button,

1. Inthe Layer Selector, select a layer in the tree.
2. From the Edit menu, select

Add Toolbar Button. The — [EAER LN 3
Toolbar Button Editor Tool Tip: | Reservoirs|
opens, as shown in Figure e 3
4.9.

3. The name of the layer 0K Cancel
appears by default in the Figure 4.9 Toolbar Button
Tool Tip field, but you can Editor

specify a more descriptive
Tool Tip if desired.

4. From the Icon list, select an icon to represent the selected
layer.

5. Select OK when you are done.

The toolbar button then appears in the toolbar above the Display
Area.

To remove a toolbar icon, select the layer in the Layer Selector, and
then from the Edit menu, select Remove Toolbar Button. To
quickly remove all toolbar buttons that you have defined, select
Reload Default Button from the Edit menu in the Layer Selector.
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4.3.2 Adding Map Layers

You will find it helpful to add maps to the watershed and the display
area to provide a geographical reference for time-series icons, the
stream alignment, and projects in your watershed.

To add map layers:
1. From the Edit menu of the Layer Selector, select Allow
Layer Editing.
2. From the Maps menu, select Add Map Layer... This
command opens a file browser to the default “maps” directory
in the watershed directory hierarchy. You must first copy any

maps you wish to use in the watershed to the “maps” directory
for your watershed.

3. From the file browser, choose the map you wish to add.
4. Click OK.
The map name now appears in the Layer Selector as a new tree

branch. See “Adding a New Map Layer” in Chapter 3, Section 3.4.2
for more information.

4.3.3 Removing Map Layers

To remove a layer from the map display, select the layer in the layer
selector, and then select Remove Map Layer from the Maps menu.
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4.3.4 Using Layer Selector Shortcut Menus
Shortcut menus in the Layer T BaldEagleDemo - Layer Selector [ J[B3J[X)

Selector offer commonly used levaE & e Ve

commands that are also :
A Layers

available in the Layer [#] Tirne Series lcons
Selector’s Edit and View o FStey
menus. Figure 410 ShOWS the + .:-tru::lrrl.u.llr|rr|Hr|t

£ hyydro dlghin Expand
shortcut menu for the Stream Coapse
Alignment layer in the Layer Mave To Top
SEIGCtor Move Up

Mowve Down

The Expand option expands Move To Batom
the tree of a layer to display its S —

component layers. Collapse
closes the layer to show only
the primary layer.

Move to Top, Move Up,
Move Down, and Move to
Bottom allow you to [ oc J[ amy [ came |
rearrange layers. The current
position of an individual layer
will determine which Move
buttons are available.

Figure 4.10 Layer Selector Shortcut
Menu for the Stream
Alignment Layer

Properties opens a Properties dialog box for the layer.
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o 1 e aea 2
(Figure 411)’ there are % BaldEagleDemo - Layer Selector g@@

L . Layers Edit Maps Wiew
several additional options

1 _A Lavers
available. The Show Legend 1 Time Series Icons
option expands the map layer 5[] Study
tree to display the map 5 [ Stream Alignment
legend. This option changes Ry dicbin) _
. Expar
to H|c_le Legend when th_e -
layer is expanded, allowing Move To Tap
you to close the branch view Move Lip
of legends. Also, the Move Down
. Mave To Botkam
Change Label option allows Shom Legend
you to change the name of Chanige Label
the layer in the tree. Properties
L . Set Scale For Zoom-in
The remalnlng OptlonS are Set Scale for Zoom-ouk
related to when the layer GEEEIEE Rl
should appear in the map
region. The viewing of the [ ok [ v [ comenl |

layer can be made to depend
on the how “zoomed in” or
“zoomed out” the view is in
the map display area. These options include Set Scale for Zoom-in,
Set Scale for Zoom-out, and Remove Scale Factors.

Figure 4.11 Layer Selector Shortcut
Menu for a Map Layer

Reminder: you must first activate Allow Layer Editing (from the
Edit menu) before you can access many of the shortcut menu
commands.

4.4 Viewing and Configuring Layer Properties

The Layer Selector provides three ways to view and configure layer
properties. You can:

Select a layer in the Layer Selector and then choose Properties from
the Edit menu.

Right-click on a layer in the Layer Selector and then select Properties
from the shortcut menu.

Double click on a layer in the Layer Selector.

Each of these techniques opens a Properties dialog box specific to the
layer type; map layers also have additional dialog boxes for configuring
properties. For information about configuring the Time-Series Icon Layer,
refer to the CWMS User’s Manual (HEC, 2006a).
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4.4.1 Study Layer Properties

The Study Layer is available only in the Watershed Setup module.
When you select Properties for the Study layer, the Drawing
Properties Editor appears (Figure 4.12).

? Drawing Properties Editor @

Triangle Elernent: Storage Reach Elerment:

Triangle Fill Colar: [ Jeyan ~ Starage Reach Fill Caolar: [ Jeyan v
Triangle outline Color: [N e v Storage Reach Outline Color: [ ©ve

<

Draw Reseroir Triangle Starage Reach Width: a v
Darm Element:

Dam Fill Color [ lightgray v Drraw Reservoir Name
DamWidth: |10 v

Figure 4.12 Drawing Properties Editor - Reservoir Tab

The Drawing Properties Editor has six tabs that allow you to view and
edit properties of Reservoirs, Levees, Diversions, Channel
Modifications, Computation Points, and Impact Areas in your
watershed.

With the Reservoir tab selected (Figure 4.12), you can choose the Fill
and Outline Color for the Triangle (which is the “visual”
representation of the Reservoir) and the Fill and Outline Color and
the Width of the Storage Reach (which represents the Reservoir
reach along the stream alignment) of reservoirs in your watershed
display. Also, you can choose the Fill Color and Width of the Dam
element. When you select Draw Reservoir Triangle with a
checkmark, the reservoir shape drawn in the Watershed Setup Module
displays on the map; when it is not checked, the reservoir shape does
not display. Likewise, Draw Reservoir Name, when checked,
displays the reservoir name on the map and hides the name when
unchecked. The Font... button for the Reservoir Name allows you to
choose the text font for the name of the reservoir in the map display.

The Levees tab (Figure 4.13) allows you to edit the properties of
levees in your watershed. You can specify the Line Color and Levee
Width. Draw Levee Name, when checked, displays Levee names on
the map and hides the names when unchecked. The Font... button
for the Levee Name allows you to choose the text font for the name
of the levee in the map display.
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X Drawi ng Properties Editor, @

Diversions | Channel Modification | Computation Point | Impact Area

[ R v | Levee Width [g v

Draw Levee Narme

Reservoir |

Levee Line Color:

Figure 4.13 Drawing Properties Editor - Levees Tab

With the Diversions tab (Figure 4.14), you can select the Line Color
and Width for the diversion. You can also select the Fill Color for
the Diversion Arrowhead. The arrowhead colors can be different to
indicate whether or not the diversion is Connected or Disconnected
(e.g., Connected indicates that the diverted water remains in the
system and Disconnected indicates that the diverted water is lost to
the system). Draw Diversion Name, when checked, displays the
Diversion names in the display area and does not display when the
name is unchecked. The Name Font... button allows you to choose
the text font for the name of the diversion in the watershed display
area.

X Drawing Properties Editor, E]

S Channel Modification | Computation Point| Impact Area

Reservoir | Levees
Line Element: Arrowhead Element:

Diverson Line Color: |l ¥ | | Diversion Arrowhead Color- Connected: [~
Diversion Line Width: |5« || | Diversion Arrowhead Color - Disconnected: [N~

Draw Diversion Mame

Figure 4.14 Drawing Properties Editor - Diversions Tab
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The Channel Modification tab (Figure 4.15) allows you to select the
Line Color and Width of the Channel Modifications. Draw
Channel Modification Name, when checked, displays the Channel
Modification names in the display area and does not display when the
name is unchecked. The Name Font... button allows you to choose
the text font for the names of Channel Modification points in the
watershed display area.

? Drawing Properties Editor, @

Resemvair| Levees || Diversions | Channel Modification:) Computation Paint| Impact Area

Channel Modification Line Color: [N vack v | Channel Modification Width: |3

Ciraw Channel Modification Marme

Figure 4.15 Drawing Properties Editor - Channel Modification Tab

The Computation Point tab (Figure 4.16) allows you to select the
Fill Color and Width of the Computation Points. Draw
Computation Point Name, when checked, displays the Computation
Point names in the display area and does not display when the name is
unchecked. The Name Font... button allows you to choose the text
font for the names of Computation Points in the watershed display
area.

X Drawing Properties Editor, E]

nt Impact Area

Reservoir| Levees || Diversions | Channel Modification CD

Computation Point Color: [N 20 ¥ | Cornputation PointwWidth: |3 v

Drawy Computation Point Mame

Figure 4.16 Drawing Properties Editor - Computation Point Tab
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The Impact Area tab (Figure 4.17) allows you to display or hide the
Impact Area name for your watershed. Draw Impact Area Name,
when checked, displays Impact Area names on the map and hides the
names when unchecked. The Name Font... button allows you to
choose the text font for the names of Impact Areas in the watershed
display.

? Drawing Properties Editor, @

Reserqmir| Levees || Diversions | Channel Modification | Computation Point Im

Drrawy Impact Area Mame

Figure 4.17 Drawing Properties Editor - Impact Area Tab

Impact areas can be included in your ResSim model for consistency
with your HEC-FIA model; however, the only computations
performed in ResSim are related to the computation points
corresponding to the FIA index locations.

For more information about Impact Areas, refer to the HEC-FIA
User’s Manual (HEC, 2003).
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4.4.2 Stream Alignment Layer Properties

When you select Properties for the Stream Alignment layer, the
Stream Alignment Properties Editor (Figure 4.18) appears.

¥ Stream Alignment Properties @

Scale

Current Scale 1:290084
Default

Edit Froperties
Stream Width: Stream Calor:
& v [ ] custamn ~

Show Stream Name

Draw Station Tics
Tic Lenath: 7 A
Major Tic Length; 14 b

Draw Stream Modes

Mode Color: N Custom v
Node outline Color: [ custorn v
MNode Width: 7w

Diraw Junctions
Junction Colar: [ Jareen v
Junction Width: 12w

Figure 4.18 Stream Alignment Properties Editor

The Stream Alignment Properties Editor allows you to specify
Stream Width and Stream Color in your watershed display. Show
Stream Name, when checked, displays stream names on the map and
hides the names when unchecked. The first Choose Font button
allows you to choose the text font for the names of streams in the map
display. When Draw Station Tics is checked, station tics display on
the map, and you are able to specify the Tic Length and Major Tic
Length. Draw Tic Labels, when checked, displays Tic labels on the
map and hides the labels when unchecked. The second Choose Font
button allows you to specify the text font for the Tic Labels. When
Draw Station Tics is unchecked, Station Tics do not display on the
map and the Tic Length, Major Tic Length, Draw Tic Labels, and
Choose Font options are not available. Similar options are available
for Stream Nodes and Stream Junctions (stream junctions occur at
the confluence of multiple stream alignments).

The Stream Alignment Properties Editor’s preview pane (located on
the right side of the editor) allows you to view your changes before
applying them.
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4.4.3 Map Layers Properties

Map layers can be any of a number of formats supported by ResSim,
including ArcView® Shapefiles, AutoCAD® DXF files, raster
images, U.S Geological Survey (USGS) Digital Line Graphs (DLG)
files, USGS Digital Elevation Model (DEM) files, ASCII NET TIN
files, and Arcinfo® DEM files. Hence, when you select Properties
for a map layer, the editor that opens is specific to the type of map.

For example, if the map layer you wish to configure is a USGS
Digital Line Graph map layer, the Properties command opens the
USGS Digital Line Graph Editor (Figure 4.19).

¥ USGS Digital Line Graph Editor X]

i1_ResSim_v3_forlUserDocumentationtbasel/BaldEagleDemaoimapsizubbasinOutlines.dighin

Default Color: [:T

[] Draw Mades
Draw Lines
Draw Areas
Saturation (0-1): 1

Brightniess (0-1): 1

[ OK ][ Apply H carncel ]

Figure 4.19 USGS Digital Line Graph Editor for Digital
Line Graph (DLG) Map Layer, Properties Tab

From the “Properties” tab of this Map Layers Properties Editor, you

can specify the default Color of the map and choose whether or not

Nodes, Lines, and Areas display in the watershed. You can also set
the Saturation and Brightness of the display.

From the “Scale” tab (Figure 4.20) of this Map Layers Properties
Editor, you have the choice to Always show the layer, or you can
indicate a scale range where the map layer will be visible.

() Always show laver

(O Only show layer in the fallowing scale range
Only visible below 1:
Only visihle ahove 1:

Current Scale 1 : 386047

Figure 4.20 USGS Digital Line Graph Editor for Digital
Line Graph (DLG) Map Layer, Scale Tab

The directory location of the map file in your ResSim watershed is
shown at the top of the dialog box.

Appendix C describes additional map layer editors available in
ResSim.
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Chapter 5
Working with the Stream Alignment

The Stream Alignment, illustrated in Figure 5.1, represents the river
system in the watershed. It indicates where confluences and bifurcations
occur and provides a sense of distance and scale.

T 1

Figure 5.1 Stream Alignment

In the Watershed Setup Module, Stream Elements (Figure 5.2), Stream

Nodes (Figure 5.3), and Stream Junctions (Figure 5.4) are the components
of a Stream Alignment.

T

Figure 5.2 Stream Figure 5.3 Stream Figure 5.4 Stream
Elements Nodes

Junctions

When you create a Stream Alignment, you draw it as a set of connected,
multi-segmented lines. The Stream Alignment must have at least two
nodes, defining the beginning and end of a stream element. Figure 5.5

illustrates the relationship of line segments, stream elements, and the
Stream Alignment.
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Line Segments /

Element CB

&) ®

' FElementDC —————J—ElementCA—

| Stream Alignment

Figure 5.5 Relationship of Line Segments, Stream Elements,
and Stream Alignment

ResSim creates and labels stream stations (or river stations) automatically

along each stream element. By default, the station at the downstream end
of an element is Station O (zero), and the stationing increases upstream
along the element according to the linear distance between nodes on the
stream element in the watershed coordinate system. You can override the

default stationing by editing the station values of the stream nodes at the
upstream and downstream ends of the stream element, as well as by
adding additional nodes along the stream element.

Stream stationing is based on the geographic extents you define when you
draw a stream element. If you have set the geographic extents to represent
feet, either manually or by importing a layer projected in feet, the station
labels will represent feet.

After you have drawn a Stream Alignment in the display area, you can
edit, rename, delete, and move its component stream elements, stream
nodes, and stream junctions using the Stream Alignment shortcut menus.

5.1 Creating a New Stream Alignment

You must be in the Watershed Setup Module to create a Stream
Alignment in ResSim. Although it is not necessary, you will find it useful
to display a background map of the river system as a guideline for creating
your stream alignment. If your stream alignment is going to be based on a
map layer, the map layer should already have been included in the
watershed by copying the map files into the “maps” directory. The map
layer should contain water features, such as stream channels and reservoirs
or lakes. Use this map layer as a guide while creating the stream
alignment. By doing this, the units of the labels on the stream alignment
will be the same as the units of the water feature layer (i.e., if your water
feature layer is projected in state plane coordinates (feet), then the labels
on the stream alignment will be in feet). Refer to Chapters 3 and 4 for
more information about adding and displaying maps.
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You can either digitize a stream alignment by hand or import a stream
alignment from an ArcView® shapefile. The following are the steps for
digitizing a stream alignment (see Section 5.3 for details on importing a
stream alignment).

To create a stream alignment:

1. You must be in the Watershed Setup Module. On the
Module list, select Watershed Setup.

2. On the map toolbar, press the Stream Alignment Tool ﬂ

3. Determine an upstream location where you want to start a
stream element (typically, you will begin at the upstream end
of the mainstem and end at the most downstream location of
the primary river in your watershed).

4. Hold down the CTRL key. Starting at the upstream end, draw

the stream element by clicking the left mouse button at each
vertex point as illustrated in Figure 5.6.

Vertex Point

Figure 5.6 Drawing a Stream Element

5. Continue downstream (while continuing to hold down the
CTRL key) and before placing the last point of the stream
element, release the CTRL key, and then click the left mouse
button at the last downstream location. This creates the ending
stream node of the stream element.

6. The Create New Stream dialog box (Figure 5.7) opens. You
can either accept the default name or enter a new name. Also,
you can enter a description for the stream element. Click OK
to close the Create New Stream dialog box.
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? Create Mew Stream @

Mame:

Description: -~

| ok |[ canca |

Figure 5.7 Create New Stream

7. Repeat steps 4 through 6 to add more stream elements to your
stream alignment.

8. To create a confluence or bifurcation, end the stream element
by clicking directly on an existing stream element. After
naming the new stream element, the Connect Stream Reaches
dialog box (Figure 5.8) will appear. You need to determine
whether you want to connect the new stream element to the
existing stream element. Click Yes if you want the two stream
elements connected; otherwise click No. If you selected No,
and if there are additional existing streams that are possible
candidates for connecting your new stream element to, then a
subsequent Connect Stream Reaches dialog will appear to
give you the opportunity to connect to the existing stream.

Connect Stream Reaches

@ Ok to connect Stream My Trib One to Stream My Main River?

Figure 5.8 Connect Stream Reaches

When multiple stream '
elements are connected (e.g.,
at a confluence), a stream n
junction is automatically

created and appears as a

highlighted green circle (a L
“light green halo) as shown %

in Figure 5.9. Figure 5.9 Stream Junction

9. Once you have completed the creation of your stream
alignment, save your work. From the File menu, select Save
Watershed and the stream alignment for your watershed will
be saved.
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5.2 Editing an Existing Stream Alignment

After drawing a stream alignment in the display area, there are many
options available for revising your stream alignment. To edit your stream
alignment, you must be in the Watershed Setup Module. The Zoom
Tool can be used to help magnify the stream network, thus providing more
detail to make editing the stream alignment easier.

This section describes the following capabilities for editing your Stream
Alignment:

% how to refine and re-shape your stream alignment (by
moving/adding/deleting vertex points of the stream elements)

X/
°e

how to review stream stationing and provide a stream element
description (by using the stream element editor)

X/
°e

how to rename and delete stream elements

>

7
*

how to add and edit stream nodes (for defining stream stationing)

L)

X/
°e

how to move and edit stream junctions

>

how to reverse the flow direction of a stream element

R/

*

X/
L X4

how to disconnect a stream element

Since the Stream Alignment may be referenced by other models,
care should be used when making any changes to it.

5.2.1 Moving Vertices of a Stream Element

To move a vertex of an existing Stream Element:

1. LockZthe configuration.

2. With the Stream L
Alignment Tool Al %
selected, double-click
anywhere on the stream
element. The stream
element you select will
turn red and all the
vertices of that stream
element will turn blue.

3. Click on the vertex you
want to move, and drag it
to a new location, as
illustrated in Figure 5.10.

Figure 5.10 Moving Stream
Element Vertices
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5.2.2 Adding Vertices to a Stream Element
To add vertex points to an existing stream element:
1. LockEZthe configuration.

2. With the Stream Alignment Tool ﬂ selected, double-click
anywhere on the stream element. The stream element you
select will turn red and all the vertices of that stream element
will turn blue.

3. Place the pointer on the selected stream element where you
want to add a vertex point. Hold down the CTRL key and
click. A blue point will appear on the selected stream where
you have added a vertex point.

5.2.3 Deleting Vertices from a Stream Element
To delete vertex points from an existing stream element:
1. LockZthe configuration.

2. With the Stream Alignment Tool il selected, double-click
anywhere on the stream element. The stream element you
select will turn red and all the vertices of that stream element
will turn blue.

3. Hold down the SHIFT+CTRL keys and click on the vertex
point to be deleted. The blue vertex point will disappear from
the stream element, and the stream will straighten between the
two adjacent vertices.

5.2.4 Editing a Stream Element
To edit a Stream Element:

1. LockEthe configuration.

2. With the Stream Alignment Tool ﬂ selected, right-click on
the stream you want to edit.

3. From the shortcut menu
(Figure 5.11), select Edit

Stream Element to open =Lt
the Stream Ed |t0 r Edit Stream Element. ..

. Rename Stream Element. .,
(F'gu re 5 12) Dizlete Stream Elemant

Reverse Direction

Figure 5.11 Stream Alignment
Shortcut Menu
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? Stream Editor @

Skreamns

MName:  [Bald Eagle Creek v | [W][@] 107 [](m]

Description: | |
Station Easting MHarthing

pstream Mode 286,637,187 1,5864,331.011 206,712,474
151,695, 509 1,9568,165.961 282,904,949
132,215.075 1,970,319.0Z6 294,297,127
74,557,662 2,011,104,703 325,066,476
65,321,507 2,0Ll6,6668.331 327,419,171
26,162,207 2,04z2,2035.808 346,457, 452

DownStream Mode 0,000 2,065,100,020 353,366,313

Figure 5.12 Stream Editor

The Stream Editor displays a summary of the stream name,
description, stationing, and coordinates for a stream element. You can
edit only the description.

Stream name:

The Stream Editor displays the name of the Stream Element you have
selected in the list along with all available Stream Elements in the
watershed. Also, left and right arrows (navigator buttons) allow you
to click through the Stream Elements in the watershed.

Description:
To edit the Description of the Stream Element, you can type into the

text area or click the =l button to access the Enter Description
dialog box (Figure 5.13)

X Enter Description E]

M

] ] [ Cancel

Figure 5.13 Enter Description - Stream Element

Stationing:

The Stream Editor provides you with a report of the stream stationing
and coordinates of the Upstream and Downstream nodes, plus any
stream nodes in between them. Use the Stream Node Editor
(described in Section 5.2.8) to edit the stream stationing of the nodes.
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5.2.5 Renaming a Stream Element
To rename a stream element:

1. Lock D the configuration.

2. With the Stream Alignment Tool ﬂ selected, right-click on
the stream element and select Rename Stream Element.

3. Enter a new Name and Description for the stream element in
the Rename Stream dialog box illustrated in Figure 5.14.

Rename Stream E|
Mame: Bald Eagle Creel
Description: =]
[ (0]%4 ] ’ Cancel ]

Figure 5.14 Rename Stream

5.2.6 Deleting a Stream Element
To delete a stream element:

1. Lock & the configuration.

2. With the Stream Alignment Tool ﬂ selected, right-click on
the stream element and select Delete Stream Element.

3. When the confirmation message (shown below in Figure 5.15)
appears, select either Yes or No.

Confirm Delete

@ ‘yarning: do not delete a stream that is used by any model configuration. Are wou sure you want to delete Stream My Trib Gne?

Figure 5.15 Confirmation Message when Deleting a Stream Element

may use the same stream alignment, so be sure to confirm with

i It is important to remember that other models (e.g., HEC-FIA)
other modelers before deleting any stream elements.
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5.2.7 Inserting a Stream Node

By default, ResSim generates beginning and ending stream nodes for
each stream element. Also, stream nodes are automatically created
where stream elements connect (stream junctions). Since stream

nodes are used for establishing the stream stationing, you may want to
include additional stream nodes along your stream element for
locations where you want to define specific stream stationing.

computations.

It is important to keep in mind when defining the stream
stations that the locations you specify for stationing are

common to all models that use stationing in their

To insert a stream node on an existing Stream Alignment:

1. Lock D the configuration.

4. Using the Stream Node Tool ﬂ hold down the CTRL key
and right-click on the Stream Alignment in the place where the

stream node is to be inserted.

5. When you right-click on the
stream station node, a shortcut
menu appears (Figure 5.16).

6. From the shortcut menu on the
stream node, you can choose
Edit Node, which will bring
up the Stream Node Editor
illustrated in Figure 5.17.

5.2.8 Editing a Stream Node

T

Edit Mode. ..
Delete Mode

Figure 5.16 Stream Node

Shortcut Menu

The Stream Node Editor (Figure 5.17) displays the location

information for the node.

1. The Use Default Stationing check

box is selected by default. When
you select this option, the current
location of the selected node
displays in the Stream Node Editor.
2. If you want to specify the exact
location for the node on the stream
element, then “deselect” the
Use Default Stationing to make
the Station box editable.
3. Enter the location for the station
directly into the Station box, and
then click OK.

Stream | Marsh Creek
Location

Easting 1981607, 701
Morthing 321778, 588

Station 36656, 335

Use Default Stationing

I (8124 ] [ Cancel

l

Figure 5.17 Stream Node

Editor
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5.2.9 Deleting a Stream Node

Since stream nodes define the stream stationing that may be
referenced by other models, care should be used when deleting stream
nodes.

To delete a stream node from an existing Stream Alignment:

1. Lock B the configuration.
2. Find the stream node you wish to delete.

3. Using the Stream Node Tool ﬂ right-click on the stream
node.

4. Select Delete Node from the shortcut menu.
5. A Confirm Delete

message will display Confirm Delete
(Figure 5.18) asking
you whether you real |y @ Caonfirm deletion of Stream Node
want to delete the
selected stream node.

6. Click Yes and the Figure 5.18 Confirm Delete of
message will close and Stream Node

the stream node will be
deleted from the stream element.

5.2.10 Moving a Stream Junction

When two stream elements intersect (e.g., at a confluence), a Stream
Junction is automatically created. A stream junction is multiple
stream nodes at one location and is represented by a dark green circle
with a light green halo around the circle. Although ResSim generates
default stream junctions when you create the Stream Alignment, you
can move them as needed.

To move a Stream Junction along an existing Stream Alignment:

1. Lock B the configuration.
2. With the Stream Node Tool

ﬂ selected, double-click on
the stream junction. The
stream junction you select will
turn dark green and will have .
small squares (handles) at
each corner (Figure 5.19).

3. To move the stream junction,
click and drag it along the

stream element to its new Figure 5.19 Moving a
position. Stream Junction
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5.2.11 Editing a Stream Junction

To edit a Stream Junction:

Stream Junckion

1. Lock B the configuration.
2. Using the Stream Node Tool

ﬂ, right-click on the Stream
Junction to access the shortcut  Figure 5.20 Stream Junction

menu (Figure 5.20). Shortcut Menu
3. Select Edit Junction to open the Stream Junction Editor
(Figure 5.21).

? Stream Junction Editor: @
Easting: 2011104.70 | Morhing: 325066, 45
Stream Modes

lze Default

Stream Station Stationing
Bald Eagle Creek 74,5577
Marsh Creek 0.0

Figure 5.21 Stream Junction Editor

The Stream Junction Editor displays the list of stream nodes
associated with a junction and allows you to edit the stationing of
each of the nodes by deselecting the “Use Default Stationing” box and
entering the desired station.

5.2.12 Reversing the Direction of a Stream

If you find that you have inadvertently drawn your stream element in
the wrong direction (e.g., downstream to upstream when it should be
upstream to downstream), then instead of having to delete the stream
element and redraw it, you can choose to reverse the direction of the
stream element.

To reverse the direction of a stream element:

1. Lock & the configuration.

2. With the Stream Alignment Tool ﬂ selected, right-click on
the stream element and select Reverse Direction from the
shortcut menu.

5-11



Chapter 5 — Working with the Stream Alignment ResSim User’'s Manual

3. A warning message (Figure 5.22) will open asking you whether
you really want to reverse the direction of the stream element.

Confirm Reverse Direction

Warning: reversing the skeam direction will reverse default stationing of the stream,
which may cause problems with other model data relving on the Stream Alignment.
Are wou sure you wank ko reverse the direction of Stream Marsh Creek?

Figure 5.22 Confirm Reverse Direction of Stream Element

4. Click Yes and the warning message will close and the stream
element’s direction will be reversed.

5.2.13 Disconnecting a Stream Element

A stream element can be connected to another stream element (e.g., at
the confluence of two streams). If, for some reason, you need to
disconnect the stream element from another stream element, you can
do so.

To disconnect a stream element from another stream element:

1. Lock & the configuration.

2. With the Stream Alignment Tool ﬂ selected, right-click on
the stream element you want to disconnect and select either
Disconnect Upstream or Disconnect Downstream, as
appropriate, from the shortcut menu.

3. The stream element will now be disconnected from the other
stream element. On the display area, the upstream (or
downstream) point will physically move away from the
connecting stream element and a stream node will remain
where the stream element was originally connected.

5.3 Importing a Stream Alignment

To import a stream alignment you must first have as an active map layer
(see “Adding a New Map Layer” in Chapter 3, Section 3.4.2) an
ArcView® shapefile which represents the stream system of your
watershed. This shapefile must have an attribute that is the name of each
stream, and each stream must form a contiguous line with one upstream
point and one downstream point.

To import a stream alignment:

1. You must be in the Watershed Setup Module. From the
Module list, select Watershed Setup.

5-12
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2. Add the map layer that will be imported to the display area (see
“Adding a New Map Layer” in Chapter 3, Section 3.4.2 to add
a map layer).

3. From the Watershed menu, point to Import, and then select
Stream Alignment.

4. The Import Stream e &
Allgnment d|alog bOX Shapefile Mame: | rUsarDs ionibase/Demo 5 5hp
- - Shapefile Information:
(Figure 5.23) will open. SO 2

Stream_ID Impon
Bald Eagle Creek
Beech Creek
Fishing Creek
Marsh Craek
Nittany Creek
Spring Creek

HRIEERE

5. In the Shapefile Name box is
displayed one of the
ArcView® shapefiles defined
as active map layers in your
watershed. ResSim
automatically selects the first
shapefile that contains
polylines. Therefore, if this
is not the desired shapefile, 0 oap Toerance:
then from the File menu, e B e e

.
select Choose Shapefile. Figure 5.23 Import Stream

Alignment

6. The Choose Shapefile dialog box (Figure 5.24) will open. In
the Available box is a list of the available polyline shapefiles
that you have added as map layers. In the Selected box is the
polyline shapefile that has been chosen. To choose a different
polyline shapefile, use the Add and Remove buttons to get the
correct shapefile. In Figure 5.24, the polyline shapefile to be
used for importing the stream alignment is BaldEagleRivers.shp.

R Choose Shapefile @

Available Selected
BaldEagleStreams.shp BaldEagleRivers.shp

4

Add Al »
4 Remaove All

ok [ canea |

Figure 5.24 Choose Shapefile
(for Importing Stream Alignment)
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7.

10.

11.

Once the correct shapefile has been chosen, the required
attribute is the name of each stream. The program
automatically searches for a database field name of
Stream_ID. If there is not a database field name of
Stream_ID, then in the Database Field Name list, you must
select the database field name that contains the names of each
stream. In the example shown in Figure 5.23, for the shapefile
BaldEagleStreams.shp, the database field name is Stream_ID.

When you have selected the correct database field name, the
table will list the stream names. If each stream is a contiguous
line with one upstream point and one downstream point, then
the checkbox in the Import column of the table will be set. If
there is something wrong with the line that represents a stream,
the checkbox will not be set, and ResSim will not import that
stream element.

Gap Tolerance (Figure 5.23) is used to connect stream
elements that have a gap between the end point and the
junction with another stream. By default, the Gap Tolerance
is set to zero (0.0), so ResSim can connect streams to other
streams. If you click Gap Tolerance, then you need to enter a
value larger than zero in the Gap Tolerance box, which will
allow ResSim to connect streams that might have a larger gap
between them.

The Replace Existing Stream Alignment box, allows you to
replace the existing stream alignment with the one being
imported from the selected ArcView® shapefile.

Once everything is set, click Import. The stream alignment
will be automatically drawn in the display area. From the File
menu, choose Close and the Import Stream Alignment dialog
box (Figure 5.23) will close.

5.4 Exporting a Stream Alignment

If you have digitized a stream alignment by hand, you might want to save
that stream alignment as an ArcView® shapefile. To export a stream
alignment you must have a stream alignment in the display area.

To export a stream alignment:

1.

You must be in the Watershed Setup Module. On the
Module list, click Watershed Setup.

From the Watershed menu, point to Export, and then select
Stream Alignment.
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3. A Save File browser (Figure 5.25) will open. Enter a name in

the File Name box. Click OK, the Save File browser will
close, and you will have an ArcView® shapefile of the
displayed stream alignment.

X Save File
Drive W‘fl @EEE
Folder: ‘ GIHEC Datall_ResSim_v3_forUserDocumentation/base/Demo/maps
7‘ rFolder: C.}
hé‘ j iﬂ BaldEagleRivers.shp
Watershed @ BaldEagleStreams. shp
@ BaldEagleyvatershed shp
I@g\j @ raingage.shp
CWMS_HOME
File name | MyStreamAl\gnmemExpnnmﬂ | [ Ok I
Files of Twpe : :*SE’:I Cancel

Figure 5.25 Save File Browser

5.5 Configuring Stream Alignment Display Properties

You can change the color, line width, font, and tic mark properties of a
Stream Alignment using the Stream Alignment Properties Editor. The
section on “Viewing and Configuring Layer Properties” in Chapter 4,
Section 4.4 describes in detail how to change Stream Alignment display
properties.

To change stream alignment properties:

1.
2.
3.

From the View menu, select Layers.

The Layer Selector dialog box will open.

Right-click on the StreamAlignment layer in the tree. From the
shortcut menu, click Properties.

The Stream Alignment

Properties dialog box

(Figure 5.26) will open. s

To change the color of the | cememne ——

stream alignment layer, e T :

select a color from the omnca - [ome | 1,

Stream Color list. The —

preview pane to the right | “wes” " e

of the Edit Properties S

box will display the Pt

selected color. L m—
Figure 5.26 Stream Alignment

Click OK and the Stream Properties
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Alignment Properties dialog box will close and the color change
will appear in the display area.

7. Repeat steps 5 and 6 for any other changes you wish to make to
the stream alignment properties.

8. Once you have finished, from the Layer Selector dialog box,
click OK to close.

5.6 Saving the Stream Alignment

Since creating a stream alignment can be a very detailed activity, you
should save it frequently during its creation. From the File menu, click
Save Watershed. This command will save all of the stream alignment
properties and the appropriate files created and used by ResSim for the
stream alignment.

5.7 Listing of Streams

Once you have your stream alignment completed, it’s a good idea to
review the streams in your stream alignment. From the Watershed Setup
Module, there is a report that contains this information.

1. From the Reports menu, select List of Streams and a report
similar to Figure 5.27 will appear.

X BaldEagleDemo - List of Streams g@gl

File  Help
BaldEagleDema
List of Streams

Stream

Mame Description
Bald Eagle Creek
Beech Creek
Fishing Creak
marsh Creek
MF Beech Creek
Kittany Creek
Spring Creek

Cloze

Figure 5.27 List of Streams in Stream Alignment

2. This report provides a list of streams and their descriptions that
have been input for the stream alignment.

3. From the File menu of the report, you can print the report, or
you can export the report as an ASCII tab-delimited file.

4. Click Close and the List of Streams report will close.
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In the Watershed Setup Module you can define the Projects and
Computation Points used in ResSim.

ResSim provides the tools for drawing geographically referenced Projects
including Reservoirs, Levees, Diversions, Channel Modifications, Off-
Channel Storage Areas, and “Other” Projects. The tools provide the
ability to edit the graphical representation of the Project within the map
display panel, and they also provide access to menu items for editing the
Project data directly from the map display. ResSim computations include
only reservoir and diversion projects.

When you add a Project to the map display panel, it becomes part of the
Configuration you currently have selected. A “superset” of all
configurations is named “Study” and includes all of the Projects for the
watershed. For more information on associating projects with
Configurations, refer to Chapter 7.

The Computation Point set contains all locations where time-series
information is to be computed for possible exchange between application
models (e.g., ResSim and FIA). ResSim automatically generates
Computation Points when Projects are placed on the Stream Alignment.

6.1 Creating a Reservoir

You will create a reservoir by starting at the upstream end of the reservoir.
After the reservoir has been created, several visual elements will appear
(as shown in Figure 6.1) that represent a reservoir: a storage reach (cyan),
a “pool” (cyan triangle), a “dam” (small gray rectangle), and computation
points (black dots) at the upstream and downstream locations of the
reservoir on the stream alignment.

hiyFRes IN

MyRes

hMyRes OUT

L 4

Figure 6.1 Reservoir Elements in Watershed Setup Module




Chapter 6 — Creating Watershed Elements ResSim User’'s Manual

To add a reservoir to the watershed:

1. Select the Reservoir Tool il

2. While holding down the CTRL key, click on the stream
alignment at the upstream location of the reservoir. If more than
one stream flows into the reservoir pool, continue holding down
the CTRL key and click at each location of inflow into the
reservoir on these streams.

3. Release the CTRL key and click on the stream alignment at the
downstream location of the reservoir (where the dam is located).
Reservoirs should not overlap previously placed computation
points.

4. When you release the mouse button after creating the downstream
end of the reservoir, the Name New Reservoir dialog box

appears (Figure 6.2).
? Name Mew Reservoir @
MHame: MyRes
Description: | -

[ Ok ] ’ Cancel

Figure 6.2 Name New Reservoir

5. You name the Reservoir by typing a name in the Name field.
Optionally, you can enter a Description for the Reservoir.
6. Click OK when you are done.

The new Reservoir will now appear in your map display.

6.1.1 Editing Reservoir Data (Watershed Setup)
To edit data for the Reservoir in the Watershed Setup Module, select

the Reservoir Tool Al and right-click on the Reservoir. From the
shortcut menu, select Edit Reservoir to access the Reservoir Editor
(Figure 6.3).
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? Reservoir Properties Editor E]

Project  Edit
Reservair Mame: MyRes v [E]@ 1of2 [E][E]
Description: )

Reservair Information:

Stream Mame: | my Main River [] Existing Project [] Carps Project
Label Position: |MORTH w Yearin Service: 1900
[ QK l [ Apply ] [ Cancel l

Figure 6.3 Reservoir Properties Editor

In the Watershed Setup Module, the only data that you need to specify
for the Reservoir is its Name and Label Position (additional data is
entered in the Reservoir Network Module). The Label Position
selects where to place the reservoir name in the display area, relative
to the reservoir.

Check Existing Project if the reservoir currently exists so that the
reservoir will be added automatically to any new configurations. You
can remove it at any time by selecting Remove from Configuration
in the shortcut menu or by using the Configuration Editor. Thisis a
useful option if you are creating multiple configurations that use the
same set of reservoirs.

Certain models compute project benefits (e.g., HEC-FIA); therefore,
use the Corps Projects checkbox to indicate if the reservoir is a
Corps Project.

The Year in Service field is optional and is used in planning studies.
You do not need to specify a year in service when defining projects
for real-time studies.

6.1.2 Renaming a Reservoir

To rename a Reservoir, select the Reservoir Tool Al and right-click
on the Reservoir. From the shortcut menu, select Rename Reservoir.
This command opens a dialog box that allows you to rename the
reservoir. A warning message (Figure 6.4) appears when you save the
new name, asking you to

confirm that you want to Warning!
rename the reservoir. If you
. Do you really wank to renarne
choose to rename the reservoir, & MyRes?
remember that changing a
I Yes ] [ [{a} ] [Cancell

reservoir name may affect one
or more of the configurations
that recognize the reservoir.

Figure 6.4 Warning Message when
Renaming Reservoir
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6.1.3 Removing a Reservoir from a Configuration

To remove a Reservoir from the current Configuration, select the

Reservoir Tool Al and right-click on the Reservoir. From the
shortcut menu, select Remove from Configuration. This command
removes the reservoir from the Configuration that is currently
displayed in the Configuration box on the toolbar. The Confirm
Removal dialog box appears (Figure 6.5).

Confirm Remowal

@ Are wou sure you want ko remove Reservoir MyRes From Configuration Existing?

Yes

Figure 6.5 Confirm Removal of Reservoir

You can also remove a Reservoir from a Configuration by accessing
the Configuration Editor and manually removing the reservoir from
the Projects tab using the Project Selector.

6.1.4 Deleting a Reservoir

To delete a Reservoir from the watershed, select the Reservoir Tool

Al and right-click on the Reservoir. From the shortcut menu, select
Delete Reservoir. This command removes the reservoir and all data
associated with the reservoir from the watershed. You are asked to
confirm a deletion before the reservoir is removed, and asked if you
would like to delete the reservoir’s computation points. If you choose
to delete the reservoir, remember that deleting the reservoir may
affect one or more of the configurations that recognize the reservoir.

6.1.5 Adding Configuration Notes for a Reservoir

To add Configuration Notes for a Reservoir, select the

Reservoir Tool il and

right-click on the Reservoir. m
From the shortcut menu, cenfuatan
select Configuration Notes.
This command opens a dialog
box (Figure 6.6) for entering
text information about a
project specific to the

configuration. Figure 6.6 Configuration Notes
for Reservoir

Project Mame: [Sayers 4

Configuration Motes:
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6.2 Creating a Levee

A levee is an earthen barrier built along a stream to provide protection
from flooding. A levee can reduce flood damage by preventing flood
stages from reaching a potential damage area.

To add a levee to the watershed:

1. Select the Levee Tool .Q]

2. While holding down the CTRL key, click on the stream
alignment to select the upstream end of the levee, then release the
CTRL key and click to select the downstream end.

When you release the mouse button after clicking at the downstream end
of the levee, a dialog box appears for you to provide a name and
description. After entering a Levee name, the levee will be drawn as a
black line following the stream alignment. However, using the Levee
Editor (see Follows Stream option in Section 6.2.1), you can allow for
positioning the levee along the side of the stream alignment in the display
area (Figure 6.7).

Figure 6.7 Levee Drawing

6.2.1 Editing Levee Data

To edit Levee data, right-click on the levee and select Edit Levee.
The Levee Properties Editor opens, as shown in Figure 6.8.

In addition to the Levee Name and Description, the Levee Editor
displays the Stream Name and the Start and End Stations for the
levee. You can edit the stationing manually by directly entering
values in the Start Station and End Station fields.

The Follows Stream checkbox is selected by default. With this
option selected, the levee is drawn in parallel to the stream alignment.
By deselecting the Follows Stream checkbox, you can allow for
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moving the levee and editing its shape using the Levee Tool ﬂ in
the map display. To do this, first double-click the levee to select it.
The levee will turn yellow and the beginning and end points will
appear as black dots. To add additional vertex points, CTRL-click
along the levee. You can then drag any of the vertex points to the
desired location. This process is very similar to editing the stream
alignment, with the exception of the mouse tool used.

Certain models compute project benefits (e.g., HEC-FIA); therefore,
use the Corps Projects checkbox to indicate if the levee is a Corps
Project.

ResSim does not actually use levees in its computations. However,
those models that do use levee data in their computations contain the
tools for configuring the levee data. Therefore, refer to the
appropriate model’s User’s Manual (e.g., HEC-FIA) for further
information.

X Levee Properties Editor @

Project  Edit
Levee Name: Lock Haven Levee v | [W](a] 1011 |[][m]
Description: L]

Levee Information:

Start End
Stream Station Station
Bald Eagle Creek | 431. 226 | 4,174,322/
[] Fallows Stream [] Existing Project Corps Project
Bank: Left | Average Offset:
YearIn Service: o

Figure 6.8 Levee Properties Editor
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6.2.2 Renaming a Levee

To rename a Levee:

1. Select the Levee Tool ﬂ and right-click on the Levee.

2. From the shortcut menu, select Rename Levee. This
command opens a dialog box that allows you to rename the
levee.

3. If you choose to rename the levee, remember that changing the
levee name may affect one or more of the configurations that
recognize the levee.

4. A warning
message appears Warning!

(Figure 6.9) when
you save the new & Do you really wank ko rename
. Lock Haven Levea?
name, asking you
to confirm that | ves || Mo | [cancel |
you want to
rename the levee.  Figure 6.9 Warning Message
when Renaming Levee

6.2.3 Removing a Levee from a Configuration

To remove a Levee from the current Configuration:

1. Select the Levee Tool ﬂ

2. Right-click on the Levee.

3. From the shortcut menu, select Remove from Configuration.
This command removes the levee from the Configuration that
is currently displayed in the Configuration box on the toolbar.
The Confirm Removal dialog box appears (Figure 6.10).

Confirm Remowval

® Are you sure you want ko remowve Levee Lock Haven Levee From Configuration Existing?

Figure 6.10 Confirm Removal of Levee

You can also remove a Levee from a Configuration by accessing the
Configuration Editor and manually removing the levee from the
Projects tab using the Project Selector.
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6.2.4 Deleting a Levee

To delete a Levee from the watershed:

1. Select the Levee Tool ﬂ

2. Right-click on the Levee.

3. From the shortcut menu, select Delete Levee. This command
removes the levee and all data associated with the levee from
the watershed. You are asked to confirm a deletion before the
levee is removed. Again, if you choose to delete the levee,
remember that deleting the levee may affect one or more of the
configurations that recognize the levee.

6.2.5 Adding Configuration Notes for a Levee
To add Configuration Notes for a Levee:

1. Select the Levee Tool ﬂ and right-click on the Levee.

2. From the shortcut menu, select Configuration Notes. This
command opens a dialog box (Figure 6.11) for entering text
information about a project that is specific to the configuration.

Configuratian:

Froject Mame: |Lack Haven Levee b

Configuration Motes:

Figure 6.11 Configuration Notes for Levee
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6.3 Creating a Diversion

To add a Diversion to the watershed:

1. Select the Diversion Tool .d

2. While holding down the CTRL key, click to select the location on
the stream alignment where the diversion will occur (the “from”
location). Then, release the CTRL key and click to select the
location where the diverted water will go (the “to” location). The
“to” location (location that will receive the diverted water) can be
on the stream alignment (which indicates that the diverted water
will remain within the channel system) or it can be a point in the
display area that is not connected to the stream alignment (which
will indicate a loss of the diverted water to the channel system).

3. When you release the mouse button after creating the diversion, a
dialog box appears for you to provide a name and description.
After entering a name, the Diversion is drawn in the display area.
If both ends of the diversion are connected to the stream
alignment, then Computation Points are automatically generated
at each end of the diversion (the color of the arrow head will be
blue). If the diversion is only connected to the stream alignment
at the location where the water is diverted from, then a
Computation Point will be generated at that location only (and the
color of the arrow head will be black).

4. It’s a good idea to rename the Computation Points that are
automatically generated for a diversion. To do this, select the

Computation Point Tool ®|and right-click on the computation
points at the ends of the diversion. Then, from the shortcut menu,
select Rename Computation Point. Figure 6.12 shows example
diversions where the Computation Points for the diversions were
renamed (“PutDiv”, “GetDiv”, and “DivOut”).

After the diversion is
defined, it will show up as a
black line with an arrow head
at the divert-to end. If the
diversion leaves one location
and returns to another
location (see “MyDiv”
diversion in Figure 6.12), the
arrow head is blue. If the o
diversion leaves the system T

(see “YourDiv” diversion in
Figure 6.12), then the arrow ] -
head is displayed in black Figure 6.12 Example Diversions

instead of blue.
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6.3.1 Editing Diversion Data

To edit Diversion Data:

1. Select the Diversion Tool .d
2. Right-click on the Diversion and select Edit Diversion. The
Diversion Editor opens, as shown in Figure 6.13.

? Diversion Properties Editor @

Project  Edit

Diversion Mame: |Future Diversion s | (W] Ca] 1 or1 ] (m)

Description: Future Diversion, 2007 [J

Diversion Information:

Stream
Mame

Common Comp..

Paint Mame Mare

Resenmnir ‘

Upstream by Main River |FutDivut [ |
Diownstream [ [ [ |
[[] Existing Project [ Corps Project  Yearin Service: 1500
Label Position: MORTH -

Figure 6.13 Diversion Editor

The Diversion Editor is similar to the Reservoir Editor described in
Section 6.1.1. You can specify whether the diversion is an Existing
Project, a Corps Project, the Label Position, and the Year In
Service (as previously described in Section 6.1.1). The Stream the
diversion connects to is shown.

6.3.2 Renaming a Diversion

To rename a Diversion

1. Select the Diversion Tool d

2. Right-click on the Diversion and from the shortcut menu select
Rename Diversion. This command opens a dialog box that
allows you to rename the diversion. If you choose to rename
the diversion, remember that changing the diversion name may
affect one or more of the configurations that recognize the
diversion.

3. A warning message
(Figure 6.14) appears Warning!
when you save the new
name, asking you to &
confirm that you want
to rename the
diversion.

Do wou really want ko rename
Future Diversion?

I Yes H i ][Cancel]

Figure 6.14 Warning Message when
Renaming Diversion
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6.3.3 Disconnecting a Diversion
If you decide to disconnect the outflow of a diversion:
1. Select the Diversion

Tool .d Wilesburg Jot

2. Right-click on a
Diversion that is
connected to another a0t
location and select

Disconnect Outflow Dvermians 'D' oncs
from the shortcut Edit Diversion...
menu (Figure 615) Rename Diversion...

Remove from Configuration
Delete Diversion

Configuration Motes...

Disconnect OutFlow

Figure 6.15 Diversion Shortcut Menu
Disconnect Outflow

6.3.4 Removing a Diversion from a Configuration

To remove a Diversion from the current Configuration:

1. Select the Diversion Tool d

2. Right-click on the Diversion and from the shortcut menu select
Remove from Configuration. This command removes the
diversion from the Configuration that is currently displayed in
the Configuration box on the toolbar. The Confirm Removal
dialog box will appear.

You can also remove a Diversion from a Configuration by accessing
the Configuration Editor and manually removing the diversion from
the Projects tab using the Project Selector.

6.3.5 Deleting a Diversion

To delete a Diversion from the watershed:

1. Select the Diversion Tool .d and right-click on a Diversion.

2. From the shortcut menu, select Delete Diversion. This
command removes the diversion and all data associated with
the diversion from the watershed. You are asked to confirm a
deletion before the diversion is removed. Again, if you choose
to delete the diversion, remember that deleting the diversion
may affect one or more of the configurations that recognize the
diversion.
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6.3.6 Adding Configuration Notes for a Diversion

To add Configuration Notes for a Diversion:

1. Select the Diversion Tool .d and right-click on the
Diversion.

2. From the shortcut menu, select Configuration Notes. This
command opens a dialog box (Figure 6.16) for entering text
information about a diversion that is specific to the
configuration.

Configuration:
Froject Name: |Diversion3 4

Configuration Hotes:

Figure 6.16 Configuration Notes for Diversion

6.4 Creating Channel Modifications

To add a Channel Modification to the watershed:

1. Select the Channel Modification Tool E

2. Hold down the CTRL key and click at the upstream end of the
channel modification along the stream alignment.

3. Release the CTRL key and click on the downstream end of the
channel modification.

When you release the mouse button after creating the downstream end, the
channel modification is drawn along the stream alignment and a dialog
box appears for you to provide a name and description. After entering a
name, the channel modification is drawn along the stream alignment in the
display area. Note that Channel Modifications are not yet implemented in
ResSim’s computations.
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6.4.1 Editing Channel Modification Data
To edit Channel Modification Data:

=

Select the Channel Modification Tool E

Right-click on the Channel Modification and select Edit
Channel Modification. The Channel Modification Editor
opens, as shown in Figure 6.17.

X Channel Modification Properties Editor E|
Project  Edit
Channel Modification Name: [MyChanMod v E@ 10f1 @@
Description: o
Channel Modification Information:
Strearn Mamme: | My Main River YeatIn Service 1300
Station Easting Marthing
Upstream | 167,515.67|  1,945,445.11] 276,141, 14|
Downstrearm | 160,258.63|  1,951,473.74 278,927, 16|
[] Existing Project  [] Corps Project Label Position: MORTH ~
[ QK l [ Apply ] ’ Cancel ]

Figure 6.17 Channel Modification Editor

The Channel Modification Editor contains the basic configuration data
for the Channel Modification Project, such as whether it is an Existing
Project, a Corps Project, the Label Position, the Stream Name, and
the Year in Service (as previously described in Section 6.1.1).

6.4.2 Renaming a Channel Modification
To rename a Channel Modification:

1.

2.

Select the Channel Modification Tool E and right-click on
the Channel Modification.

From the shortcut menu, select Rename Channel
Modification. This command opens a dialog box that allows
you to rename the channel modification. If you choose to
rename the channel modification, remember that changing the
name may affect one or more of the configurations that
recognize the channel modification.

A warning message
(Figure 6.18) appears
when you save the new
name, asking you to
confirm that you want
to rename the channel
modification.

Warning!

N

Do you really want bo rename
My ChanMod?

I Yes H Mir ][Cancel]

Figure 6.18 Warning Message when
Renaming Channel Modification
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6.4.3 Removing a Channel Modification from a
Configuration

To remove a Channel Modification from the current Configuration:

1.

2.

Select the Channel Modification Tool E and right-click on
the Channel Modification.

From the shortcut menu, select Remove from Configuration.
This command removes the Channel Modification from the
Configuration that is currently displayed in the Configuration
box on the toolbar. The Confirm Removal dialog box appears.

You can also remove a Channel Modification from a Configuration
by accessing the Configuration Editor and manually removing the
Channel Modification from the Projects tab using the Project
Selector.

6.4.4 Deleting a Channel Modification

To delete a Channel Modification from the watershed:

1.

2.

Select the Channel Modification Tool E and right-click on
the Channel Modification.

From the shortcut menu, select Delete Channel Modification.
This command removes the Channel Modification and all data
associated with it from the watershed. You will be asked to
confirm a deletion before the Channel Modification is
removed. Again, if you choose to delete the Channel
Modification, remember that deleting it may affect one or more
of the configurations that recognize the project.

6.4.5 Adding Configuration Notes for Channel
Modifications

To add Configuration Notes for a Channel Modification:

1.

2.

Select the Channel Modification Tool E and right-click on
the Channel Modification.

From the shortcut menu,
Select Conﬁgu ratlon Configuration

Project Mame: yChanMod 9

Notes. This command
opens a dialog box (Figure
6.19) for entering text
information about a project C o ]
that is specific to the
configuration.

Configuration Notes:

appy | [ cancer |

Figure 6.19 Configuration Notes
for Channel Modification
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6.5 Creating Off-Channel Storage Areas
To add an Off-Channel Storage Area to the watershed:

1. Select the Off-Channel Storage Tool ﬂl

2. Hold down the CTRL key and click the location in the map
where you want to add the Storage Area. Continue to hold the
CTRL key while you click to add additional vertex points for the

bounding polygon that represents the Off-Channel Storage Area.

3. When you reach the end point, release the CTRL key and click to
place the last point.

4. When you release the mouse button, a dialog box appears for you
to provide a name and description. After entering a name, the
polygon appears in the map display area. Note that Off-Channel
Storage Areas are not yet implemented in ResSim’s computations.

6.5.1 Editing Off-Channel Storage Data
To edit Off-Channel Storage data:

1.

2.

Select the Off-Channel Storage Tool ﬂl and right-click on
the Off-Channel Storage Area.

Select Edit Off-Channel Storage. The Off-Channel Storage
Editor opens, as shown in Figure 6.20.

X Off Channel Storage Area Properties Editor, @

Project  Edit
Off Channel Storage Area Mame: (ofchanStorage | (1[4 1 011 [][m]
Description: ]

Off Channel Storage Area Information:

Strearn Mame: | My Main River [] Existing Praject [] Corps Project
Label Position: |MORTH w Yearin Service: 1900
[ Ok ] ’ Apply ] ’ Cancel ]

Figure 6.20 Off-Channel Storage Editor

The Off-Channel Storage Editor contains the basic configuration data
for the Off-Channel Storage project, such as whether the project is an
Existing Project, a Corps Project, the Label Position, the Stream
Name, and the Year in Service (as previously described in Section

6.1.1).
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6.5.2 Renaming an Off-Channel Storage Area

To rename an Off-Channel Storage Area:

1.

2.

Select the Off-Channel Storage Tool ﬂl and right-click on
the Off-Channel Storage Area.

From the shortcut menu, select Rename Off-Channel
Storage. This command opens a dialog box that allows you to
rename the Off-Channel Storage Area project. If you choose to
rename the Off-Channel Storage Area project, remember that
changing the name may affect one or more of the
configurations that recognize the project.

A warning

message (Figure Warning!

6.21) appears

when you save the & Do wou really want to rename
new name asking OfFChanStorage?

you to confirm [ fes ] [ Mo ] [Cancel ]
that you want to

rename the Off- Figure 6.21 Warning Message when

Channel Storage Renaming Off-Channel Storage Area
Area project.

6.5.3 Removing an Off-Channel Storage Area from a
Configuration

To remove an Off-Channel Storage Area from the current
Configuration:

1.

2.

Select the Off-Channel Storage Tool ﬂl and right-click on
the Off-Channel Storage Area.

From the shortcut menu, select Remove from Configuration.
This command removes the Off-Channel Storage project from
the Configuration that is currently displayed in the
Configuration box on the toolbar. The Confirm Removal
dialog box will appear.

You can also remove an Off-Channel Storage Area from a
Configuration by accessing the Configuration Editor and manually
removing the project from the Projects tab using the Project
Selector.
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6.5.4 Deleting an Off-Channel Storage Area

To delete an Off-Channel Storage Area from the watershed:

1. Select the Off-Channel Storage Tool ﬂl and right-click on
the Off-Channel Storage Area.

2. From the shortcut menu, select Delete Off-Channel Storage.
This command removes the Off-Channel Storage Area project
and all data associated with it from the watershed. You will be
asked to confirm a deletion before the Off-Channel Storage
Area project is removed. Again, if you choose to delete the
project, remember that deleting it may affect one or more of the
configurations that recognize the Off-Channel Storage Area
project.

6.5.5 Adding Configuration Notes for an Off-Channel
Storage Area

To add Configuration Notes for an Off-Channel Storage Area:

1. Select the Off-Channel Storage Tool ﬂl and right-click on
the Off-Channel Storage Area.

2. From the shortcut menu, select Configuration Notes. This
command opens a dialog box for entering text information
about an Off-Channel Storage Area project that is specific to
the configuration (Figure 6.22).

Canfiguration:

Project Mame: \ofChanStorage b

Canfiguration Motes:

Figure 6.22 Configuration Notes for Off-Channel Storage
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6.6 Creating “Other” Projects
To add “Other” Projects to the watershed:

1. Select the Other Project Tool E
2. Hold down the CTRL key and single click in the location where
you want the other project to appear.

The Other Projects symbol will appear in the map display. Note that
Other Projects are not yet implemented in ResSim’s computations.
6.6.1 Editing “Other” Project Data
To edit “Other” Projects Data:

1. Select the Other Project Tool E and right-click on the
“Other” Project.

2. Select Edit Other Project. The Other Project Properties
editor opens, as shown in Figure 6.23.

X Other Project Properties Editor g|
Project  Edit
Other Praject Mame: [vourotherProj | [W][a] 1 af 1 [(w][m]
Description: )
Other Project Information:
Strearn Mame: |y Main River 1 Connectto Stream Yearin Service: 1200
Ican Position: |EAST * | [] Existing Project [] Corps Project

Computation Paint Infarmatian:

Stream Station:

0.000
Eastinog: 1973891.133
Morthing: 267876.815
Lahel Position: |MORTH W
[ Do Mot Generate Camputation Paint
[ Ok ] ’ Apply ] ’ Cancel ]

Figure 6.23 Other Project Properties Editor

The Other Project Properties editor allows you to define the spatial
location (Coordinates), and contains basic configuration data, such as
whether the project is an Existing Project, a Corps Project, the
Label Position, the Stream Name, and the Year in Service (as
previously described in Section 6.1.1).
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Two options are unique to the Other Project Editor:

1.

Connect to Stream checkbox allows you to associate the
project with a particular stream in case it might be used with a
supplemental model.

Do Not Generate Computation Point checkbox determines
whether or not ResSim will automatically generate a
Computation Point at the location specified in the Coordinates
box.

6.6.2 Renaming “Other” Projects
To rename an “Other” Project:

1.

2.

Select the Other Project Tool @ and right-click on the

Other Project.

From the shortcut menu, select Rename Other Project. This
command opens a dialog box that allows you to rename the
Other Project. If you choose to rename the project, remember
that changing the project name may affect one or more of the
configurations that recognize the Other Project.

A warning

message (Figure Warning!

6.24) appears

when you save & Do you really wank ko rename

the new name, YourOkherProjy

asking you to [ Yes ] [ Mo ] [Cancel ]
confirm that you

want to rename Figure 6.24 Warning Message when

the project. Renaming “Other” Project

6.6.3 Removing “Other” Projects from a Configuration
To remove an “Other” Project from the current Configuration:

1.

2.

Select the Other Project Tool E and right-click on the
Other Project.

From the shortcut menu, select Remove from Configuration.
This command removes the Other Project from the
Configuration that is currently displayed in the Configuration
box on the toolbar. The Confirm Removal dialog box
appears.

You can also remove an Other Project from a Configuration by
accessing the Configuration Editor and manually removing it from
the Projects tab using the Project Selector.
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6.6.4 Deleting “Other” Projects

To delete an “Other” Project from the watershed:

1. Select the Other Project Tool E and right-click on the
Other Project.

2. From the shortcut menu, select Delete Other Project. This
command removes the Other Project and all data associated
with it from the watershed. You will be asked to confirm a
deletion before the Other Project is removed. Again, if you
choose to delete the Other Project, remember that deleting it
may affect one or more of the configurations that recognize the
Other Project.

6.6.5 Adding Configuration Notes for “Other” Projects

To add Configuration Notes for an “Other” Project:

1. Select the Other Project Tool E and right-click on the
Other Project.

2. From the shortcut menu, select Configuration Notes. This
command opens a dialog box (Figure 6.25) for entering text
information about an Other Project that is specific to the
configuration.

Canfiguration:

Froject Marme: vaurCtherPraj -4

Caonfiguration Motes:

Figure 6.25 Configuration Notes for “Other” Projects

6.7 Configuring Project Display Properties

You can configure the appearance of Reservoirs, Levees, Diversions, and
Computation Points in the Study Layer of your watershed using the
Study Properties Editor. See Chapter 4, Section 4.4.1, “Study Layer
Properties” for information on how to change Project display properties.
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6.8 Defining Computation Points

The Computation Point set contains all locations where time-series
information is to be computed. ResSim automatically generates
Computation Points for the watershed based on Project, Stream
Alignment, and Impact Area placement.

To add a Computation Point:

1. Lock & the configuration.

2. Select the Computation Point Tool !I
3. Hold down the CTRL key and click in the desired location.

The new Computation Point will appear in the map display. By default,
Computation Points snap to the stream alignment. If you prefer that the
Computation Point not snap to the stream alignment, de-select the Snap to
Stream Alignment check box in the Computation Point Editor, described
below.

6.8.1 Editing Computation Point Data
Use the Computation Point Editor to edit a Computation Point:

1. Lock & the configuration.

2. Select the Computation Point Tool !l

3. Right-click on the Computation Point to access the shortcut
menu.

4. Select Edit Computation Point. The Computation Point
Editor (Figure 6.26) will appear.

= Computation Point Properties Editor @

Mame: Mill Hall v @@ 7ofg @@

Description: [
Stream Mame: Label Position: |NORTH w
Location Infarmation: Associated Project:

Stream Station: 28971.857

Easting: 2039710.097

Marthing: 349445, 508

Lacation ID:

Shap to Stream Element

Figure 6.26 Computation Point Editor

The Computation Point Editor displays the information associated
with a Computation Point and allows you to edit its location
information.
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Computation Point Name:

The Computation Point Editor displays the name of the Computation
Point you have selected (in the list along with all available
Computation Points in the watershed). Also, left and right arrows
(navigator buttons) allow you to click through the Computation Points
in the watershed.

Description:

To edit the Description of the Computation Point, you can type into
the text area or click the = button to access the Enter Description
dialog box.

Stream Name:

The stream name automatically appears in the Stream Name box. In
the case of a Computation Point situated at a confluence of two
streams, you need to verify that the Computation Point resides on the
appropriate stream.

Label Position: ResSim automatically positions the text label for a
Computation Point where it is least likely to overlap other labels.
However, you can move the position of the layer by selecting a
position from the Label Position list.

Location Information:

» Stream Station: The Stream Station field displays the
location of the computation point along the stream element.

» Easting / Northing: ResSim automatically fills in the
coordinate information. You may type in new coordinates to
relocate the Computation Point on the map display.

Location ID:
Optionally, you can enter a Location ID to reference the Computation
Point to a ResSim ID.

Snap to Stream Alignment:

By selecting the Snap to Stream Alignment check box, you can place
a Computation Point at any location and it will snap to the alignment.
After a Computation Point is snapped on the stream alignment, only

the Stream Station can be edited. ResSim automatically displays the
Stream Name and Stream Stationing and Coordinates.

System Generated:

ResSim automatically generates Computation Points for the
watershed based on Project placement. The System Generated
checkbox is selected if the Computation Point has been system
generated.
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6.8.2 Renaming a Computation Point and Editing the
Description
To rename a Computation Point or edit its description:

1. Lock & the configuration.

2. Select the Computation Point Tool !l and right-click on the
Computation Point.

3. Select Rename Computation Point.

4. Use the Rename dialog box (Figure 6.27) to edit the name and
description. Click the _ button to access the Enter
Description dialog box for longer descriptions.

Rename Computation Point

Mamme: Sayers Inflow Jct
Descriptinn:| Inflow for Savers L |
[ (0] 74 ] ’ Cancel ]

Figure 6.27 Rename Computation Point

6.8.3 Deleting a Computation Point
To delete a Computation Point:

1. Lock & the configuration.

2. Select the Computation Point Tool !l and right-click on the
Computation Point.

3. Select Delete Computation Point from the shortcut menu.
The Confirm Deletion dialog box will appear (Figure 6.28).

4. Click Yes to confirm the deletion.

Confirm Deletion

@ Are you sure you wank bo delete Milesburg Jck from the watershed?

Yes

Figure 6.28 Confirm Deletion of Computation Point
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6.9 Working with Time-Series Icons

Time-Series Icons are not necessary for ResSim simulations. However, as
part of watershed setup, you may need to configure them for other
applications in the modeling software suite.

You can use Time-Series Icons to represent the locations of gages or
Time-Series locations. Typically used in CWMS, they can be linked to
data from either the Oracle Database or from a DSS file. The complete
inventory of Time-Series Icons is viewable in the Watershed Setup
Module. Figure 6.29 shows examples of the icons you can configure in
the Watershed Setup Module.

l} Diversion
& | Junctiona
eldun[:tiunE

‘, Resenrvoir
£3| sink

Source

Subbasin
@ TimeSeries

Figure 6.29 Time-Series
Icons

Refer to the CWMS User’s Manual (HEC, 2006a) for additional
information about Time-Series Icons.
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Chapter 7
Creating Watershed Configurations

Once you have added all of the Projects and Computation Points needed
for the watershed, you will need to create one or more Configurations. A
Configuration is a specific physical arrangement of projects and
computation points that will be modeled for the study of the watershed.
Watershed Configurations are defined within the Watershed Setup
Module.

ResSim provides enough flexibility to create Configurations for use in
both real-time and planning contexts. ResSim creates a “superset” of all
configurations (named Study) that contains all of the projects and
computation points defined for the watershed. Additional Configurations
you create reflect particular watershed conditions. For example, you
might create Configurations for Existing Condition and Future Condition
—2030.

When you create additional Configurations, you can associate projects
with specific Configurations, or add and remove them from the list of
projects associated with a particular Configuration. You make
Configuration associations with Alternatives, as described in Chapter 13.

7.1 Adding Watershed Configurations

Watershed Configurations are added and edited within the Watershed
Setup Module. To add a Configuration:

1. Lock & the Configuration.

2. From the -
Watershed

R Configuration Edit  Projects
menu, click
. . Mame: Existing -
Configuration .
. Description: | Exisiting canditions far Bald Eagle watershed, with levee C]_
Editor. The _ ®
B} N Base Date:
Conflgurat|0n Time Step: 1 Hour
Editor Projects
(Figure 71) W||| Project Project
Mame Project kotes Type Existing
open. Lock Hawen Levee | |Levee |ves |
Sayers | |Resenvair |'res |

Figure 7.1 Configuration Editor
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3.

In the Configuration menu, click New. The Create a New
Configuration dialog box (Figure 7.2) will open.

X BaldEagleDemo - Create a New Configuration @

Marne:

Description: ~

Time Step: |1 Hour

[ Ok H Cancel ]

Figure 7.2 Create a New Configuration

Enter the Name (required) and Description (optional).

The Configuration Time Step is only used when ResSim is
operated as part of the Corps Water Management System
(CWMS) software package, but it is required even when using
ResSim as standalone software. From the Time Step list, select a
computation time step interval for the configuration.

Click OK to close the Create a New Configuration dialog box.

The name of the new configuration will appear in the Name list of
the Configuration Editor, along with its defined Time Step.

Any project flagged as an Existing project (Chapter 6, Section
6.1.1), before you defined the new Configuration, will
automatically be included in the table. To add projects (that are
not flagged as Existing) to the configuration refer to Sections 7.2
and 7.2.1.

Once you have created the new Configuration, you can also
optionally associate a Date with the Configuration. The Base
Date field is used by some HEC applications (e.g., HEC-FIA),
particularly in a planning context. You can either directly type
the date into the field in the appropriate format (e.g., 01Feb2002),
or use the Calendar Tool (Figure 7.3).

To use the Calendar tool:
((Jmar[p] [« 2007 ]

e Inthe Configuration Editor, click

on the [ button to the right of the 1[ 7]
Base Date field. The Calendar IEEE EE
Tool will appear. 1 1z] 3] 14 15] 18] 17
e Select the month and year by il e i Bl Bl
clicking the left and right arrow il ol el el el

buttons to navigate backwards and
forwards. Select the day by clicking

Thu 8 Mar 2007

on the appropriate day button. [ ok J[ cance ]
¢ Click OK to close the Calendar Figure 7.3 _(I_Zalelzndar
00

tool.
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10. When you are done creating the new Configuration, Click OK to
close the Configuration Editor.

7.2 Adding and Removing Projects from
Configurations

As you set up your watershed and manage it over time, you may need to
add new Projects to, or remove Projects from, Configurations you have
created. To do this:

1. Select the Configuration you want to edit from the
Configurations list on the toolbar.

2. Lock & the Configuration.

3. Open the Configuration Editor from the Watershed menu.

4. From the Projects menu, select Edit Project List, as shown in
Figure 7.4.

? Configuration, Editor,
Configuration  Edit Wi

Edit Project List., .. |

=

Mlame: Ewisl w

Cescription: | Exisiting conditions for Bald Eagle watershed, with leves ).

Baze Date: [:]
Time Step: 1 Hour

Frojects

Project Project

MHame FProject Motes Type Existing
Lock Hawen Levee Levee Tes
Savers Resermair YRS

I Ok H ARply H Cancel

Figure 7.4 Configuration Editor — Edit Project List Option
from Projects Menu

5. The Project Selector dialog box (Figure 7.5) will open. The
Project Selector displays the Configuration name and description
for reference. The left pane contains all Available Projects not
already associated with the Configuration (in this example, two
projects, Channel and ChannelMod). The Projects in
Configuration pane on the right lists all Projects currently
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associated with the Configuration. Between the two panes are
four buttons that enable you to add and remove projects of the
Configuration by moving Projects from one pane to the other.

? Project Selector. @

Marrne: Existing
Description: Exisiting conditions for Bald Eagle watershed, with levee at Lock Haven impact area. ~
bt
Available Projects FProjects in Configuration
Channel Lock Haven Levee
ChannelMod Sayers
»
4
Add Al »
4 Remove All

OK l ’ Cancel

Figure 7.5 Project Selector

7.2.1 Adding Projects to a Configuration
To add Projects to an existing Configuration:

1. To add individual Projects, click on the Project’s name in the
Available Projects list (Figure 7.5) to select it, and then click
the Add button to move it to the Projects in Configuration
list.

2. Toadd all of the Available Projects to a Configuration, click
the Add All button.

3. Click OK to save your changes and close the Project Selector
dialog box.

7.2.2 Removing Projects from a Configuration
To remove Projects from an existing Configuration:

1. Toremove individual Projects, click on the Project’s name in
the Projects in Configuration list (Figure 7.5) to select it, and
then click the Remove button to move it to the Available
Projects list.

2. Toremove all of the Projects in Configuration from a
Configuration, click the Remove All button.

3. Click OK to save your changes and close the Project Selector
dialog box.
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7.3 Adding Project Notes to a Configuration

Project notes within a Configuration are any comments that pertain
specifically to a project in a particular Configuration. To Add or Edit
project notes within a Configuration:

1. Select a project row in the Configuration Editor. If you do not
select a project in the Configuration Editor before selecting the
Project Notes menu item, you are alerted to select a project from
the list.

2. Choose Project Notes from the Edit menu. The Project Notes
dialog opens (Figure 7.6).

X Project Motes Editor, @

Configuration: | |

Project Mame:

Configuration MNates:

Figure 7.6 Project Notes Editor

3. When the Configuration Notes dialog opens, enter any
Configuration-specific notes as needed.
4. Click OK to close the Configuration Notes dialog box.

7.4 Making a Copy of a Configuration

Sometimes you might want to make an exact copy of an existing
configuration and then make some changes to it so you have a different
configuration. To make a copy of a configuration:

1. On the Configuration Editor (Figure 7.1), from the Name list,
select a configuration that you wish to copy.

2. From the Configuration menu, click Save As..., and the Save As.
dialog box (Figure 7.7) opens.

Save As.. [‘S__<|

Marne: Exizting
Description: Exisiting conditions for Bald Eagle |
[ Ok l ’ Cancel ]

Figure 7.7 Configuration Menu, Save As...
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3. The Name box contains the name of the selected configuration.
Enter a new name in the Name box, and replace the description in
the Description box.

4. Click OK to close the Save As dialog box. In the Name list on
the Configuration Editor the new configuration is included.

7.5 Deleting a Configuration
To delete a configuration:
1. On the Configuration Editor (Figure 7.1), from the Name list,
select the Configuration that you want to delete.
2. From the Configuration menu, select Delete.

3. A warning message (Figure 7.8) will open asking you whether
you really want to delete the selected configuration. Click Yes,
the warning message will close and the configuration name will
no longer appear in the Name list on the Configuration Editor.

Confirm Delete

@ Okay to delete Configuration MyZonfigZopy2

Yes

Figure 7.8 Confirm Delete of a Configuration

7.6 Saving Configuration Data

To save the data you have entered for a Configuration, from the
Watershed menu, click Save Configuration. This command will cause
the program to save all configuration specific data.

7.7 Listing Configurations

Once you have all of your configurations entered, you might like to review
the configurations in your watershed. From the Watershed Setup
Module there is a report that contains this information.

To view the List of All Configurations:

1. You must be in the Watershed Setup Module. On the Module
list, click Watershed Setup.

2. From the Reports menu, choose List of All Configurations, and
the List of Configurations dialog box (Figure 7.9) will open.
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£ BaldEagleDemo - List of Configurations
File Help

BaldEagleDemo
List of Configurations

Basze Time
Mame Date Step Description
Existing 1 Hour(s) Exigiting conditions for Bald Eagle watershed,...
Without_Levee 1 Hour(s) Configuration is without levee at Lock Haven ...
< >

Cloze

Figure 7.9 List of Configurations Report

3. This report provides a list of configurations that have been input
for the watershed. The list includes the Name and Description,
along with the Time Step and Base Date (if entered) for each
Configuration.

4. From the File menu, you can send the report to a printer, or you
can export the report to an ASCII file. See Appendix F, Section
F.4 for more details about printing and exporting tabulated data.

5. Click Close to close the List of Configurations report.
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Chapter 8
Developing a Reservoir Network

A reservoir network represents a collection of watershed elements
connected by routing reaches. Elements created in the Watershed Setup
Module belong to specific watershed configurations, and when you create
a reservoir network, it references one of those configurations.

The computation points defined for a configuration in the Watershed
Setup Module automatically become junctions in the Reservoir Network
Module. Your primary task in developing a reservoir network is to
connect the junctions with routing reaches between junctions.

This chapter provides an overview of the Reservoir Network Module’s
screen components and describes the processes for creating a new
reservoir network, opening an existing reservoir network, making a
network editable, and adding routing reaches. ResSim also allows you to
add additional elements to a reservoir network.

After you have established your reservoir network connectivity, you will
need to edit Junction, Reach, and Diversion data (Chapter 9), define and
edit the Physical components of Reservoirs in your network (Chapter 10),
define Reservoir Operations data (Chapter 11), define Reservoir Systems
(Chapter 12), and define Alternatives (Chapter 13). These steps will
prepare your reservoir network to run Simulations (Chapter 14).
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8.1 Recognizing Reservoir Network Screen
Components

The Reservoir Network Module (Figure 8.1) provides the tools you will
need to develop the connectivity of your reservoir network as well as enter
and edit physical and operations data. What follows is a discussion of the
components and features of the Reservoir Network Module.

Title Bar Current Network Lock/Unlock  Current Network’s Configuration

)

. HEC-ResSim 3.0 - BaldEagleDemo (=13

Menu Bar —p | File Edit VYiew Metwork Alernative Reports Toaols Help ] ] |
Module List —p ) module: [FEEae l'-JEet-.-'-.-'n:nI-:' Metwork: | Base2003 Configuration
Pointer Tool —| -~
Zoom Tool —P @
Pan Tool —
Reservoir Tool —p|
Diverted Outlet Tool —
Reach Tool —
Junction Tool —| @
Diversion Tool —p
Display Area
b
Status Bar ~ ) >
[ 1ates: 2136657 east, 357536 north [Local Workspace BaldEagleDemo opened =]

A

General Message Bar

Figure 8.1 Reservoir Network Module Main Window
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8.1.1 Menu Bar

The following is an overview of the Reservoir Network Module’s
Menu Bar tools, which allow you to create and edit the connectivity
of your reservoir network. The tools specific to this module will be
described in more detail in the context of particular tasks later in this

chapter.

The File menu (Figure 8.2) allows you to el e el
Open an existing watershed, Save a Open Watershed...  Chrl+0
watershed, Save the Display Area SaveWatershed  Ctrl4S
(Map), and Exit ResSim. Your most- Save Map As...
recently-used watersheds are listed at the Exit Chrl+0

bottom of the File menu. 1 BaldEagleDemo

2 Dermnio

3 HavesBasin

Figure 8.2 File Menu

The Edit menu (Figure 8.3) provides ol Wiew  Metwork  Alket
access to the ResSim editors for Reservoirs...
Reservoirs, Reaches, Junctions, Reaches...
Diversions, and Reservoir Systems. Junckions. ..

Also, the editors for State Variables and Diversions. ..

Import Elements are available. You Reservair Systems. ..

must select the Allow Network Editing
option to access the editors.

Skake Wariables, ..

Import Elements. ..

' Allow Metwork Editing

Figure 8.3 Edit Menu

In the View menu (Figure 8.4) select
Zoom to All to restore your watershed

Metwork,  Alkerna

. X Zoorm ko Al
map view to full size. Layers opens the Lavere
Layer Selector dialog box. Unit System YRS
nit Syskern ]

allows you to customize the display
(view) settings for your watershed. If a Restore Windows
dialog or editor window is open but
inactive, Restore Windows brings the
dialog or editor window to the front as
the active window.

Figure 8.4 View Menu
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Metbwiork

The Network menu (Figure 8.5) is

unique to the Reservoir Network Mew...
Module. It allows you to create a Open...
New network, Open an existing Save
network, Save a network or Save Save As...
As a new network, or Rename a REnamE, ..

network. You can also Update
Network from Configuration and
Delete Networks.

alkernative  Reparts

Tools

Ipdate Metwork, From Configurakion

Delete Mekworks, ..

Figure 8.5 Network Menu

The Alternative menu (Figure 8.6), also
available in the Simulation Module, provides
access to the Alternative Editor.

The Reports menu (Figure 8.7) provides access
to the Reservoir List, Reach List, Junction
List, and Diversion List. Also, two Advanced
reports are available: the Network Connectivity
(for All Elements or for Selected Elements) and
the Node L.ist reports.

As in the other modules, the Tools menu (Figure
8.8) provides access to HEC-DSSVue and to
Scripts. Options allows you specify Model
Directories, Cache Directory, Compute Display,
Debug Levels, General information (including
whether to show a confirmation when exiting the
program and whether to reload last watershed at
startup of program), and Fonts. Console Output
displays the information written to the
ResSim.log file. Information provides details
about client, user, and watershed settings as well
as server and system properties.

Aleernative

Edit...

Figure 8.6
Alternative Menu

Tools

Reports

Help

Reservaoir Lisk
Reach Lisk
Juniction Lisk

Diversion Lisk

Advanced r

Figure 8.7
Reports Menu

Help
Hechssvue. ..
Scripks. ..

Qptions. ..
Console Oukput, .,

Information. ..

Figure 8.8 Tools
Menu

In the Help menu (Figure 8.9) the About
command displays information about the
version of ResSim. Also, from this menu Quick Start Guide

you can access user documentation and
Install Example Watersheds (after you
define a watershed location as described

Uset's Manual
Install Example Watersheds. ..

Abouk

in Section 3.3.1).

Figure 8.9 Help Menu
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8.1.2 Network, Configuration, and Lock/Unlock

In the Reservoir Network Module, your current Reservoir Network -

and Configuration, along with the Lock/Unlock icon I%, are
displayed below the Menu Bar and to the right of the Module List, as
shown in Figure 8.10.

MHetwork: | Base2003 Cnnﬂguratinn: Existing

Figure 8.10 Network, Configuration, and Lock/Unlock Icon

The Configuration indicates which configuration the current
Network is based on. As will be described in Section 8.2, you select
the Configuration when you create the Network (using the Network
menu).

The Lock/Unlock icon indicates whether or not the Network is
locked and available for editing. You can lock and unlock the
Network by clicking on the icon or by selecting or deselecting Allow
Editing in the Edit menu.

8.1.3 Map (Mouse) Tools

The Map (Mouse) Tools, which appear in the toolbar on the left side
of the ResSim screen, allow you to interact with objects in the map
display. The Reservoir Network Module has three standard Map
Tools and five network connectivity tools that allow you to establish
the connectivity of your reservoir network.

ll Pointer Tool

Right-click with the Pointer Tool to select and access a shortcut menu
for any schematic element within your map display. The Pointer Tool
is available in all ResSim modules.

3' Zoom Tool

The Zoom Tool allows you to zoom in and out of the display area in
all modules. To zoom in, hold the left mouse button down and outline
the area you want to enlarge. To zoom out, click the right mouse
button. Zooming out using the right click button zooms out by a
factor of two, positioning the clicked location at the center of the
screen. The Zoom Tool is available in all ResSim modules.

ﬂ Pan Tool

After you have zoomed in with the Zoom Tool, you can use the Pan
Tool to view watershed areas that fall outside of the ResSim window
borders. The Pan Tool is available in all ResSim modules.
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il Reservoir Tool

With the Reservoir Tool, you can add reservoirs to your reservoir
network. You can also edit reservoir properties, rename, and delete
reservoirs using commands in the shortcut menu.

i Diverted Outlet Tool

The Diverted Outlet Tool allows you to create a diverted outlet from a
reservoir in your network. The shortcut menu for this tool provides
access to the Reservoir Editor and also allows you to rename and
delete a diverted outlet.

p

= IReach Tool

Use the Reach Tool to draw routing reaches (from upstream to
downstream) to connect the junctions on the stream alignment. You
can also edit reach properties, rename, break, and delete reaches using
commands in the shortcut menu.

— 1 Junction Tool

The Junction Tool allows you to manually insert junctions in your
reservoir network. The shortcut menu for this tool allows you to edit
junction properties, rename and delete junctions.

i Diversion Tool

With the Diversion Tool you can add diversions to your reservoir
network. You can also edit diversion properties, rename, delete, and
disconnect outflow of diversion reaches using commands in the
shortcut menu.

8.1.4 Display Area

In the Reservoir Network Module, the display area contains the
reservoir network connectivity you construct, along with the map
layers, stream alignment, reservoirs and computation points you have
established in the Watershed Setup Module for the current network’s
configuration. Any other time-series icons, projects, and impact areas
you established in the Watershed Setup Module will not appear.

Using the Map (Mouse) Tools to access shortcut menus, you can open
data editors as well as rename and delete elements in your reservoir
network directly from the display area.
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8.2 Defining a Reservoir Network

With a stream alignment in place and one or more configurations defined,
you can create a network of reservoirs and routing reaches. This process
involves defining a new network and then adding routing reaches.

8.2.1 Creating a New Reservoir Network

When you create a new reservoir network, you are defining which
elements will be included in your network by selecting the
appropriate watershed configuration. Once you have created your
network, you can add additional elements. Remember, however, that
any additional elements you add will not be available for use in other
networks. If you want the additional elements to be available for
other networks, you will need to go back to the Watershed Setup
Module and add the new elements to the appropriate configuration,
then return to the Reservoir Network Module to create your reservoir
network using the updated configuration (Section 8.6, “Updating a
Reservoir Network”).

To create a new reservoir network:

1. From the Network menu, select New. The Create New
Reservoir Network dialog box will appear (Figure 8.11).

Create New Reservoir Network @

Watershed: BaldEagleDemo

Existing Reserir Metworks

Marme Description
Base Base Model - less detailed gate settings | &
Standard Basze Model of Bald Eagle Creek

Mew Reserir Metwork

Mame:
Description: )
Configuration: |Existing b

I W= H Cancel l

Figure 8.11 Create New Reservoir Network

2. Specify a Name for the network and enter a Description. You
can click the _ button to access a larger text field for your
description.

3. From the Configuration list, choose the configuration on
which this network will be based.

4. Click New.

8-7



Chapter 8 — Developing a Reservoir Network ResSim User’'s Manual

The Create New Reservoir Network dialog box will close, and you
will see the name of your new network and its configuration displayed
below the Menu Bar, to the right of the Module List (see Section 8.1.2
above).

In the display area, ResSim will automatically create the reservoirs
and computation points that were part of the selected configuration as
elements in the new Reservoir Network. Reservoirs transfer directly,
whereas Computation points appear as Junctions.

8.2.2 Opening an Existing Reservoir Network
To open an existing Reservoir Network for editing:

1. From the Network menu, select Open. The Open Reservoir
Network dialog box will appear (Figure 8.12).

Open Reservoir Metwork E|
Watershed: BaldEagleDemao

Existing Reseroir Metworks
Description

Base Model - less detailed gate settings

Standard Base Model of Bald Eadle Creek

Open Resenmir Metwork

MHame: Baze

Description: | Base Model - less detailed gate settings [

| open || cancel |

Figure 8.12 Open Reservoir Network

2. Select the Reservoir Network you want by clicking on it.
3. Click Open.

The Open Reservoir Network dialog box will close, and you will see
the name of your network and its configuration displayed below the
Menu Bar, to the right of the Module List (see Section 8.1.2 above).

8.3 Making the Network Editable

Before you can begin editing your reservoir network, you must ensure that
the network is editable (“locked”). To do so, select Allow Network

Editing from the Edit menu or click the Lock/Unlock button .
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8.4 Adding Routing Reaches

Routing reaches are elements that establish the connectivity of the
reservoir network schematic. By adding a routing reach between two
junctions, you can connect the reservoir network so that water will
transverse through the routing reach from upstream to downstream.

8.4.1 Drawing Routing Reaches

Routing Reaches are drawn from upstream to downstream. You
connect two adjacent junctions (typically, computation points added
to the network’s Configuration in the Watershed Setup Module) by
drawing a routing reach.

To draw routing reaches:

1. Select the Reach Tool i

2. Point to the upstream junction at the upstream end of the reach.

3. Hold down the CTRL key and click on the junction to start the
upstream end of the reach.

4. Release the CTRL key and move the mouse pointer along the
stream alignment and click on the downstream junction.

Routing reaches automatically conform to the stream alignment. You
can connect routing reaches to existing junctions; otherwise, if you
begin and/or end a reach elsewhere on the stream alignment, ResSim
will create new junctions at both/either end of the reach.

ResSim will automatically constrain a new reach between existing
junctions (e.g., will not allow a reach to be drawn past an existing
junction). If the reach appears to draw past a junction, then the
junction is not on the stream you think it’s on. This can occur if the
computation point (that the junction is based on) is not initially placed
on the appropriate stream. To solve this situation, go back to the
Watershed Setup Module and revise the location of the computation
point (you may need to delete and recreate the computation point to
be on the appropriate stream). After saving your watershed
configuration, change to the Reservoir Network Module and select
Update Network from Configuration from the Network menu. See
Section 8.6, “Updating a Reservoir Network” for additional
information for updating networks.

Additionally, you may not connect tributaries to the middle of a
reach; tributaries must connect to a junction.
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8.4.2 Renaming Routing Reaches

ResSim automatically names routing reaches according to the names
of the upstream and downstream junctions. To rename a reach
component:

1. Select the Reach Tool i

2. Right-click on the routing reach to be renamed.

3 Select Renme

from the shortcut
menu. The Name: Beech Ck Station to Mill Hall

Rename ReaCh Description: Routing Reach; Muskingum routing method ~
dialog bOX WI” (k=2 hrs travel time; ¥=0.3 attenuation coefficient).
appear (Figure
8.13), allowing
you to type in a
NeEw name.

4. Type in the new Figure 8.13 Rename Reach
name and optional
description.

5. Click OK to close the Rename Reach dialog box.

[ Qi H Cancel ]

The new name will now appear as a label in the map display.

8.4.3 Deleting Routing Reaches

To delete routing reaches:

1. Select the Reach Tool i
2. Right-click on the routing reach to be deleted.
3. Select Delete _
from the shortcut Confirm Delete
menu. A
Confirm Delete @ Delete Reach Beech Ck Station ko Mill Hall?
dialog box will
appear (Figure es

8.14).
4. Click Yes if you Figure 8.14 Confirm Delete of Reach

are sure about the
deletion.

The deleted routing reach will no longer appear in the map display.
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8.5 Viewing Network Reports

In the Reservoir Network Module, the Reports menu allows you to access
summary reports pertinent to the elements in your network. These reports
summarize your reservoirs, routing reaches, junctions, and diversions. In
addition, advanced reports of your network connectivity are also available.
The Report contents can be “sorted” alphabetically by clicking on a
column header in the report. Also, when an element is selected in the
report listing, that element is highlighted in the Map Display area.

8.5.1 Viewing the Reservoir List

The Reservoir List (Figure 8.15) displays the names and descriptions
of all reservoirs in your network. For information about printing and
exporting options available from the report’s Report menu, see
Appendix F. The Edit menu provides access to the Reservoir Editor
(after selecting a reservoir in the list and then selecting Edit from the

Edit menu).
? Reservoir List @
Report  Edit
MName ‘ Description ‘
Sayers |Sayers Reservair |

Close

Figure 8.15 Reservoir Network Reports: Reservoir List

8.5.2 Viewing the Reach List

The Reach List (Figure 8.16) displays the names and descriptions of
all reaches in your network. For information about printing and
exporting options available from the report’s Report menu, see
Appendix F. The Edit menu provides access to the Reach Editor
(after selecting a reach in the list and selecting Edit from the Edit

menu).
X Reach List 3]
Repaort  Edit

Mame Description
|Beech Ck Statian ta Mill Hall Routing Reach; Muskingum routing methad (K=2 hrs travel time; ¥=0.3 attenuation coeflicient).
|Blanchard to Marsh Ck Jet Fouting Reach; Coeflicient routing method =1.0

|Fishing CkJctto Bald Eagle Total  |Routing Reach; Muskingum routing method (k=1 br travel ime; ¥=0.3 attenuation coefiicient).
|Marsh Ck Jctto Beech Ck Station Routing Reach; Muskingum routing methad (k=1 hr travel time; ¥=0.3 attenuation coefficient).
|Mill Hall to Fishing Ck Jct Routing Reach; Coefficient routing method=1.0

Close

Figure 8.16 Reservoir Network Reports: Reach List

8-11



Chapter 8 — Developing a Reservoir Network ResSim User’'s Manual

8.5.3 Viewing the Junction List

The Junction List (Figure 8.17) displays the names and descriptions
of all junctions in your network. For information about printing and
exporting options available from the report’s Report menu, see
Appendix F. The Edit menu provides access to the Junction Editor
(after selecting a junction in the list and selecting Edit from the Edit

menu).
?Junctiun List E]
Report  Edit
Mame Description
Bald Eanle Total Just upstream of Confluence (and Lock Havem)
Beech Ck Statian Gage Location just downstream of conflugnce with Beech Creek. Loc..
Elanchard Elanchard Gage is insignificantly downstream of Savers' Qutlet warks ..
Fishing CkJct Inflows = Fishing Creek Hwy
Marsh ChkJct Confluence with Marsh Ck, Inflow in Marsh HW
Wil Hall Mill Hall added as local inflow point upstream of Fishing Creek Jct
Sayvers Inflow Jct Reservair Inflow from HMS is "Sayers Inflow’”.

Figure 8.17 Reservoir Network Reports: Junction List

8.5.4 Viewing the Diversion List

The Diversion List (Figure 8.18) displays the names and descriptions
of all diversions in your network. For information about printing and
exporting options available from the report’s Report menu, see

Appendix F. The Edit menu provides access to the Diversion Editor
(after selecting a diversion in the list and selecting Edit from the Edit

menu).
? Diversion List @
Report  Edit
Mame Description
Example Diversian Example for illustration purposes

Cloze

Figure 8.18 Reservoir Network Reports: Diversion List
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8.5.5 Viewing Advanced Reports
Two Advanced Reports are available from the Reports menu:

The first advanced report is the Network Connectivity summary.
This report provides a connectivity summary of “all” or “selected”
elements/nodes in your reservoir network. Details include
Element/Node (the “type” of Element and associated Inflow and
Outflow Nodes), ID, Name, Function/Upstream Element, and
Parent/Downstream Element.

» The All Elements connectivity report (Figure 8.19) is
accessed from the Reports menu by selecting:
Advanced - Network Connectivity > All Elements

Advanced Metwork Conneckivicy b All Elements

Mode Lisk Selected Elements

? ResSim Network Connectivity - Base @

Report  Find
Elementf D MHame Functions Parentf
Mode Upstrm Elem Dinstrm Elem

JunctionElement 1 Bald Eagle Total Junction -
Outflow Mode 1 ~E1 1 1
Inflow Maode 17 ~E17 17 1

Inflowe Mode 23 Bald Eagle Local - Loc... 1

JunctionElement 2 Fishing Ck Jct Junction

Inflove Mode 16 ~E16 16 2

Outflow Mode 2 ~E2 2 17 —
Inflowe Mode 22 ~E2~Fishing Ck HW 2

JunctionElement 3 Mill Hall Junction

Inflove Mode 15 ~E158 15 3

Outflow Mode & ~E3 3 16

Inflove Mode Al Mill Hall Local - Lock H... 3

Inflowe Maode 36 ~E27 27 3

JunctionElement 4 Beech Ck Station Junction

Inflowe Mode 13 ~E14 14 4

Outflowy Mode 14 ~E4 4 16

Inflowe Maode 20 Beech Ck HW 4

JunctionElement & Marsh CkJct Junction

Inflowe Mode 12 ~E13 13 5

Outflowy Mode G ~Ef ) 14

Inflowe Mode 19 ~Ef~Marsh Ck HW 5

Inflowe Mode 25 ~E18 19 g

linrtinnElarmant = BRlanrhard Iimetine ¥
Tahle Motes:

Dark gray rows represent primary netwatk elements

Light gray rowes represent child elements
White rows represent nodes

In name fields, ~E# references the name of element with id #

Figure 8.19 Reservoir Network Reports: Advanced --
Network Connectivity — “All” Elements”

For information about printing and exporting options available
from the report’s Report menu, see Appendix F. The Find menu
allows you to find text strings within the report.
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» The Selected Elements connectivity report (Figure 8.20) is
accessed by first selecting elements in the Map Display area
by holding down the SHIFT key and clicking on the desired
elements (performs multiple selections as indicated in the map
shown in Figure 8.20). Then, from the Reports menu, select:
Advanced - Network Connectivity - Selected Elements

G Tools  Help

Reservair Lisk

Reach Lisk th: | Base* | Configuration: | Existing

Junction Lisk
Diiwersion Lisk )

] Mebwork Connectivity »

Maode Lisk

Advanced

All Elements

Selecked Elements

Wil Hall

X ResSim Network Connectivity @

Dark gray rows represent primary network elements

Light gray rovwes represent child elements

White rows represent nodes

In name fields, ~E# references the name of element with id #

Report  Find
Elementf ID MName Function/ Parent
Mode Upstrm Elem Dnstrm Elem
DiversionElement 26 Example Diversion
Outlow Mode 36 ~E27 27 e}
Element a7 Example Diversion Cnirl |AdjustableDiversion Exarmple Diversion
Outlow Mode a7 ~E27 27
Outlow Mode 36 ~E27 27 3
JunctionElement 3 Mill Hall Junction
Inflow Node 145 ~E15 15
Outlow Mode 3 ~E3 3 16
Inflow Mode 21 il Hall Local - Lock H... 3
Inflow Mode 36 ~E27 27 3
ReachElement 16 dill Hall to Fishing Ck Jct CoefRouting
Inflow Mode &) ~E3 3 16
Outlow Mode 16 ~E16 16 2
Table Motes

Close

Figure 8.20 Reservoir Network Reports: Advanced --
Network Connectivity — “Selected” Elements”

For information about printing and exporting options available
from the report’s Report menu, see Appendix F. The Find menu

allows you to find text strings within the report.
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The second advanced report is the Node List (Figure 8.21). This
report provides a summary of all nodes in your reservoir network.
Details include the Node ID, Name, Key String, Upstream Element,
Downstream Element, Stream, Stream Station, and Stream Coordinate
(i.e., a normalized position on the stream).

% ResSim Node Report - Base @

Report  Edit
| Mode ID MNarme KeyStr Upstrm Dnstrm Stream Strearn | Stream
Elem Elem Station | Coord |
1 |Bald Eagle Total |Bald Eagle Tatal | Bald Eagle Creek |6167.10 (0.0215 | A|
2 |F|5mng CkJct \F\shmg Claet |F\5h|ng Ck Jctto Bald Ea... |Bald Eagle Creek | 2615728 [0.0913
Mill Hall Mill Hall |M\II Hall to Fishing CGk.Jct |Bald Eagle Creek |28971.86 |0.1011
Marsh Ck Jet Marsh Ck.Jet |Mar3h Ck.Jetto Beech C... [Bald Eagle Creek |7 8.02 |0.2601
Blanchard Blanchard Blanchard to Marsh Ck Jct |Bald Eagle Creek |8l B.41 743
Sayers Inflow Jot Sayers Inflow Jct Sayers-Pool Bald Eagle Creek |1 00 235
Sayers-Darm at Bald Eagle Creek Tailwater Sayers-Darn at Bald .. |Blanchard Bald Eagle Creek | & 6.41 743
0 Sayers-Darn at Bald Eagle Creek L&O IN ~E12~IN Sayers-Pool Sayers-Dam at Bald Eag... |=not on stream=
11 Sayers-Darn at Bald Eagle Creek L&O ~E12 Sayers-Darn at Bald .. |Sayers-Dam at Bald Eag... [2not on stream=
12 Blanchard to Marsh CkJect ~E13 Blanchard to Marsh Ck.. [Marsh CkJct Bald Eagle Creek |74558.02 |0.2601
13 Marsh CkJctto Beech Ck Station ~E14 Marsh CkJctto Beech .. |Beech Ck Station Bald Eagle Creek |65314.18 |0.2279
14 Beech Ck Station ~E4 Beech Ck Station Beech Ck Station to Mill ... |Bald Eagle Creek |65314.18 |0.2279
] |Beech Ck Station to Mill Hall ~E15 Beech Ck Station to Mi... |Mill Hall Bald Eagle Creek | 2897186 |0.1011
B \Mill Hall ta Fishing Ck Jct ~E1B Mill Hall {0 Fighing Ck .. |F\sh|ng Ch Jct Bald Eagle Creek |26157.28 3
T Fishing Ck Jct to Bald Eagle Total ~E17 Fishing CkJctto Bald |Ea|d Eaagle Total Bald Eagle Creek |B157.10 <}
8 |Sayers Inflow Savyers Inflow |Sayars Inflowe Jct Bald Eagle Creek |121400 5
9 Marsh Ck Jct Marsh Ck HW ~ES~Marsh Ck [Marsh Clct Bald Eagle Creek |74558.02 1
20 Beach Ck HW Beech Ck Hw Beech Ck Station Bald Eagle Creek 6531418 ]
i Mill Hall Local - Lock Haven LOC 60% Mill Hall Local - Mill Hall Bald Eagle Creek |28871.86 |0.1011
22 Fishing Ck Jct Fishing Ck Hw ~E2~Fishing Ck. Fishing Ck Jct Bald Eagle Creek | 2615728 [0.0813
23 Eald Eagle Local - Lock Haven LOC 40% Bald Eagle Lac.. Bald Eagle Total Bald Eagle Creek |6157.10 |0.0215
24 Sayers-Spillway Diversion Tailwater ~E20 Sayers-Spillway Diver... |Sayers-Spiltway Diversio... |Bald Eagle Creek | 8419798 [0.2937
&) Sayers-Spillway Diversion Reach E1 Sayers-Spillway Diver... [Marsh Ck.Jct Bald Eagle Creek |74558.02 |0.2601
0 Sayere-Main Gates [N Sayers-Pool |Sayers-Ma|n Gates =not on stream=
1 Sayers-Main Gales Sayers-Main Gates |Sayers-Dam at Bald Eag... | =not on stream>
34 |Sayers-Uncaontrolled Outlet IN |Sayers-Pool [Sayers-Uncontrolled Oull...[<not on stream= |
Table Notes
In KeyStr fields, ~E# references the name of element with id #

Figure 8.21 Reservoir Network Reports: Advanced -- Node List

For information about printing and exporting options available from
the report’s Report menu, see Appendix F. The Edit menu provides
two options: Clean Network and Delete Node. These options can
potentially damage a working network and should only be used when
recommended by a ResSim technical expert.
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8.6 Updating a Reservoir Network

In the Watershed Setup Module, if you make changes (e.g., add, delete,
move or rename elements) to the watershed configuration your network is
based on, you need to update your Reservoir Network to include those
changes. First, in the Watershed Setup module, from the Watershed
menu, select Save Configuration (Figure 8.22).

File Edit view BROEREE=s8 Reports  Tools  Help

Configuration Editar...
Module: [vater IJpdate Compukation Poinks

Irnpork ]

E Export ]

Save Configuration

Ol

Figure 8.22 Watershed Setup Module - Watershed Menu:
Save Configuration before Updating Network

Next, in the Reservoir Network module, with the network to be updated
shown in the display area, select Update Network from Configuration
from the Network menu (Figure 8.23).

File Edit ‘iew alkernative Reports  Tools  Help
Mew. .,
Module: |Rese Open...
Save [
Save As... ==
D harsh Ch Jet

@ Rename...

IUpdate Mekwork Frorm Configuration
Sayers
Delete Metwarks, ..

] i

Figure 8.23 Reservoir Network Module - Network Menu:
Update Network from Configuration

After the network has been updated from the revised Configuration, you
should see the revisions reflected in the Map Display area.

You will need to update each Reservoir Network that is based on
the revised Watershed Configuration.
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Chapter 9

Editing Junction, Reach, and
Diversion Data

Once you have established the connectivity of your Reservoir Network
(Chapter 8), you can define and edit the properties of elements in the
network. You will need to specify parameters for all junctions, reaches,
diversions, and reservoirs using ResSim’s specialized editors. You will
also need to edit the physical and operations data for reservoirs, as
described in Chapters 10-11.

This chapter explains how to enter and edit data for junctions, reaches, and
diversions. Refer to Chapter 8 for developing a Reservoir Network within
the Reservoir Network Module.

9.1 Editing Junction Properties

To edit junction data, select the Junction Tool i and right-click on a

junction. From the shortcut menu, select Edit Junction Properties. The
Junction Editor will open.

The Name field at the top of the editor contains a list of all of the
junctions in your reservoir network, with the name of the selected junction
displayed. You can access all of the junctions both from this list and by
using the VCR-style buttons to navigate through the available junctions.

The Junction Editor has four tabs that allow you to edit junction
information (Info), Local Flow, Rating Curve, and Observed Data, as
described in the following sections.

9-1



Chapter 9 —Editing Junction, Reach, and Diversion Data ResSim User’'s Manual

9.1.1 Junction Editor: Info Tab

The Info tab (Figure 9.1) displays the Description, Stream Station,
Stream, and Tributaries you have defined within the Watershed Setup
Module and during the process of creating your reservoir network
within the Reservoir Network Module.

? Junction Editor §|

MName Mill Hall v| [W(a] 30r7[w](n]

Description Mill Hall added as local inflow point upstream of Fishing Creek Jct [

Info | Local Flow | Rating Curve | Observed Data

Stream Station 28971.86
Strearmn  |Bald Eagle Creek

Tributaries

[ Cutflow known during hindcast.

Label Position  |WORTH w

Figure 9.1 Junction Editor: Info Tab

The Stream and Tributaries fields are not editable, but you may
revise the junction Description and Stream Station. If the historic
outflow for a junction is available for the hindcast (lookback) period,
then click on the Outflow known during hindcast box. An entry
will appear in the time-series table that you will complete during the
creation of an Alternative (Chapter 13).

You may also choose the position of the name label in your map
display from the options in the Label Position field.

To edit properties for other junctions without exiting the Junction
Editor, click the Apply button and then select another junction from
the Name list or use the navigator buttons.
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9.1.2 Junction Editor: Local Flow Tab

On the Local Flow tab (Figure 9.2) of the Junction Editor, you can
input a Name and Factor in the table for each external flow entering
the junction.

? Junction Editor f‘5_<|

Mame  [uill Hall v| (W(a] 3017 [0](m])

Description |ru1iII Hall added as lacal inflow point upstream of Fishing Creek Jct [:]|

Info| Local Flow | Rating Curve | Observed Data

Marme Factar
mill Hall Lacal - Lock Haven LOC B0% 0.R00| &

Figure 9.2 Junction Editor: Local Flow Tab

= Name: The name you enter will appear during the Alternative
definition to identify the local flow for time-series mapping
(Chapter 13). This name CANNOT be the same as the Junction
name.

= Factor: The factor value is available to increase or decrease
the local flow hydrographs. If you enter a value of 1.0, then
the local flow will be equal to the hydrograph reference.

You must define flows for headwater junctions. Flows are optional at
other junctions.

If you specify an entry on the Local Flow tab, then you will see a
circle (i.e., a “halo) around the junction as a “visual reminder”

to indicate which locations will receive local inflows.

To edit properties for other junctions without exiting the Junction
Editor, click the Apply button and then select another junction from
the Name list or use the navigator buttons.
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9.1.3 Junction Editor: Rating Curve Tab

The Rating Curve tab (Figure 9.3) is optional. However, if you need
stages calculated at a junction, you can enter Stage and Discharge
values for the junction here. The mini-plot will reflect the values you
enter and can be viewed in full size when you double-click on it.

? Junction Editor @

Mame |will Hall v| (1la] 3017 w0

Description |ru1i|| Hall added as local inflow point upstream of Fishing Creek Jot E]|

Infa | Local Flow/| Rating Curve | Ohserved Data

Stage (M) Discharge (cfs)

Stage ()

I O Y I I
20 40 60 2.0 100

Discharge {cfe)

W

Stage Daturn i) | |

Figure 9.3 Junction Editor: Rating Curve Tab

= Stage: Enter Stage values (in meters or feet) that correspond
to the Discharge values.

= Discharge: Enter Discharge (flow) values (in cms or cfs) that
correspond to the Stage values.

To edit properties for other junctions without exiting the Junction
Editor, click the Apply button and then select another junction from
the Name list or use the navigator buttons.
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9.1.4 Junction Editor: Observed Data Tab

Use the Observed Data tab (Figure 9.4) to indicate that observed data
is available for comparison purposes. If the Observed box in the
table is checked (as shown in Figure 9.4), then there will be a
corresponding entry in the Observed Time-Series mapping table when
you create an Alternative (Chapter 13).

? Junction Editor E]

Name il Hall v| [W](a] 3017 [m](n]

Description |ru1i|| Hall added as local inflawe point upstream of Fishing Creek Jct E]|

Info | Local Flow | Rating Curve | Ohserved Data

Select Locations that display Observed data in output reports and plots

Lacation Wariahle Cbserved

hill Hall F oy [v]
Mill Hall Local - Lock Haven LOC 60% | Flow F]

Figure 9.4 Junction Editor: Observed Data Tab

To edit properties for other junctions without exiting the Junction
Editor, click the Apply button and then select another junction from
the Name list or use the navigator buttons.
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9.2 Editing Reach Properties

To edit routing reach data, select the Reach Tool i and right-click on a
routing reach. From the shortcut menu, select Edit Reach Properties.
The Reach Editor will open (Figure 9.5).

X Reach Editor §|

Reach Mame |Fighing Ck Jetto Bald Eagle Total v | [W][a) 505 |[w](m)

Description  Routing Reach; Muskingum routing method (=1 hr travel time; ¥=0.3 attenuation coeflicient;. E]

Routing | Losses | Ohserved Data

Method  Muskingum b
Muskingurm K thrs) 1.00
Muskingumm X 0.3000
Mumber of Subreaches 1

[ ok || appy || cancel

Figure 9.5 Reach Editor: Routing Tab

The Reach Name field at the top of the editor contains a list of all of the
routing reaches in your reservoir network, with the name of the selected
reach displayed. You can access all of the reaches from this list or by
using the VCR-style buttons to navigate through the available reaches.

Below the Reach Name list is the Description of the current reach; this
field is editable.

The Reach Editor has three tabs that allow you to edit Routing methods,
Losses, and Observed Data, as described in the following sections.
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9.2.1 Reach Editor: Routing Tab

The Reach Editor’s Routing tab (as previously shown in Figure 9.5)
allows you to choose from seven routing methods: Coefficient,
Muskingum, Muskingum-Cunge 8-pt Channel, Muskingum-Cunge
Prismatic Channel, Modified Puls, SSARR, and Working R&D
Routing, each method with its own set of parameters. If there is no
lag or translation of the hydrograph through the reach, you can select
Null Routing. Select the routing method for the reach from the
Method list. The appropriate fields for data entry will appear
according to the method you have selected.

9.2.1.1 Coefficient Routing Method

For the Coefficient Routing method (Figure 9.6), you will need to
enter coefficients for each time step of the routing extent. Each
coefficient equates to the fraction of the flow entering the reach
that will reach the downstream end at the end of each time step in
the table. The values in the table must sum up to 1.

?Reach Editor @
Reach Name |Fishing Ck Jot to Bald Eagle Tatal v | (W][«a] 50r50](m]
Description  |Routing Reach; Coefficient Routing Method (4 coef, SUM=1.0) O
Routing | Losses | Observed Data
Method |Coef. Routing v

Time Step Coefficient

1 0. 150] A
2 0. 250

3 0. 500

4 0.100

5

f W

| ok |[ mepy ][ cancel

Figure 9.6 Reach Editor: Coefficient Routing Method

If you enter a 1 in the first row and leave the rest of the
table blank, you have effectively described null or no-
route routing. This means that 100% of the flow

entering the reach instantaneously leaves the reach in
that time step.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.1.2 Muskingum Routing Method

The Muskingum routing method (Figure 9.7) requires you to enter
values for Muskingum K (in hours) and Muskingum X. You will
also need to specify the Number of Subreaches.

? Reach Editor E|

Reach Mame |Fishing Ck.ct to Bald Eagle Total | [W][a] s o5 [w][m]

Description  |Routing Reach; Muskingum routing method (k=1 hr travel time; ¥=0.3 attenuation coefficient). [J

Routing | Losses || Observed Data

Method  |mMuskingum -
Muskingurm K (hrs) 1.00
Muskingurm x 0.3000
Mumber of Subreaches 1

’ Ok ] [ Apply ] I Cancel

Figure 9.7 Reach Editor: Muskingum Routing Method

=  Muskingum K: Enter the number of hours (travel time) for
the reach, i.e., how long it takes for a drop of water that
enters the reach to exit the reach.

= Muskingum X: Enter the attenuation coefficient (from 0.0
to 0.5). A value of 0.0 indicates maximum attenuation of
the hydrograph through the routing reach. A value of 0.5
indicates a “direct translation” of the hydrograph through
the reach.

= Number of Subreaches: Number of steps (subreaches)
applicable for the routing reach. This parameter should be
approximately equal to travel time divided by the
computation interval.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.1.3 Muskingum-Cunge 8-pt Channel Routing
Method

The Muskingum-Cunge 8-pt Channel routing method (Figure
9.8) uses a representative eight-point channel cross section to
perform the Muskingum-Cunge hydrologic routing method. This
method requires that you enter the Channel Length and Channel
Slope, as well as eight Station and Elevation values to describe
the cross section. The cross section displays in both a generalized
illustration of a cross section and a mini-plot of the data you enter
and can be viewed in full size when you double-click on it. Other
parameters you will need to enter are Manning’s n Values for the
Left Overbank, Main Channel, and Right Overbank. The
Default Reference Flow value is used to compute the celerity for
the reach. The Routing Timestep Subintervals value can vary

from 1 to 12.
? Reach Editor g|
Reach Name [Fighing Ck Jetto Bald Eagle Total | [1W](a] 5 ors | )m)
Description  |[Routing Reach; Muskingum-Cunge 8-Pt Channel Routing Method. [.J

Routing | Logses | Observed Data

Method  [Muskingum-Cunge 8-pt Channel A
Channel Length () 0.o0 42 34 56 7 3
Channel Slope iftifh 0.000000 | | | |
Zross Section Table
- i Lett flain Fight
Station Elevation Overbark|  Channel | Owverbank
ifty fty
1
10
2 -
3 #]
4 £ B
= |
il
5 =t
5 |
7
T T T T T T T T T
a 1.00 3.00 5.00 7.00 5.00
Station iy
Mannings nYalues
Left Overbank Main Channel Right Overbank
Muskingum-Cunge Stakility Control
Default Reference Flow (cfs) 100
Routing Timestep Subintervals 1 w
[ ok [ aeew || cancel

Figure 9.8 Reach Editor: Muskingum-Cunge 8-pt Channel
Routing Method
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Channel Length: Enter the length of the routing reach.

Channel Slope: Enter the slope of the routing reach,
AY/AX.

Station: Enter the horizontal position of a point used to
describe a stream cross section.

Elevation: Enter the vertical position of a point used to
describe a stream cross section.

Manning’s n Values: Enter the unitless loss coefficients
for Left Overbank, Main Channel, and Right Overbank
to be used in the normal depth calculations of the cross
section.

Default Reference Flow: The flow value is used to
compute the celerity (and thus the travel time) for the
reach. If the travel time is less than the time-step size, the
reach is divided into subreaches for the computation.
Travel time (and thus the number of subreaches) is greater
for low flow; therefore, the reference flow value should
approximate the base flow for the reach.

Routing Timestep Subintervals: Select a value from 1 to
12.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.1.4 Muskingum-Cunge Prismatic Channel Routing
Method

The Muskingum-Cunge Prismatic Channel method (Figure 9.9)
provides two more options for describing the cross section to be
used by the Muskingum-Cunge hydrologic routing method. In this

method, you can describe the cross section as either a trapezoid or
a circle.

?Reach Editor @
Reach Name [Fishing Ck Jctto Bald Eagle Total v | [(W][«] 5 of5[m](m]

Description  |Routing Reach; Muskingum-Cunge Prismatic Channel Routing Method. [.J

Routing | Losses | Observed Data

Method  |Muskingum-Cunge Prismatic Channel

Channel Length {ft) 0.00

Channel Slope {ftit) 0.000000

Manning's n 0.000

Channel Shape
(%) Prismatic Battarm YWidth {ff) 0.00
Side Slope (hiv) 0.000

) Circular

Muskingum-Cunge Stability Contral

Default Reference Flow (cfs) 100

Routing Timestep Subintervals 1w

Lok J[ ey || cance |

Figure 9.9 Reach Editor: Muskingum-Cunge Prismatic Channel
Routing Method

For the Muskingum-Cunge Prismatic Channel method, enter the
appropriate parameters, described below:

= Channel Length: Enter the length of the routing reach.

= Channel Slope: Enter the slope of the routing reach,
AY/AX.

Manning’s n: Enter the unitless loss coefficient to be used
in the normal depth calculations of the cross section.
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Channel Shape: Select either Prismatic (trapezoid) or
Circular (pipe).

o0 Prismatic: This shape is a basic trapezoid with the

bottom of the trapezoid less than or equal to the
width of the top. When you choose Prismatic as the
Channel Shape, you also need to specify the Bottom
Width and Side Slope.
+ Bottom Width: the width of the bottom of
the trapezoidal section.
+«»+ Side Slope: the slope of the sides of the
trapezoid entered as Ax/Ay.
Circular: This shape is a simple circle used to
represent a pipe or culvert. This method is valid for
flow depth up to 0.77*diameter. For depths greater
than this, the depth used by the method is held to
0.77*diameter and a warning message is generated.
If you choose Circular as the Channel Shape, you
also need to specify the Channel Diameter.
¢ Channel Diameter: Define the size of the
circle.

Muskingum-Cunge Stability Control: Enter the default
reference flow and the routing timestep subintervals.

o Default Reference Flow: The flow value is used to

compute the celerity (and thus the travel time) for the
reach. If the travel time is less than the time step
size, the reach is divided into subreaches for the
computation. Travel time (and thus the number of
subreaches) is greater for low flow; therefore, the
reference flow value should approximate the base
flow for the reach.

Routing Timestep Subintervals: Select a value
from 1 to 12.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.1.5 Modified Puls Routing Method

The Modified Puls channel routing method (Figure 9.10)
describes the reach as a set of cascading reservoirs, the number of
which is specified by the number of subreaches. The outflow from
the reach is defined as a function of the storage. An option is
available within this method to account for seepage losses within
the routing computation. To use this option, check the With
Channel Losses box and enter the average Invert Elevation of the
reach, the Percolation Rate to describe the seepage, and extend
the outflow-storage table by adding associated elevation data.

i If you use the Channel Losses option in this method, do

not define seepage losses on the losses tab for this reach
—you will be double accounting for the seepage losses.

? Reach Editor @
Reach MNarme [Fishing Ck Jet to Bald Eagle Total v | (W][a] 5 ofs|w](m]
Description  [Routing Reach; Modified Puls Routing Method. E]
Routing | Losses || Observed Data

Method  |Modified Puls hd
Storage Qutflowe Elevation 10
{ac-f) (cfs) (M 9
~ 8
@]
£ &
£ 5
2 .4
£ 4
o 34
5
- 1 T T T T T T 1
100 300 500 700 900
Storage (ac-1t)
Mumber of Subreaches 1
Selact Plot
With Channel Losses
Storage vs. Quifllow
Invert Elevation & © storag
Percolation Rate (fis)

[ Ok ] [ Apply ] [ Cancel

Figure 9.10 Reach Editor: Modified Puls Routing Method

= Storage: Enter monotonically increasing values of storage to
describe the storage-outflow relationship needed for this
routing method.

= Qutflow: Enter the outflow values associated with each
storage value in the storage-outflow relationship.
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9.2.1.6

= Elevation: Enter associated elevation values; ResSim uses
these values as extensions to the storage-outflow relationship
when you select the With Channel Losses option. This
column is only available when this option is active.

= Number of Subreaches: This parameter is similar to that used
in the Muskingum routing method. Enter the reach travel time
divided by the computation interval.

= Invert Elevation: Enter the average minimum elevation of the
channel in this reach.

= Percolation Rate: Enter the flow rate identifying the loss of
water to the soil/groundwater.

= Inthe Select Plot area, you can choose whether the plot shows
Storage vs. Outflow or Storage vs. Elevation. The plot will
reflect the values you enter.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.

SSARR Routing Method

The SSARR routing method (Figure 9.11) describes the channel
routing based on the computer program Streamflow Synthesis &
Reservoir Regulation (SSARR), from the Corps’ Northwestern
Division (USACE, 1991).

? Reach Editor @

Reach Name |Fishing Ck Jctto Bald Eagle Total | [W][«] 5015 [w][m]
[

Description  [Routing Reach; SSARR Routing Method.

Routing | Losses || Observed Data

Method |354RR Routing b

1
TS = KTSi0™n 27
34
4
5
G
74
2
a-
10 T T T
1.00 3.00 4500 7F.00

KTS Outflow (cfs)

Quiflow Time Of Storage
(cfs) (hours)

kY
Time Of Storage ¢hrs)

Time of Storage Equation T
9.00

n

MNumber of Subreaches 1

[ oK ][ Apply H Cancel ]

Figure 9.11 Reach Editor: SSARR Routing Method
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The storage in the routing reach is defined by Time of Storage
values (Ts), in units of hours. Therefore, the storage is defined like
Muskingum K values (described in Section 9.2.1.2). Instead of

using Modified Puls storage-outflow, this method uses Ts versus
outflow.

An alternative method for defining T is by the following equation,
which defines T as a power function of flow.

_ KTs
T, = o
where
Ts = Time of storage per increment in hours
KTS = Constant determined by trial and error or
estimated from physical measurements of flow
and corresponding routing times.
Q = Discharge in cubic meters (or feet) per hour
n = Coefficient usually between -1 and 1

As evident from the above equation, Ts is a nonlinear function of
discharge except when n = 1. It is possible to use a negative value
of n if time of storage increases as discharge increases. According
to the SSARR User’s Manual, a value of n = 0.2 is reasonable for
most streams in the Columbia River Basin.

For the SSARR routing method, enter the appropriate parameters,
described below:

= Time of Storage Method: Select either the Use
Interpolation Table or the TS = KTS/Q" method.

= Qutflow and Time of Storage: If the Use Interpolation Table

method is selected, enter the outflow and corresponding Ts
values.

» Time of Storage Equation: If the TS = KTS/Q" method is
selected, enter values for KTS and n.

= Number of Subreaches: Number of steps applicable for the
routing reach.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.1.7

Working R&D Routing Method

The Working R&D routing method (Figure 9.12) uses a nonlinear
storage-outflow relation, like the Modified Puls method. Also, it
permits use of wedge storage, like the Muskingum method. For a
linear storage-outflow relation, the Working R&D method
produces results identical to the Muskingum method. For routing
with no wedge storage (Muskingum X = 0), the Working R&D
method produces results identical to the Modified Puls method
(USACE, 1994).

? Reach Editor, @

Reach Name [Fishing CkJct to Bald Eagle Total v | [W][«] 505 |[»][m]
Description  Routing Reach; Working R&D Routing Method. [
Routing | Losses | Observed Data
Method  Pworking R&D v
Starage Qutflow
{ac-ft) (cfs) 10
- 97
g
& T
REA
g
2 3
Muskingum
MNumber of Subreaches 12
T T T T T T T T
1.00 3.00 500 700 9.00
Starage {ac-f)
[ QK ” Apply ” Cancel ]

Figure 9.12 Reach Editor: Working R&D Routing Method

= Storage: Enter monotonically increasing values of storage to
describe the storage-outflow relationship needed for this
routing method.

=  Qutflow: Enter the outflow values associated with each
storage value in the storage-outflow relationship.

= Muskingum X: Enter the attenuation coefficient (from 0.0 to
0.5). A value of 0.0 indicates maximum attenuation of the
hydrograph through the routing reach. A value of 0.5 indicates
a “direct translation” of the hydrograph through the reach.

= Number of Subreaches: Number of steps (subreaches)
applicable for the routing reach. This parameter should be
approximately equal to travel time divided by the computation
interval.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or
use the navigator buttons.
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9.2.2 Reach Editor: Losses Tab

The Losses tab of the Reach Editor (Figure 9.13) provides two
options for computing losses in the routing reach: Constant Seepage
or Seepage as a function of Flow. The default is no losses in the

reach.

?Reach Editor @
Reath Mame [Fishing ChkJctto Bald Eagle Total ~| (][] 5015 [ ][]
Description  |[Routing Reach; Muskingum routing method (k=1 hrtravel time; X=0.3 E]
Raouting | Losses | Observed Data
(%) Constant Seepage (cfs)

() Seepage as a function of Flow
Flowicfs) Seepage(cfs)
10

~ B

& -

T 7

= i

R

ar -

[ai]

dn} 2_
T T T 1T T T T°1
20 40 B0 B0 10C

Flonafs)
[ 64 H Anply ” Cancel l

Figure 9.13 Reach Editor: Losses Tab

= Constant Seepage: Enter the flow (in cms or cfs) lost to the
reach through the soil, non-varying throughout the simulation.

= Seepage as a function of Flow: With this option, you can
define the loss as a function of the routed flow of the reach.
Reach losses are computed after the flow is routed through the
reach; therefore, the final outflow from the reach is the routed
flow minus the loss.

= Flow: Enter a monotonically increasing set of flow values to
define the relationship of seepage with respect to flow.

= Seepage: Enter the associated seepage values for each flow
value in the table, expressed in flow units.

The mini-plot will reflect the values you enter and can be viewed in
full size when you double-click on it.

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or use
the navigator buttons.
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9.2.3 Reach Editor: Observed Data Tab

Use the Observed Data tab (Figure 9.14) to indicate that observed
data is available for comparison purposes. If the Observed box in the
table is checked (as shown in Figure 9.14), then there will be a
corresponding entry in the Observed Time-Series mapping table when
you create an Alternative (Chapter 13).

X Reach Editor E|
Reach Marme |Fishing Ck Jetto Bald Eagle Tatal v | [W][4] 505 | ](n]
Description |Rnu1ing Reach; Muskingumm routing method (k=1 hr travel time; ¥=0.3 [:]|
Routing | Losses | Observed Data |
Select Locations that display Obhsered data in output reports and plots

Location | Yariahle | Observed
Fishing Ck Jctto Bald Eagle Total |F|DW
I 0]34 ] [ Anply ] [ Cancel

Figure 9.14 Reach Editor: Observed Data Tab

To edit another reach without exiting the Reach Editor, click the
Apply button and then select another reach from the Name list or use
the navigator buttons.
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9.3 Editing Diversion Properties

To edit diversion data, select the Diversion Tool i and right-click on a
diversion. From the shortcut menu, select Edit Diversion Properties.
The Diversion Editor will open (Figure 9.15).

? Diversion Editor El
Diversion Mame |Example Diversion A EEM@@
Diescription Example Diversion for illustration purposes [:]
Diversion Ohserved Data

Method: |Constant b
Constant Diversionicfs): 0.0

(] Computed during UnReg

Ok l ’ Anply ] [ Cancel

Figure 9.15 Diversion Editor

The Name field at the top of the Editor contains a list of all of the
diversions in your reservoir network, with the name of the current
diversion displayed. You can access all of the diversions both from this
list and by using the VCR-style buttons to navigate through the available
diversions.

If the Computed during UnReg box is checked, then the diversion will
operate during the unregulated flow calculation. If the box is left
unchecked, then the unregulated flow will reflect flow conditions without
the diversion.

The Diversion Editor has four tabs that allow you to edit diversion
information (Diversion tab), Losses, Routing, and Observed Data, as
described in the following sections.

Note that the Losses and Routing tabs are available only for diversions
that connect to downstream nodes.
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9.3.1 Diversion Editor: Diversion Tab

9.3.1.1

The Diversion Editor’s Diversion tab allows you to choose from six
methods: Constant, Monthly Varying, Seasonal, Function of Flow,
Function of Pool Elevation, and Time Series, each with its own
parameters. The default method is Constant.

Select the diversion method from the Method list. The appropriate
editing fields will appear according to the method you have selected.

Constant Diversion Method

For the Constant method (Figure 9.16), you will need to enter a
diversion flow value (in the appropriate units of your watershed).
This constant value will apply to each period of your simulation.

?Diversion Editor E|
Diversion Mame |Example Diversion b’ E@ 1of1 @@
Description Exarmnpla Diversion far ilustration purposes E]
Diversion Ohserved Data

Method: [sEElEEE

Constant Diversion{cfs) 25.0

[ Computed during UnReg

’ Ok ” Apply H Cancel

Figure 9.16 Diversion Editor: Constant Diversion Method

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.1.2 Monthly Varying Diversion Method

For the Monthly Varying diversion method (Figure 9.17), you
will need to enter the diversion flow value (in the appropriate units
of your watershed) corresponding to each month of a year. These
monthly values will apply to each year in your simulation.

? Diversion Editor @

Diversion Nare [Exarnple Diversion v [W]la] 1er1m]n]
Description |Examp|e Diversion for illustration purposes E]|
Diversion | Observed Data
Method: [T ]

Manth Diversion{cfs)

Jan 0.0 1.0

Feh 0.0 054

Mar 0oy = E

Apr ool 2 PE]

May 0.0f 5 oad

Jun 0o B 7]

Jul 0.0 a -

ALl 0.0 0.0 T T T 1

Sep 0.0 Jan  May  Sep

Oct 0.0

Moy 0.0

Dec 0.0
[] Computed during UnReg

[ ]34 l [ Anply l [ Cancel l

Figure 9.17 Diversion Editor: Monthly Varying Diversion Method

= Diversion: Enter a flow value (in cms or cfs) for each
month.

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.1.3

Seasonal Diversion Method

For the Seasonal method (Figure 9.18), you will need to enter a
Date along with a corresponding Diversion flow value (in the
appropriate units of your watershed). The seasonal diversion is
applicable for each year of your simulation.

? Diversion Editor @

Diversion Name |Example Diversion v | [W][a] 1011 |m](n]
Description |Examp|efnrillustrati0n purposes E]|
Diversion | Observed Data

Method: EEEENEL

Date Diversion(cfs)

01Jan

0.4+

Diversion{cfz)

0o:00

[ computed during UnReg

ok J[ ey || cancel

Figure 9.18 Diversion Editor: Seasonal Diversion Method

= Date: Enter the Day and Month in the format ddMMM
(e.g., 01Jan).

= Diversion: Enter a Flow value in cms or cfs.

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.1.4 Function of Flow Diversion Method

For the Function of Flow diversion method (Figure 9.19), you will
need to enter a relationship between a junction’s net flow and the
resulting diverted flow (in the appropriate units of your watershed).
The Flow Location junction can be selected from the list and need
not be the same location as where the diversion occurs. This
allows for a diversion to limit or augment flow based on any
junction’s flow. For a given net Flow value entering the diversion
element, the Diversion flow will be removed from the junction.
This relationship applies to your entire Simulation period.

? Diversion Editor @

Diversion Name |Example Diversion v | [W][a] 1011 |0](m]
Description |Examp|efnrillustrati0n purposes E]|
Diversion | Obsetved Data

Method: (g dely R a i

Flows Location ; |Ba|d Eagle Total V|

Flowicfs) Diversion{cfs)

Diversionfcfz)
1

T T T T T T T
20 40 50 20 10C

Flow(cfs)

[ computed during UnReg

Lok J[ ey || cancel |

Figure 9.19 Diversion Editor: Function of Flow Diversion Method

= Flow: Enter the net flow (in cms or cfs) entering the
junction.

= Diversion: Enter the flow (in cms or cfs) that is diverted
from the junction.

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.1.5

Function of Pool Elevation Diversion Method

For the Function of Pool Elevation diversion method (Figure
9.20), you will need to enter a relationship between reservoir
elevation and diversion flow (in the appropriate units of your
watershed). Also, you will need to select the appropriate reservoir
from the Reservoir list. When a given Elevation at the selected
reservoir occurs, then the corresponding Diversion flow will be
diverted from the junction. Linear interpolation will be made
between the elevations (and corresponding diversions) that you
enter. This relationship applies to your entire simulation.

? Diversion Editor @

Diversion Name |Example Diversion v| (W] 1or1|m](m]
Description Example for illustration purposes E]
Diversion Ohserved Data

[EigIale Bl F LN ction of Fool Elevation g

Feseroir Sayers L

Elevation(ft) Diversion{cfs)

Elevationfcfz)
1

T T T T T 171
20 40 &0 20 100

Diversion(ft)

[ computed during UnReg

Lok J[ ey [ cancal

Figure 9.20 Diversion Editor: Function of Pool Elevation
Diversion Method

= Elevation: Enter the reservoir elevation (in meters or feet)
on which the diversion is based.

= Diversion: Enter the flow (in cms or cfs) that is diverted
from the diversion element.

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.1.6 Time-Series Diversion Method

For the Time-Series diversion method (Figure 9.21), you only
need to select Time Series from the Method list. An entry for this
diversion will appear in the Time-Series mapping table when you
create an Alternative (Chapter 13). The time series of diversion
flow values must be in the appropriate units (cms or cfs) of your

watershed.

?Diversion Editor. @
Diversion Name |Example Diversion v | [W][a] 1011 |m](n]
Description Example for illustration purposes E]
Diversion Ohserved Data

Method: ERiEEREETEE

Time Series

[] Computed during UnReg

ok J[ ey || cancel |

Figure 9.21 Diversion Editor: Time-Series Diversion Method

To edit another diversion without exiting the Diversion Editor,
click the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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9.3.2 Diversion Editor: Routing Tab

For diversions connected to downstream junctions, the Diversion
Editor’s Routing tab allows you to choose from seven routing
methods: Coefficient, Muskingum, Muskingum-Cunge 8-pt Channel,
Muskingum-Cunge Prismatic Channel, Modified Puls, SSARR, and
Working R&D Routing, each with its own set of parameters. If there
is no lag or translation of the hydrograph through the diversion reach,
you can select Null Routing (which is the default routing method).

The Routing tab of the Diversion Editor is identical to the Routing tab
of the Reach Editor. For details about using the Routing tab, refer to
Section 9.2.1.

9.3.3 Diversion Editor: Losses Tab

Available for diversions connected to a downstream junction, the
Losses tab of the Diversion Editor (Figure 9.22) provides three
options for computing losses in the diversion’s routing reach: Return
Ratio, Constant Seepage, or Seepage as a function of Flow.

Diversion Mame |Diversion Exarmple v [W[e]) 2orz|m](n]
LJ

Description Example for illustration purposes dwith connection)
Diversion | Routing | L0SSeS | Observed Data

() Return Ratio ¢0.0-1.00

(%) Constant Seepage (cfs)

() Seepage as a function of Flow

Flow(cfs) Seepage(cfs)
10

87

@ -

T 67

o _

S 4

@ _

a5}

[4x) 74
I'T T T T T T1
20 40 6.0 8.0 100

Flow(cfs)

Figure 9.22 Diversion Editor: Losses Tab

= Return Ratio: Enter a value between 0.0 and 1.0 (the default
is 1.0) to indicate how much diversion continues through the
diversion to the downstream junction.
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= Constant Seepage: Enter a seepage value (in cms or cfs) to
indicate how much diversion flow will “seep into” the ground
and therefore be lost from the system.

= Seepage as a function of Flow: Enter a Flow vs. Seepage
relationship (in cms or cfs) to indicate how much of the
diversion flow is lost from the diversion to the ground.

The mini-plot will reflect the values you enter and can be viewed in
full size when you double-click on it.

To edit another diversion without exiting the Diversion Editor, click
the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.

9.3.4 Diversion Editor: Observed Data Tab

Use the Observed Data tab (Figure 9.23) to indicate that observed
data is available for comparison purposes. If the Observed box in the
table is checked, then there will be a corresponding entry in the
Observed Time-Series mapping table when you create an Alternative

(Chapter 13).

? Diversion Editor @
Diversion Name |Diversion Example v| [W](a] 2or2w](m]
Description Example for illustration purposes {with connection) )
Diversion | Routing | Losses | Observed Data
Select Locations that display Observed data in output reports and plots

Location Wariahle Observed |
Diversion Example-Diversion Example Cnirl Flom [v]
Diversion Example-Diversion Example Rch Flow: [v]

Figure 9.23 Diversion Editor: Observed Data Tab

To edit another diversion without exiting the Diversion Editor, click
the Apply button and then select another diversion from the
Diversion Name list or use the navigator buttons.
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CHAPTER 10

Defining Physical Components of
Reservoirs

The data that defines an individual reservoir element within the reservoir
network consists of two conceptual types: Physical and Operational.
This chapter describes the physical components of a reservoir that include
the Pool, the Dam (and its Outlets), and any Diverted Outlets (commonly
called diversions from the pool). ResSim represents these components
using a “tree structure”. As you add optional physical components to the
reservoir, they will appear in the reservoir tree. This reservoir tree is more
than just an illustration. It is the mechanism you will use to access the
editors for the separate reservoir components. As you select a component
in the reservoir tree, the edit panel to the right of the reservoir tree will
display the editor you need to define the properties of that component.

An elevation-storage-area relationship describes the properties of the pool,
while a crest elevation and length describes the dam, represented
internally in the ResSim program as an uncontrolled spillway. You will
need to add one or more outlets to the dam to enable water to pass through
it into the downstream system. You can also add a power plant to describe
the hydropower generating capacity. Within the Reservoir Editor,
Diverted Outlets (or reservoir diversions) are separate outlet groups. As
with the dam, you will need to add one or more outlets to a diverted outlet
group to enable the reservoir to allocate flow through the diversion.

The order in which you add physical components and edit their properties
is flexible. You can add all the physical components to the reservoir then
go back and define each component’s properties, or you can define the
properties of each component as you add it, before going on to add and
edit the next component. Choose the style that works best for you.
However, you should finish defining the physical representation of your
reservoir before going on to define its operational data (Chapter 11), as the
definition of the operational zones depends on the physical definition of
the pool, and the rules depend on the description of the outlet works.
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10.1 Accessing the Reservoir Editor

In the Reservoir Network Module, you can access the Reservoir Editor
from either the Edit menu in the menu bar or from the right-click shortcut
menu of a reservoir in the map display.

= From the Edit menu, select Reservoirs....

= From the map display, right-click on a reservoir with the
Reservoir Tool ﬂ then select Edit Reservoir Properties.

10.2 Using the Reservoir Editor to Define Physical
Components
The Physical tab of the Reservoir Editor allows you to define the

physical properties of reservoirs in your reservoir network. Figure 10.1
shows the Reservoir Editor with the Physical tab selected.

i Reservoir Editor @
Reservoir  Edit
Resenoir [sayers ~| Description | Sayers Resenoir ] (W] 1 o1 ][]

Physical | Operations | Observed Data

Sayers
Fool

= 57 Dam at Bald Eagle Creek Composite Release Capacity
# @ Spiltway Diversion 2 -
Total (cfs)
0.0
500.0
1,350.0
2,500.0
3,560.0
ShEE ] PP
5,250.0 i 200000
5,920.0
,4a0.0
6,980.0
7,470.0
7,910.0
&,340.0

Elevation (fty | Controlled Uncontrall
580.0 0.0
585.0 500.0
600.0 1,350.0
605.0 2,500.0
610.0 3,560.0
615.0 4,460.0
B6z0.0 5,250.0
B6E5.0 5,920.0
630.0 6,480.0
635.0 6,980.0
£40.0 7,470.0
645.0 7,910.0
£50.0 8,340.0
655.0 8,730.0 8,730.0
657.0 8,886.0 8,686.0
658.0 8,964.0 2,500, 11,464.0
659.0 9,042.0 6,000.0 15,042.0
660.0 9,120.0 lz,000.0 21,120.0
661.0 9,182.0 16,000.0 25,192.0
B663.0 9,336.0 29,000.0 38,336.0
665.0 9,4380.0 46,000.0 55,480.0
B67.0 9,620.0 £4,000.0 73,620.0
669.0 9,760.0 85,000.0 94,760.0

>

sen- g
Em?k’/

600

Elevation (ff)

Flow (cfs)

oloooloaloolalalololoola
cloololooloolalololololola

670.0 5,830.0] 96,000.0 105,830.0%)| Label Position: |EAST v|
,

Figure 10.1 Reservoir Editor: Physical Tab

On the Physical tab, a reservoir tree appears in the left panel of the
window. By default, the reservoir tree displays the reservoir and its
primary components: the Pool & and the Dam 7. Additionally, if you
add a diversion to remove water from this reservoir’s pool in the reservoir
network, a Diverted Outlet & appears in the reservoir tree. As you add
components to the reservoir, such as outlets and losses, the reservoir tree
will expand to show these components.

The area to the right of the reservoir tree is the Edit Panel. The content of
this panel changes according to the component you select in the reservoir
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tree. Figure 10.1 shows the Composite Release Capacity summary for
the reservoir because the reservoir is the selected component in the
reservoir tree.

The menu bar of the Reservoir Editor changes according to the component
you select in the reservoir tree. For example, when you select the Dam in
the reservoir tree, a Dam menu becomes available in the menu bar.

When the reservoir £ is selected in the tree, you may re-position the name
label in your map display by choosing from the options in the Label
Position field (see the lower right portion of the editor in Figure 10.1).

The Reservoir field at the top of the Editor contains a list of all of the
reservoirs in your network, with the name of the current reservoir
displayed. You can access all of the reservoirs both from this list and by
using the VCR-style buttons to navigate through the available reservoirs.
Below the Reservoir name list is the Description of the current reservoir;
this field is editable.

The following sections describe how to use the Physical tab of the
Reservoir Editor to define the physical components of the reservoir that
appear in the reservoir tree.

10.3 Specifying Physical Components of a Reservoir

On the Physical tab of the Reservoir Physical

Editor, a reservoir tree appears in the e Resenvoir

left panel of the window. By default, I

the primary components for all 7 Dam at Bald Eagle Creek
reservoirs are a Pool and a Dam, as

Figure 10.2 illustrates. Figure 10.2 Reservoir Editor,

Physical Tab: Default Reservoir

A Pool reflects characteristics of
Component Tree

reservoir storage, while a Dam reflects
the reservoir dam and its outlets.

Additionally, if the individual reservoir Physical

has a diverted outlet, a Diverted Outlet 4 rmmr=mmms

will appear as a primary component of T

the reservoir, as illustrated in Figure 7 Dam at Bald Eagle Creek
10.3. = 4 Diverted Outlet

. . Controlled Outlet
The Reservoir and primary components ¢

that appear in the default reservoir tree Figure 10.3 Reservoir Editor,
are features of the reservoir network Physical Tab: Default Reservoir
that you have setup previously using Component Tree with Diverted
the map (mouse) tools. The following Outlet

sections explain how to add details to

the primary components of a reservoir and how to define secondary
components such as outlets and losses.
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10.4 Specifying Reservoir Pool Losses

You can specify both Pool Evaporation and Pool Seepage, as shown in
Figure 10.4.

On the Physical tab, you may use Physical

either the Pool menu in the Reservoir S MNew Reservair
Editor’s menu bar (Figure 10.5) or the = &R _
right-click shortcut menu (Figure 10.6) 4 Evaporation

. . SeERpAQR
to SpeCIfy Losses for a reservoir p00|. b ;m atga?d Eagle Creek

To add Pool Evaporation and/or Pool & Diverted Outlet
Seepage:

Figure 10.4 Reservoir Editor,

1. Select Pool in the reservoir tree. Physical Tab: with Pool Losses

2. Either click on Pool in the
menu bar or right-click on Pool
in the reservoir tree to access
the shortcut menu.

3. Select Add Pool Evaporation or Add Pool Seepage.

Physical
L — . . ﬂ_ Sayers
% Reservoir Editor, 8
Reservoir  Edit RWElGl dd Pool Evaporation

) Add Pool Evapaoration a8 Snillh a0 poal Seepade
Reservair |Say

Add Pool Seepage
Figure 10.5 Reservoir Editor: Figure 10.6 Reservoir Tree:
Pool Menu Pool Shortcut Menu

You can also remove Pool Seepage and Pool Evaporation, as described in
Section 10.12.3.

10.5 Defining Physical Features of a Dam

As Figure 10.7 shows, you can add the Physical

following physical features to a Dam: A Sayers

. Poal
Leakage (Section 10.6), = ?
Tailwater Elevation (Section 10.10), & Leakage
Controlled Outlets (Section 10.8.1), & Tailwater
Uncontrolled Outlets (Section 10.9), @ Controlled Outlet
Outlet Groups (Section 10.7), <> Uncantrolied Outlet 1
Power Plants (Section 10.8.2), and  Outiet Group
Pumps (Section 10.8.3) e

P 10 & Pump

You can also rename Dams in the 4" Shillway Diversion
;e(z)sirzv(ilr tree, as described in Section Figure 10.7 Reservoir Tree:

Dam
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On the Physical tab, you may use either the Dam menu in the Reservoir
Editor’s menu bar (Figure 10.8) or the right-click shortcut menu (Figure
10.9) to specify features of a dam.

10.6 Adding Leakage to a Dam

To add Leakage to a dam:

1. Select the dam by
clicking on it in the
reservoir tree. Reseroir @

2. Select Add Leakage

? Reservoir Editor

Reservoir  Edit ekl

#dd Tailwater Elevation

fdd Leakage
Add Controlled Cuklet

Physical

from either the Dam | Enysical | Ope Add Uncantralied Outlet
menu in the Reservoir A Sa?ﬁ_fm Add Outlet Group
EthOF S menu bar ? add Power Plant
(Figure 10.8) or the a2 Spillwz Add Pump
right-click shortcut menu Pulse Flow Options

of the Dam (Figure S—

10.9).

Figure 10.8 Reservoir Editor,
Physical Tab: Dam Menu

. | Bhysical |
Leakage will now appear
A « " A\ Sayers
v ISELERE a5 a “branch” of the S Pool
reservoir tree, beneath the dam. oo Dz

Spilly  Add Tailwater Elevation
You can also remove Leakage a' 3

from a dam (Section 10.12.3).

add Leakage

Add Controlled Cutlet
Add Uncontralled Outlet
Add Qutlet Group

Add Power Plant

Add Pump

Pulse Flow Options

Renarne

Figure 10.9 Reservoir Tree:
Dam Shortcut Menu
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10.7 Adding Outlet Groups

You can add Outlet Groups as components of Dams, Diverted Outlets,
and other Outlet Groups, as shown in Figure 10.10.

An Outlet Group allows you to
define subsets of a reservoir
component. An Qutlet Group can
include Tailwater Elevation
(Section 10.10), Controlled
Outlets (Section 10.8),
Uncontrolled Outlets (Section
10.9), and other Outlet Groups as
components.

On the Physical tab, you may use
either the component-specific
menus in the Reservoir Editor’s
menu bar or the right-click shortcut
menus (Figure 10.11) to add an
Outlet Group as a component of a
Dam, Diverted Outlet, or other
Outlet Group.

To add an Outlet Group:

1. Select the Dam,
Diverted Outlet, or
Outlet Group to which
you want to add the
new Qutlet Group.

2. Choose Add Outlet
Group from the
shortcut menu (Figure
10.11) or from the
component’s menu in
the Reservoir Editor’s
menu bar.

The new Qutlet Group will
appear U Joutlet Group JETN
reservoir tree as a branch beneath
the component you selected.

Physical

& Sayers
8 Fool
= 57 Dam
& Leakage
& Tailwater
W MainGates
S Uncnntrnlled Outlet

O Tallwater
& Controlled Qutlet 1
<> Uncontrolled Outlet 1
’ Qwutlet Group 1
& Power Plant
& Pump
= & Spillway Diversion
<5 EmergencySpillbway
# Fouting

Figure 10.10 Reservoir Tree:
Outlet Groups

Fhysical

ﬂ Sayers
8 Faool
= %7 Dam
& Leakage
& Tailwater
W WainGates
< Uncontrolled Outlet
1 ' OutletGmup

Q Emergency‘: Add Tailwater Elevation
# Routing Add Controlled Cutlet
Add Uncontrolled Cutlet

Add Outlet Group

Add Power Plant
Add Pumnp
Rename

Delete

Figure 10.11 Diverted Outlet

Shortcut Menu:
Add Outlet Group

You can also rename and delete Outlet Groups in the reservoir tree, as

described in Section 10.12.
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10.8 Defining Controlled Outlets

You can add Controlled Outlets,
Power Plants, and Pumps to Dams,
Diverted Outlets, and Outlet Groups,
as shown in Figure 10.12.

Additionally, you can add Tailwater
Elevation (Section 10.10) as a
component of Controlled Outlets,
Power Plants, and Pumps.

You can also rename and delete
Controlled Outlets, Power Plants, and
Pumps in the reservoir tree

(Section 10.12).

10.8.1 Adding Controlled Outlets

Physical

ﬂ Sayers
8 Fool
= 57 Dam
Q Cantrolled Cutlet
= ' Dutlet Group
% Controlled Outlet 1
& Power Plant
<3 Uncontrolled Outlet
= 4 Spillway Diversion
& Pump
# Routing

Figure 10.12 Reservoir Tree:
Controlled Outlets,
Power Plants and
Pumps

On the Physical tab, you may use either the component-specific
menus in the Reservoir Editor’s menu bar or the right-click shortcut
menus (Figure 10.13) to add a Controlled Outlet as a component of a
Dam, Diverted Outlet, or Outlet Group.

To add a Controlled Outlet:

1. Select the Dam or
Outlet Group to which
you want to add the
new Controlled Outlet.

2. Choose Add
Controlled Outlet
from the shortcut menu
(Figure 10.13) or from
the component’s menu
in the Reservoir
Editor’s menu bar.

Physical

7 EE

# o Spilly  Add Taibwater Elevation

ﬂ Sayers

Fool

Add Leakage

Add Controlled Cutlet

Add Uncontrolled Outlet
Add Duklet Group

Add Power Plant

Add Pump

Pulse Flow Options

Rename

Figure 10.13 Dam Shortcut Menu:

Add Controlled Outlet

The new Controlled Outlet will appear @ EEREIEENE in the
reservoir tree as a branch beneath the dam or outlet group you

selected.

You can rename and delete Controlled Outlets (as described in

Section 10.12).
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10.8.2

Power Plants are added in the same manner as the controlled outlets
(as described in Section 10.8.1). Therefore, on the Physical tab, you
may use either the component-specific menus in the Reservoir
Editor’s menu bar or the right-click shortcut menus (Figure 10.14) to
add a Power Plant as a component of a Dam, Diverted Outlet, or
Outlet Group.

Adding Power Plants

To add a Power Plant: Physical

Select the Dam or Outlet £\ Sayers
Group to which you & Poal

S D |
want to add the Power _ .
Plant % C  Add Taibwater Elevation

' + af Spilv add Leakage

Select Add Power &dd Controlled Cutlet
Plant from the shortcut Add Uncontrolled Outlet
menu (Figure 10.14) or Add Outlet Group
from the component’s Add Power Plank

menu in the Reservoir Add Pump

Editor’s menu bar. Pulse Flow Options

Renarme

Figure 10.14 Dam Shortcut Menu:
Add Power Plant

The Power Plant will now appear ¢ EREREEL 55 5 branch of the
reservoir tree, beneath the component that it was added to.

You can rename and delete Power Plants (as described in Section
10.12).

requires a tailwater definition to be with or above the power
plant in the outlet tree. See Section 10.10 for a description
of adding Tailwater Elevation.

@ To properly calculate energy production, a power plant
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10.8.3 Adding Pumps

Pumps are added in the same manner as the controlled outlets (as
described in Section 10.8.1). Therefore, on the Physical tab, you may
use either the component-specific menus in the Reservoir Editor’s
menu bar or the right-click shortcut menus (Figure 10.15) to add a
Pump as a component of a Dam, Diverted Outlet, or Outlet Group.

To add a Pump: A Flat Rock
1. Select the Dam or Outlet |- Q%
Group to which you %  Add Tailwater Elevation
want to add the Pump. & addLeakage
Select Add Pump from Add Controlled Cutlet
the shortcut menu Add Uncontrolled Qutlet
(Figure 10.15) or from Add Qutlet Graup
the component’s menu Add Power Plant
in the Reservoir Editor’s
menu bar. Pulse Flow Options
Rename

Figure 10.15 Dam Shortcut Menu:
Add Pump

The Pump will now appear ¢ as a branch of the reservoir tree,
beneath the component that it was added to.

You can rename and delete Pumps (as described in Section 10.12).

Therefore, a tailwater definition is required at or above the
pump in the outlet tree. See Section 10.10 for a description
of adding Tailwater Elevation.

@ The operation of a pump is very much tied to its tailwater.
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10.9 Adding Uncontrolled Outlets

You can add Uncontrolled Outlets to
Dams, Diverted Outlets, and Outlet
Groups, as shown in Figure 10.16.

On the Physical tab, you may use either
the component-specific menus in the
Reservoir Editor’s menu bar or the
right-click shortcut menus (Figure
10.17) to add an Uncontrolled Outlet as
a component of a Dam, Diverted
Outlet, or Outlet Group.

To add an Uncontrolled Outlet:

1. Select the Dam, Diverted
Outlet, or Outlet Group to
which you want to add the
new Uncontrolled Outlet.

2. Choose Add Uncontrolled

Outlet from the shortcut
menu (Figure 10.17) or
from the component’s menu
in the Reservoir Editor’s
menu bar.

Physical

ﬂ Sayers
8' Fool
= 57 Dam
€ Controlled Qutlet
= O Catlet Group
<> Uncantralled Qutlet 1
a8 Uncontralled Qutlet 2
= af Spillway Diversion
< Uncontralled Qutlet 3
# Routing

Figure 10.16 Reservoir Tree:
Uncontrolled
Outlets

Physical

= 4 Spi &dd Leakage

& #dd Tailwater Elewation

? Add Cantrolled Cutlek

Add Uncontrolled Cutlet
Add Outlet Group

Add Power Plant

Add Pump

Pulse Flow Options

Renarne

Figure 10.17 Dam Shortcut Menu:

Add Uncontrolled
Outlet

The new Uncontrolled Outlet will appear < MIEIEEENER i\ the
reservoir tree as a branch beneath the component you selected.

You can also rename and delete Uncontrolled Outlets in the reservoir tree,
as described in Section 10.12.
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10.10 Adding Tailwater Elevation

You can add Tailwater Elevation to (e

Dams, Diverted Outlets, and Outlet A\ savers

Groups, as shown in Figure 10.18.

On the Physical tab, you may use either ailwater

the component-specific menus in the % Controlled Outlet

Reservoir Editor’s menu bar or the = ¢ Outlet Group

right-click shortcut menus (Figure @ Tailwater

10.19) to add Tailwater Elevation to a 3 &£ 5;”'#’?“ Dt'“ers'””

Dam, or Diverted Outlet. >4 C?j'nﬁlfé 4 Div
# Routing

Figure 10.18 Reservoir Tree:

Tailwater
Elevation
To add Tailwater Elevation: Physical
. ﬂ Sayers
1. Select the Dam, Diverted & Fool

Outlet, or Outlet Group to = e

which you want to add 2 ;i &dd Tailwater Elevation

Tailwater Elevation. Add Leakage

.

Add Controlled Outlst
Add Uncaontrolled Cutlet
Add Qutlek Group

Add Power Plant

Add Pump

2. Choose Add Tailwater
Elevation from the shortcut
menu (Figure 10.19) or from
the component’s menu in the
Reservoir Editor’s menu bar.

Pulse Flow Opkions

Rename

Figure 10.19 Dam Shortcut Menu:
Add Tailwater
Elevation

The Tailwater Elevation you have added will appear 4 BEIZEER in the
reservoir tree as a branch beneath the component you selected.

You can also remove Tailwater Elevation from the reservoir tree, as
described in Section 10.12.3.
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10.11 Defining Physical Components of a Diverted

Outlet

As Figure 10.20 shows, you can add
Tailwater Elevation (Section 10.10),
Outlet Groups (Section 10.7),
Controlled Outlets (Section 10.8.1),
Power Plants (Section 10.8.2),
Pumps (Section 10.8.3), and
Uncontrolled Outlets (Section 10.9)
to a Diverted Outlet.

On the Physical tab, you may
use either the Outlet menu in
the Reservoir Editor’s menu
bar (Figure 10.21) or the right-
click shortcut menu to specify
features of a Diverted Outlet.

M add Cutlet Group B
'& Saﬁf:irs | Add Pawer Plant

You can also rename and Fhvs Duain Add Pump

delete Diverted Outlets in the & Lea Rename

reservoir tree, as described in

Section 10.12.
= al

? Reserwvoir Editor

Reservoir  Edit

Reserair |Say

Physical

ﬂ Savers

8 Fool
7 Dam

SaversSpilkway

& Tailweater

< EmergencySpillway
% Controlled Outlet 1
' Dutlet Group

& Power Plant

& Furmp

Figure 10.20 Reservoir Tree:
Diverted Outlet

Ciklek
Add Tailwater Elevation
Add Cankralled Cutlet
add Uncontrolled Cutlet

& Tail  Delete
& COnrOTET UTeT

SaversSpillway

& Tailwater

< EmergencySpillway
@ Controlled Cutlet 1
' Cuatlet Group

Figure 10.21 Reservoir Editor:

Outlet Menu for
Diverted Outlet
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10.12 Renaming, Deleting, and Removing Reservoir
Components

The following sections explain how to rename and delete or remove
reservoir components.

10.12.1 Renaming Reservoir Components

ResSim assigns default names to reservoir components you have
created in the Reservoir Network Module. You can rename Dams,
Diverted Outlets, Outlet Groups, and Uncontrolled Outlets.

To rename a reservoir component:

1. Select the component & Eﬁ‘fﬁm |
. . - ao
by CIICk_mg onitin the SRR o m at Bald Eagle Creek
reservoir tree. ‘ add Tailwater Elevation
2. Using either the right- B o 52 add Leakage
click shortcut menu g Aidd Contralled Outlet
(Figure 10.22) or the ¢  AddUncontrolied Outlet
component menu in ¢»  Add Outlet Group
the Reservoir Editor’s & Add Power Plant
menu bar, choose €  sddrump
Rename. The . b Pulse Flow Options
Rename Reservoir —
. Renarme
Component dialog

box will open (Figure  Figure 10.22 Reservoir Component
10.23). Shortcut Menu: Rename Component

% Rename Reservoir Component @

Marne: | Dam at Bald Eagle Creek |

Description: ~

0] H Cancel ]

Figure 10.23 Rename Reservoir Component

3. Type the new name for the component in the Name field. You
may also enter a new description in the Description field.

4. Click OK to close the dialog box. The new name will appear
in the reservoir tree.
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10.12.2 Deleting Reservoir Components

When you delete components from the reservoir tree, you
permanently remove them from the reservoir network. You can delete
Outlet Groups, Diverted Outlets, Controlled Outlets, Power Plants,

Pumps, and Uncontrolled Outlets.

To delete a reservoir component:

1. Select the component by
clicking on it in the reservoir
tree.

2. Using either the right-click
shortcut menu (Figure 10.24)
or the component menu in
the Reservoir Editor’s menu
bar, choose Delete.

3. A confirmation window will
appear (Figure 10.25). Click
Yes to verify the deletion.

Confirm Delete

Physical

ﬂ-., Savers
8 Fool
B ¥ Dam
% Controlled Outlet
Q; Uncantralled Outlet
' Qutlet Group Rename
= @ SayersSpillway .
<3 Emergencys
# Routing

Figure 10.24 Reservoir Component
Shortcut Menu:
Delete Component

@ Delete Reservoir Component Savers-Dam-Uncontrolled Qutlet?

Yes

Figure 10.25 Confirm Deletion of Reservoir Component

When you delete a reservoir component, it will no longer appear in

the reservoir tree.

Additionally, when you delete a Diverted Outlet, it will no longer
appear in the map display of the Reservoir Network Module. To
replace a Diverted Outlet, you will need to re-draw it in the map

display area.
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10.12.3 Removing Reservoir Parameters

You may remove Dam Leakage, Pool Evaporation and Seepage, and
Tailwater Elevation from the reservoir tree without losing the
associated data.

To remove these parameters: Physical
1. Select the parameter by Fay 553’?5 |
clicking on it in the reservoir oo

tree.

2. Using either the right-click
shortcut menu (Figure 10.26)
or the primary component’s

= o SayersSp
<> EmergencySpillway

. . # Routing
menu in the Reservoir
Editor’s menu bar, choose Figure 10.26 Reservoir
Remove. Parameter Shortcut Menu:

Remove Parameter

3. A confirmation window will appear (Figure 10.27). Click Yes
to verify the removal.

Confirm Delete

@ Delete Reservoir Component Sayers-Dam-Leakage?

Figure 10.27 Confirm Removal of Reservoir Parameter

The parameter you have removed will no longer appear in the
reservoir tree. However, if you re-add this parameter, the previously
entered values will be restored.

10.13 Editing Reservoir Physical Data

To edit the physical data associated with a reservoir component, select the
component in the reservoir tree in the Reservoir Editor. The appropriate
data editor will appear in the area to the right of the reservoir tree.

a spreadsheet application into the data editors, rather than

@ In most cases, you will want to copy and paste tabular data from
typing the data manually.
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10.14 Editing Pool Physical Data

To edit
tree.

physical data for a reservoir Pool, select the Pool in the reservoir

Figure 10.28 shows the Reservoir Editor’s Pool data editor. The table in
this Editor allows you to choose either Linear or Conic Interpolation and
enter the Elevation vs. Storage vs. Area data. Two plots visually
represent Storage and Area values in relation to Elevation.

Physical

Figure

A Sayers Sayers-Pool
= & @
4 Evaporation (& Linear Interpolation O Conic Interpolation
& Seepage
= %Tﬂain Gates Elevation Storage Area
= a@ Spillway Diversion iy (i (EEE
<» EmergencySpillway 526.00 0.00 0.00]~ 680
# Routing G87.00 0.67 2.00 50
a85.00 315 3.00
588.00 7.1 5.00 & 5407
55000 1579 13.00 & 520
581.00 30.27 16.00 " B0
59200 63.85 67.00 530 ! ! ! .
593.00 T42.74 81.00 .
59400 243.07 121.00
595.00 372.97 139.00 stor (ac-1t)
§96.00 556.48 232.00 - i
97,00 g01.38 258.00 i ),""
598.00 1081.58 303.00 580 P
599.00 1393.04 320.00 6407
E00.00 1731.37 357.00 & 520 y
G01.00 2095.35 371.00 = EDD—J/
60200 2481.25 401.00 a0 N T S
f03.00 269171 420.00 L A
E04.00 332068 438.00
60500 37R41T 448.00 Area (acre)
BOG.00 422710 477.00
I QK J [ Apply ] [ Cancel

10.28 Reservoir Editor: Physical Data--Pool

To enter data into the table, either copy and paste it from a spreadsheet
application or type in the data manually.

Linear Interpolation: By default, the interpolation method
ResSim uses to compute values for elevations and storages
between those specified in the table is linear.

Conic Interpolation: The pool definition detailed in the
regulation manual for most reservoirs was originally developed
using the assumption that the volume of water between two
elevations can be described by the same equation as that used to
compute the volume of a section of a cone. The area of the pool
surface at each elevation can be computed based on the topography
of the land and the change in elevation. Using this information,
ResSim can compute the storage between the two elevations. This
method of computing storage is available with the conic
interpolation option. This option requires you to input an elevation
vs. area relationship and a starting storage value at the lowest
elevation in the table. ResSim will then compute the storage
values using the conic assumption. Conic interpolation will also
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be used to obtain intermediate storage values for elevations
between those explicitly entered in the table.

The following are requirements for Elevation, Storage, and Area data:

e You must enter at least two rows, with values increasing down
the columns.

e You may not enter duplicate values.

e The maximum elevation should not exceed the Elevation at top
of Dam.

Be sure to click the Apply button before moving on to edit the next
component.

10.14.1 Editing Pool Evaporation Data

To edit Evaporation data, select Evaporation in the reservoir tree.
Figure 10.29 shows the Reservoir Editor’s Evaporation data editor
and its corresponding mini-plot. The mini-plot will reflect the values
you enter and can be viewed in full size when you double-click on it.

You may choose either Monthly Average Evaporation or
Evaporation Time-Series data.

Sayers-Pool-Evaparation

(%) Monthly Average Evaparation

Month Evaptin

Jan 0.0 00

Feh 0.0 7

Mar 0.0 0.8

ay 0l = b

Jun ool & 047

Jul ool % ogsd

Aug 0.0 b

Sep 00 0.0 T T T T
Oct 0o Jan  may  Sep
Maow 0.0

Dec 0.0

) Evaporation Time Series

[ Qs ‘ [ Apply ] [ Cancel
Figure 10.29 Reservoir Editor: Physical Data--Pool Evaporation

e Monthly Average Evaporation: Enter Evaporation values by
month. To enter data into the table, either copy and paste it
from a spreadsheet application or type in the values manually.
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e Evaporation Time Series: If you select this option, you will
need to specify the time-series data source when you create an
Alternative (Chapter 13).

Be sure to click the Apply button before moving on to edit the next
component.

10.14.2 Editing Pool Seepage

To edit Seepage data, select Seepage in the reservoir tree. Figure
10.30 shows the Reservoir Editor’s Seepage data editor and its
corresponding mini-plot. The mini-plot will reflect the values you
enter and can be viewed in full size when you double-click on it.

You may choose either Constant Seepage or Seepage as a function
of Reservoir Elevation.

Sayers-Pool-Seepage

(3) Constant Seepage (ofa)
() Seepane as a function of Reserir Elevation

Elevation (ft) Seepage(crs)

Elewiffy

T T T T T T 171
20 40 BO 80 10C
Seepage(cis)

[ Ok ] [ Apply ] [ Cancel

Figure 10.30 Reservoir Editor: Physical Data--Pool Seepage

= Constant Seepage: Enter the constant value in the field
provided.

= Seepage as a Function of Reservoir Elevation: Enter
Elevation and Seepage values into the table. To enter data into
the table, either copy and paste it from a spreadsheet application
or type in the values manually.

Be sure to click the Apply button before moving on to edit the next
component.
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10.15 Editing Dam Leakage

To edit Leakage data for a dam, select Leakage in the reservoir tree.
Figure 10.31 shows the Reservoir Editor’s Leakage data editor and its
corresponding mini-plot. The mini-plot will reflect the values you enter
and can be viewed in full size when you double-click on it.

The Leakage data editor allows you to define Leakage as a function of
pool Elevation. Leakage, although referred to as a “loss,” is not a true
loss of flow to the system. In fact, leakage effectively passes through the
dam into the downstream system at the downstream (or tailwater)
junction.

Sayers-Dam-Leakage

Leakage as afunction of Reservior Elevation

Elevation (fi) Leakage(cts)

Elewift)

T T T T T T 1T
20 40 &0 80 10C

Leakage(cfs)

[ 0K ] [ Apply ] l Cancel ]
Figure 10.31 Reservoir Editor: Physical Data--Dam Leakage

To enter data into the table, either copy and paste it from a spreadsheet
application or type in the data manually.

Be sure to click the Apply button before moving on to edit the next
component.

10-19



Chapter 10 - Defining Physical Components of Reservoirs ResSim User’'s Manual

10.16 Editing Controlled Outlet Physical Data

A Controlled Outlet can be a component of a Dam, Diverted Outlet, or
Outlet Group. Additionally, a Controlled Outlet may have its own
Tailwater Elevation.

To edit data for the primary Controlled Outlet, select the name of the
Controlled Outlet in the reservoir tree.

Figure 10.32 shows the Reservoir Editor’s Controlled Outlet data editor
and its corresponding mini-plot. The mini-plot will reflect the values you
enter and can be viewed in full size when you double-click on it.

Sayers-Dam-Controlled Qutlet

Mumber of Gates ofthis type 1
Elevation Max Capacity
yji] (cfg) 10

Elew ()

oo T T T T 1T T T
0.00 020 040 OEOD 080 1.0

Capacity (cfs)

Fhysical Lirnitations:
hax Rate of Increase (cfsihr)

| Edit Gate Settings |

Max Rate of Decrease (cfaihr)

[ QK ] [ Apply l [ Cancel ]
Figure 10.32 Controlled Outlet (no Gate Settings)

To enter Controlled Outlet data:

1. Specify the Number of Gates of this type.

2. Enter Elevation and corresponding Max Capacity flow values
into the table. Max Capacity values reflect the maximum physical
flow constraint of the outlet at the corresponding elevation. You
can either copy and paste data from a spreadsheet application or
type in the values manually.

3. Optionally, specify Physical Limitations for Max Rate of
Increase and Max Rate of Decrease.

Note: in the above description of Controlled Outlet data,
the term *““Max’” is used as an abbreviation for “Maximum”.
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4. Click the Edit Gate Settings — —
button to access the Gate (Roatesettins — [R)|

Settings dialog box (Figure &S R G Oy
1033) Gate Settings are (&) Specify Capacity at Specific Gate Openings
sometimes known as “cranks.” Mumber of Gate Settings |5 v
5. Choose either Specify Gate Setiing Units Length v
Maximum Capacity Only or Seting
Specify Capacity at Specific 1 ®
Gate Openings. 2
To Specify Capacity at Specific ;
Gate Openings: 5
= Select the Number of
Gate Settings (or ok J[ comel |
“cranks”) and the Gate

Setting Units (Length or Figure 10.33 Gate Settings
Percent).
= Enter the Setting for each gate.
6. Click OK to close the Gate Settings dialog box.

Note: Even though you can enter the appropriate Gate Settings, ResSim
does not currently make use of this information in its operations.
It will, however, produce a time series of gate settings as output
based on the final release from the outlet.

Figure 10.34 shows the Reservoir Editor’s Controlled Outlet data
editor with Gate Settings specified.

Sayers-Diam-Main Gates
MNurnber of Gates of this type 1
Elevation Max Capacity (cfs)
) For Gate Setting (f)
1.00 5.00 9.00 11.00 15.00 /
590.0 0.0 0.0 0.0 0.0 00| |~
a895.0 170.0 500.0 500.0 500.0 400.0
G00.0 260.0 1030.0 1350.0 1350.0 13500
G05.0 3100 1400.0 2200.0 2440.0 2500.0
610.0 360.0 1680.0 2800.0 3290.0 3560.0
615.0 410.0 1930.0 3380.0 3940.0 4460.0
£20.0 460.0 21300 3730.0 45100 52500 580T—T— T
A25.0 5000 231040 411040 5000.0 5920.0 oy ED 2
G30.0 530.0 2480.0 4480.0 5450.0 E480.0 Capacity (cfs)
635.0 a70.0 2650.0 4770.0 5E850.0 B980.0
G40.0 500.0 2810.0 a070.0 G260.0 74700
645.0 620.0 29500 5360.0 BE30.0 789100
G50.0 400 3100.0 5630.0 BH80.0 83400
6550 EE0.0 3240.0 5900.0 73200 87300
660.0 620.0 33800 B160.0 TE40.0 91200
G650 690.0 3400.0 6400.0 7930.0 9480.0
670.0 7000 36300 BE30.0 82200 98300
6745.0 7050 37500 £a50.0 8500.0 10160.0
G20.0 704.0 3880.0 FO70.0 8750.0 10500.0
683.0 710.0 3950.0 7200.0 88000 106450.0
v
Physical Limitations:
Max Rate of Increase (cfs/hn) 2000
Max Rate of Decrease (cfshr) 4008 SR A
[ o [ aeew [ cance |

Figure 10.34 Controlled Outlet (with Gate Settings)

When you are done entering Controlled Outlet data, be sure to click the
Apply button before moving on to edit the next component.
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10.17 Editing Power Plant Physical Data

A Power Plant can be a component of a Dam, Diverted Outlet, or Outlet
Group. To edit data for a Power Plant, select the Power Plant in the
reservoir tree.

The Reservoir Editor’s Power Plant data editor has five tabs that allow you
to edit data for Outlet Capacity, Plant Capacity, Efficiency, Station Use,
and Hydraulic Losses, as described in the following sections.

10.17.1 Editing Outlet Capacity Data for a Power Plant

On the Outlet tab (Figure 10.35), you will enter the rating table for
the physical capacity of this outlet. You can also specify the
increasing and decreasing physical limitations (i.e., physical rate-of-
change constraints).

To enter Outlet data:
1. Specify the Number of Gates of this type.

2. Enter Elevation and corresponding Max Capacity flow values
(per gate) into the table. You can either copy and paste data
from a spreadsheet application or type in the values manually.

3. Optionally, specify Physical Limitations for Max Rate of
Increase and Max Rate of Decrease.

Sayers-Dam-Power Plant

Qutlet | Capacity | Efficiency | Station Use | Hyid, Losses
Mumber of Gates of this type 1

Elevation ez Capacity
iji] {cfs) 1.0

0.8

06

0.4

Elewv (1t

0.2

a0 T T 1T 1T T T 11
000 020 040 060 080 1.0

Capacity (cfz)

Physical Limitations:
Max Rate of Increase (cfs/hn

Max Rate of Decrease (cfsihn Sl el Sl

Figure 10.35 Power Plant Physical Data Editor: Outlet Tab
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10.17.2 Editing Capacity Data for a Power Plant

On the Capacity tab, you can enter Installed Capacity and Overload
Factor (Figure 10.36). The Installed Capacity is entered in
megawatts (MW) and represents the nameplate capacity for the power
plant. The Overload Factor is used as a multiplier for the Installed
Capacity to determine the maximum energy the power plant can
produce in a time interval. To use the full Installed Capacity, enter an
Overload Factor of 1.0. For example, to overload a plant’s installed
capacity by 10%, enter a factor of 1.10.

Sayers-Dam-Power Plant
Outlet| Capacity | Efficiency| Station Use | Hyd. Losses
Installed Capacity () 0.000
Overload Factar 0.0o0

Figure 10.36 Power Plant Physical Data Editor: Capacity Tab

10-23



Chapter 10 - Defining Physical Components of Reservoirs ResSim User’'s Manual

10.17.3 Editing Efficiency Data for a Power Plant

Power efficiency is the total efficiency (generator efficiency x turbine
efficiency) of the power plant. On the Efficiency tab, you can specify
an Efficiency Method from a list of four options: Constant, Function
of Reservoir Elevation, Function of Release, or Function of Operating
Head. Each Efficiency Method has its own data editor, as described
in the following sections.

10.17.3.1 Constant Efficiency Method

For the Constant Efficiency method (Figure 10.37), enter a
constant percentage value for the overall, generator plus turbine,
plant efficiency (typical plant efficiency ranges between 80% and
90%). In actual operation, however, the turbine-generator
efficiency varies throughout its range of operation (subsequent
sections describe efficiency as a function of elevation, release or
operating head).

Sayers-Dam-Power Plant
Outlet| Capacity| Efficiency | Station Use | Hyd. Losses
Efficiency Method (sl
Caonstant Efficiency {%) 0.000

Figure 10.37 Power Plant Physical Data Editor:
Efficiency Tab - Constant Efficiency Method

When you have finished entering Efficiency data, be sure to click
the Apply button before moving on to the next tab.
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10.17.3.2 Function of Reservoir Elevation Efficiency
Method

For the Function of Reservoir Elevation efficiency method
(Figure 10.38), enter values for Elevation and Efficiency. The
mini-plot will reflect the values you enter and can be viewed in full
size when you double-click on it.

Sayers-Dam-FPower Plant
Outlet| Capacity| Efficiency | Station Use | Hyd. Losses
SHEINRUENNTRF Lnction of Reserair Elevation
Elevation (ft) Efficiency (%)
L
— 8_
£ ]
g °]
F 47
2 7]
m 27
LI
20 40 60 3010.LC
Efficiency (%]
hd

Figure 10.38 Power Plant Physical Data Editor:
Efficiency Tab - Function of Reservoir Elevation

When you have finished entering Efficiency data, be sure to click
the Apply button before moving on to the next tab.
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10.17.3.3 Function of Release Efficiency Method

For the Function of Release efficiency method (Figure 10.39),
enter values for Release and Efficiency. The mini-plot will reflect
the values you enter and can be viewed in full size when you
double-click on it.

Sayers-Dam-Fower Plant
Outlet|| Capacity| Efficiency | Station Use | Hyd Losses
Efficiency Method [SVTearim { == RS
Release (cfs) Efficiency (%)
~ 10_
~ &1
é .
z o]
B 47
2
g 2]
TTTTTTTT
20 40 60 3010
Releaze (cfz)
.

Figure 10.39 Power Plant Physical Data Editor:
Efficiency Tab - Function of Release

When you have finished entering Efficiency data, be sure to click
the Apply button before moving on to the next tab.
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10.17.3.4 Function of Operating Head Efficiency Method

For the Function of Operating Head efficiency method (Figure
10.40), enter values for Head and Efficiency. The mini-plot will
reflect the values you enter and can be viewed in full size when
you double-click on it.

Sayers-Dam-Power Plant
Outiet| Capacity| Efficiency | Station Use| Hyd. Losses
=N EG IR F unction of Operating Head
Head () Efficiency (%)
v 10
B3
€ o
g 4
I
2
TT T T TTTT
204060 5010C
Efficiency (%)
A

Figure 10.40 Power Plant Physical Data Editor:
Efficiency Tab - Function of Operating Head

When you have finished entering Efficiency data, be sure to click
the Apply button before moving on to the next tab.
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10.17.4 Editing Station Use Data for a Power Plant

Station Use is a portion of the flow that passes through the outlet but
is not used to generate power for the “grid.” On the Station Use tab,
you can define the Station Use Method as Constant or as a Function
of Release. Each method has its own data editor, as described in the
following sections.

10.17.4.1 Constant Station Use Method

The Constant station use method (Figure 10.41) simply means that
the flow “loss” is not affected by any parameter.

Enter a value for Constant Station Use.

Sayers-Dam-Fower Plant

Outlet| Capacity| Efficiency| Station Use | Hyd. Losses

Station Use Method [elEEE

Constant Station Use (cfs)

Figure 10.41 Power Plant Physical Data Editor:
Station Use Tab - Constant Method

When you have finished entering Station Use data, be sure to click
the Apply button before moving on to the next tab.
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10.17.4.2 Function of Release Station Use Method

The loss of flow for generating hydropower through station use can
also be defined as a function of flow entering the outlet. For the
Function of Release station use method (Figure 10.42), enter
values for Release (flow) and Use (the loss in flow units). The
mini-plot will reflect the values you enter and can be viewed in full
size when you double-click on it.

Sayers-Dam-Power Plant
Outlet| Capacity| Efficiency| Station Use | Hyd. Losses
Station Usze Method [SET N8 = EEEE
Release (cfs) Lise {cfs)
A 10
B3
T
5 A
TR
.
24
TTTTTTTT
20 4060 §010C
Releaze (ofs)
b

Figure 10.42 Power Plant Physical Data Editor:
Station Use Tab - Function of Release Method

When you have finished entering Station Use data, be sure to click
the Apply button before moving on to the next tab.
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10.17.5 Editing Hydraulic Losses Data for a Power
Plant

Hydraulic loss can also be referred to as head loss. ResSim uses the
value of head (the difference between the pool elevation and the
tailwater elevation) within the power equations to compute capacity.
When you enter a hydraulic loss, you are describing a loss to the head,
thereby reducing the plant’s generating capacity.

You can choose one of two methods to describe hydraulic losses. On
the Hydraulic Losses tab, you can specify the head loss as a Constant
or as a Function of Release (flow through the outlet). Each method
has its own data editor, as described in the following sections.

10.17.5.1 Constant Hydraulic Losses Method

For the Constant hydraulic losses method (Figure 10.43), enter a
value for Constant Hydraulic Loss.

Sayers-Dam-Power Plant

Outlet|| Capacity| Efficiency | Station Use| Hyd. Losses

Hydraulic Losses Method [efaEielil

Constant Hydraulic Loss (M)

Figure 10.43 Power Plant Physical Data Editor:
Hydraulic Losses Tab - Constant Method

When you have finished entering Hydraulic Losses data, be sure to
click the Apply button before moving on.
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10.17.5.2 Function of Release Hydraulic Losses Method

For the Function of Release hydraulic losses method (Figure
10.44), enter values for Release and Loss to describe the head loss
as a function of flow through the outlet. The mini-plot will reflect
the values you enter and can be viewed in full size when you
double-click on it.

Sayers-Dam-FPower Plant
Outlet| Capacity| Efficiency | Station Use | Hyd. Losses
Hydraulic Losses Method TGN EEEEES
Releasze (cfs) Loss (ft)
2 10
B3
E 5]
—
LIE
2
TrTTTTTTT
20 40 60 3010.LC
Relesze (of3)
w

Figure 10.44 Power Plant Physical Data Editor:
Hydraulic Losses Tab - Function of Release Method

e Release: Flow through the outlet.

e Loss: Head Loss, a unit of length to be removed from the
head value used to compute generating capacity.

When you have finished entering Hydraulic Losses data, be sure to
click the Apply button before moving on.
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10.18 Editing Pump Physical Data

A Pump can be a component of a Dam, Diverted Outlet, or Outlet Group.
In the Pump editor, you can define the Pump Capacity as Constant or as a
Function of Operating Head. Each method has its own data editor, as
described in the following sections.

10.18.1 Pump Capacity as Constant

The Constant Pump Capacity method (Figure 10.45) simply
means that the maximum capacity of the pump is not affected by
any other parameter.

Flat Rock-Dam-Pump

Mumber of Fumps 1

Operating Limits | Purnp  Min Tail Eley M ax Head
11 |

Fump Capacity Canstant

Capacity {cfs) (]

[ Ok ] [ Apply ] [ Cancel

Figure 10.45 Pump Physical Data Editor:
Pump Capacity - Constant

1. Enter the Number of Pumps associated with this pump outlet.

2. For each pump, enter the Minimum Tailwater Elevation and
corresponding Maximum Head.

3. Select Constant for Pump Capacity.
4. Enter a value for the Capacity.

When you have finished entering Pump data, be sure to click the
Apply button before moving on to the next component.
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10.18.2 Pump Capacity as Function of Operating Head

The Pump Capacity can be specified as a Function of Operating
Head (Figure 10.46).

Flat Rock-Dam-Pump

Mumber of Pumps 1

Operating Limits | Pump  Min Tail Eley Max Head
1

Pump Capacity Function of Operating Head

Operating Head () Pump Capacity (cfs)

10

d
5]
o
2]

Head (i)

{1 s s s B B
00 20 40 60 80 100

Capacity (cfs)

[ oK ] ’ Apply ] ’ Cancel

Figure 10.46 Pump Physical Data Editor:
Pump Capacity — Function of Operating Head

Enter the Number of Pumps associated with this pump outlet.

2. For each pump, enter the Minimum Tailwater Elevation and
corresponding Maximum Head.

Select Function of Operating Head for Pump Capacity.

4. Enter into the table the values for Operating Head and
corresponding values of Pump Capacity.

When you have finished entering Pump data, be sure to click the
Apply button before moving on to the next component.
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10.19 Editing Uncontrolled Outlet Physical Data

An Uncontrolled Outlet can be a component of a Dam, Diverted Outlet,
or Outlet Group. The uncontrolled outlet is an uncontrolled spillway and
you can use a weir equation to compute the flow over the spillway.
Otherwise, the outlet can be defined by a simple rating curve that
describes flow through the outlet.

Figure 10.47 shows the Reservoir Editor’s Uncontrolled Outlet data editor
and its corresponding mini-plot. The mini-plot will reflect the values you
enter and can be viewed in full size when you double-click on it.

Sayers-Spillway Diversion-EmeraencySpilhiay
Outlet Elevation (i) 657.0
3 Weir Coef

Length ()

(33 Elevation vs. Outflow

Elevation (ff) Qutflowy (cfs)
B57.0 0.0~ BG5S
F58.0 2500.0 Fa0
B58.0 6000.0 £ 576
BE0.0 12000.0 =
B61.0 160000/ | § °7°
B63.0 200000, | & DP9
B65.0 46000.0 W 66D
BET.0 640000 655 T
BEE.0 850000 ] 150000 300000
700 95000.0 Outflaw tcfs)
G720 120000.0
BT5.0 155000.0
BTE.D 172000.0
G780 200000.0/

I QK l [ Apply ] [ Cancel
Figure 10.47 Reservoir Editor: Physical Data--Uncontrolled Outlet

In the Uncontrolled Spillway data editor you will specify Outlet
Elevation. This elevation will serve as a trigger to determine when this
outlet starts “flowing.” Next, choose how you want to represent your
uncontrolled outlet: as a spillway using the weir equation (Weir
Coefficient) or as a rating curve (Elevation vs. Outflow). If you choose
to define your uncontrolled outlet as a spillway, enter the spillway length
and weir coefficient; otherwise, enter the rating curve’s elevation and
outflow values.

e Outlet Elevation: Minimum elevation at which the outlet will
begin to release water.

e Weir Coefficient: Typically in the range 2.6-4.0 depending on the
shape of the spillway crest. This value determines flow over the
spillway in the weir equation.

e Length: Spillway length.
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e Elevation vs. Outflow: To enter data into the table, either copy and
paste it from a spreadsheet application or type in the data manually.

Be sure to click the Apply button before moving on to edit the next
component.

10.20 Editing Tailwater Elevation Physical Data

Tailwater Elevation can be a component of a Dam, Diverted Outlet, Outlet
Group, Controlled Outlet, Power Plant, and Pump. If you have defined
one or more power plants for this reservoir, you must add a Tailwater
elevation so the head can be computed for the power computations. Three
different methods for defining tailwater are available. If you define more
than one, ResSim will compute all defined but will use only the highest to
determine the head.

To edit Tailwater Elevation data, select the Tailwater component in the
reservoir tree. Figure 10.48 shows the Reservoir Editor’s Tailwater
Elevation data editor. The mini-plot will reflect the rating curve values
you enter and can be viewed in full size when you double-click on it.

Sayers-Dam-Tailwater
IJse Highest Elevation Frar:
[] Constant Elevation ¢
“ontrof  |Beech Ck Stafion w
[] Rating Curve
Stage (i) Dizscharge (cfs)
A 10
8_
2 5
a1} -
o
& 4
[un] -
2
T T T 1T 1T T1
20 40 60 80 100
Discharge (cfs)
W
Stage Daturn (i)
[ QK H Apply H Cancel

Figure 10.48 Reservoir Editor: Physical Data--Tailwater
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e Constant Elevation: Enter a value for the tailwater elevation. If
the reservoir has a stilling basin at the tailwater, a constant
elevation may be an appropriate definition.

e Downstream Control: Select a location from the list. This list
will only contain downstream reservoirs or downstream junctions
(where a rating curve has been specified so the elevation of the
junction can be determined).

e Rating Curve: You can also apply a rating curve to represent the
tailwater of the dam or outlet of the reservoir. You may either copy
and paste the data from a spreadsheet application or type in the
values manually.

% Stage: The height from some datum, representing the water
surface elevation.

% Discharge: The flow passing that location that would produce

the associated water surface elevation.

Stage Datum: The “zero” elevation against which stage is measured.
This elevation must be in the same vertical reference as the elevations
describing the reservoir.

Be sure to click the Apply button before moving on to edit the next
component.
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10.21 Viewing Composite Release Capacity Tables

Composite Release Capacity tables and their corresponding mini-plots
provide a summary of outlet capacity data for Controlled and Uncontrolled
Outlets of a reservoir. Figure 10.49 shows a Composite Release Capacity
table for a reservoir. The mini-plot reflects the composite values and can
be viewed in full size when you double-click on it.

Fhysical
A Sayers
Fool
= 57 Dam Composite Release Capacity
& Main Gates
= 4 Shillway Diversion Elevation () | Controlled {cfs) | Uncontralled (.| Total (¢fs)
< EmergencySpillway 590.0 0.0 0.0 o.0la|  gagd -
& Routing 595.0 500.0 0.0 500.0 = _,”‘ffJ
600.0 1,350.0 0.0 1,350.0 = ]
605.0 2,500.0 0.0 2,500.0| | = o4
610.0 3,560.0 0.0 3,560.0| | & o
615.0 4,460.0 0.0 a,460.0| |0 -
620.0 5,250.0 0.0 5,250.0 0 200000
625.0 5,920.0 0.0 5,920.0
630.0 &, 480.0 0.0 6,480.0 Il i)
635.0 &,930.0 0.0 6,980.0
640.0 7,470.0 0.0 7,470.0
645.0 7,910.0 0.0 7,910.0
650.0 8,340.0 0.0 8,340.0
655.0 8,730.0 0.0 8,730.0
657.0 &,886.0 0.0 3,886.0
658.0 8,964.0 2,500, 11,464.0
659.0 9,042.0 6,000.0 15,042.0
660.0 9,120.0 12,000.0 21,120.0
661.0 3,192.0 16,000.0 25,192.0
663.0 3,336.0 29,000.0 38,336.0
665.0 9,480.0 45,000.0 55,480.0
667.0 9,620.0 64,000.0 73,620.0
669.0 9,760.0 85,000.0 94,760.0
670.0 3,830.0 96,000.0 105,530.0) | Label Fosition: |EAST v

Figure 10.49 Composite Release Capacity Table

Composite Release Capacity tables are informational and are not editable.
Instead, they fill in automatically as you add data for the individual
components.

10.21.1 Reservoir Composite Release Capacity Table

To view the Reservoir Composite Release Capacity table, select the
Reservoir’s name at the top of the reservoir tree (corresponding to the

FAN symbol) as shown in Figure 10.49.

In ResSim, a reservoir consists of, minimally, a Pool and a Dam; it
may also include Diverted Outlets. The dam (and diverted outlet) can
then, in turn, include outlets and outlet groups. The dam, diverted
outlet, and any outlet group will display Composite Release Capacity
tables similar to that of the reservoir to represent the total outlet
capacity of the components contained within each group.
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10.21.2 Dam Composite Release Capacity Table

To access the Dam Release Capacity table, select the Dam in the
reservoir tree (corresponding to the = symbol).

The components of a dam that influence the Composite Release
Capacity table include controlled outlets, uncontrolled outlets, and
outlet groups.

10.21.3 Diverted Outlet Composite Release Capacity
Table

To access the Diverted Outlet Composite Release Capacity table,
select the Diverted Outlet in the reservoir tree (corresponding to the
&€ symbol).

The components of a diverted outlet that influence the composite

release capacity table include controlled outlets, uncontrolled outlets,
and outlet groups.

10.21.4 Outlet Group Composite Release Capacity
Table

To access the Outlet Group Composite Release Capacity table,
select the Outlet Group in the reservoir tree (corresponding to

the symbol).

An outlet group can be a component of a dam, diverted outlet, or
another outlet group. The components that can influence the Outlet
Group Composite Release Capacity table include controlled outlets,
uncontrolled outlets, and outlet groups.
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10.22 Reservoir Editor: Pulse Flow Options

From the Reservoir editor’s Physical tab, an advanced option is available
to redefine the pulse flow that is used in the ResSim flow routing
computations associated with reservoir release determinations for
downstream operations. A value of 5000 cfs (142 cms) is used by default.
However, by selecting the Pulse Flow Options available from the Dam’s
shortcut menu (Figure 10.50) or the Dam menu in the Reservoir Editor’s
menu bar, you can set the value more appropriately for the range of flows
expected in your river system (Figure 10.51).

Physical
ﬂ, Sayers
Foaol

2P
& Add Tailwater Elevation

a8 Say  add Leakage
Add Controlled Cutlet
add Uncontrolled Outlet
Add Outlet Group
add Power Plank
Add Pump

Pulse Flow Cptions

Rename

Figure 10.50 Reservoir Tree:
Dam Shortcut Menu,
Pulse Flow Options

X Pulse Routing Options E|
ResSim uses a pulse flow from each reservoir
release pointto evalulate lag and attenuation
associated with channel routing. Setthe pulse
flowey to valuels) representative of the river system.
Default Pulse Flow (cfs) 5000.0
Reservair Release Uze Fulse Flow
Location Default (cfs)
Sayers Dam [v]
Sayers SayersSpillway [w]
| ok ][ cancer |

Figure 10.51 Dam Component:
Pulse Routing Options Editor
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10.23 Reservoir Editor: Observed Data Tab

Use the Observed Data tab (Figure 10.52) to indicate that observed data
is available for comparison purposes. If the Observed box in the table is
checked, then there will be a corresponding entry in the Observed Time-
Series mapping table when you create an Alternative (Chapter 13).

_"i, Reservoir Editor

Reservair  Edit

Resenolr |Gayars | Description | | W] 10t [])n]
Physical | Operations | Ohserved Data |

Select Locations that display Observed data in output reports and plots

Lacation Yariahle Observed
Sayers-Pool Elev [v]
Savyers-Pool Stor []
Sayers-Pool Flow-1n []
Sayers-Pool Flow-1t NET []
Savyers-Pool Flow-EVAP []
Sayers-Pool Flow-SEEPAGE []
Sayers-Fool Area-Resenoir []
Sayers-Pool Flow-0UT []
Savers-Dam at Bald Eagle Creek Tailwater Flowy [¥]
Sayers-Dam at Bald Eagle Creek LEO Flowy []
Sayers-Main Gates Flowy []
Savers-Power Plant Flowy []
Savers-Pump Flow []
Savers-Spillway Diversion Reach Flawy ]
Savers-Spillway Diversion Taihwater Flowy []
Savers-ErmergencySpillway Flowy []
»

Figure 10.52 Reservoir Editor: Observed Data Tab

To edit another reservoir without exiting the Reservoir Editor, click the
Apply button and then select another reservoir from the Reservoir name
list or use the navigator buttons.
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CHAPTER 11
Defining Reservoir Operations Data

The regulation plan for most Corps reservoirs is described by a seasonally
varying target pool elevation commonly called the Guide Curve. The
storage of the reservoir above this target elevation is referred to as the Flood
Control pool. The storage below the guide curve is called the
Conservation pool. The guidelines for determining the release from the
reservoir are then based on where the current pool elevation is in relation to
the guide curve. Under basic operation, if the pool is below the guide curve,
then the basic objective of the regulator is to reduce releases in order to refill
the pool; if the pool is above the guide curve, then the regulator will want to
increase releases to draw down the pool. Additional goals and constraints
are then applied to temper such a rigid operation plan.

In a manner similar to the methods a regulator may use, each reservoir in
your ResSim network must determine how much water to release at each
time step of a simulation run. To make this possible, you must describe an
operation plan or scheme upon which it can base its decisions. This plan is
called an Operation Set. You can define multiple operation sets for each
reservoir, but an individual alternative can follow only one operation set per
reservoir.

An operation set consists of three basic features: Zones, Rules, and the
identification of the Guide Curve.

Zones are operational subdivisions of the Reservoir Pool. Each zone is
defined by a curve describing the top of the zone. When you create an
operation set, ResSim establishes a default set of zones within the operation
set. These zones are Flood Control, Conservation, and Inactive. The
Inactive zone is a special zone in the operation set. It represents the “dead”
storage of the reservoir. The reservoir cannot release water from the
Inactive pool, and rules cannot be added to this zone.

Rules represent the goals and constraints upon the release(s). Rules can be
applied to selected zones of the reservoir to describe the different factors
influencing the release decision when the reservoir elevation is within each
zone.

process in ResSim. Basic Guide Curve operation means “get the
reservoir pool elevation to the current guide curve elevation as fast
as possible, within the physical and operational constraints of the
outlets™.

j The guide curve concept is used as the basis for the release decision
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The Guide Curve is identified by selecting the top of one of your
operational zones to represent the target elevation of the reservoir. By

default, ResSim assigns the Guide Curve to the top of the Conservation
zone.

An operation set that has the zones defined but no rules will cause
ResSim to follow the Basic Guide Curve operation. For testing
purposes, every reservoir should have an operation set of this type.
It is the easiest way to verify that your physical data, your
operational zones, and your guide curve have been properly defined.

This chapter will guide you through the process of defining operations data
for your reservoir network. The first section describes key features of the
Operations tab you will need to recognize. The remainder of the chapter

explains how to create an Operation Set, define Zones, define Rules, and
select your Guide Curve.

11.1 Reservoir Editor’'s Operations Tab

Using the Operations Tree, the Edit Panel, and the Operations, Zone,
Rule, and IF_Block menus, the Operations tab of the Reservoir Editor

(Figure 11.1) allows you to define operation sets and their zones and rules
for the reservoirs in your network.

Mini-Plot of Currently

Edit Panel Selected Zone or Rule
?Reservnir Editor @
Reservoir Edit  Operations Zone Rule IF_Block
enu Bar —»

Reservoir (Sayers v Description .Sayers Hesenoir [:]_ E]@ 1of1 @@
Physical| Operations | Observed Data|
Operation Set |Typical Operations ~] Description ‘-Sta hdard Operations as defined in the Reservoir Regulatipn manual. E]
| Zone-Rules | |
- EllmwcljagRoszElleechCKStatmn Storage Zone | Conseralion I Description | A% described on Platg 7-01 of Reg N[:]g

g Egg—g;;r Date Top Elevation (|

. [ MinRel( 30)_AtSite [01Jan 625.0{a 660
Operations —p{ | Erememm Jioke ol Bsn '
MinRel(1 307_AtSite Al o A
Tree g ROC [Eecr)_ 014pr f10.0 640

& ROC_Incr EEE fa00| | & B30 -

[ MaxRel_BeechCkStation || oHa¥ B30 | 5 620-_\\\ /
o (nactive 01Dec £25.0 E 5o ,f

Y Bon4
590
580

T T T T T
Jdan Mar May Jul Sep bov

[] Allowe Multi-year Seasonal Data
Starting Year

[[] Define Zone with Time-Series

[ OK ] [ Apply I |_ Cancel

Figure 11.1 Reservoir Editor--Operations Tab
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When the Operations tab is selected for display in the Reservoir Editor, the
Menu Bar at the top of the editor includes four menus unique to the
Operations tab: Operations, Zone, Rule, and IF_Block. These menus
provide the options for creating and deleting operation sets, zones, and rules
(including “conditional logic” IF-THEN-ELSE), respectively. These
options, as well as others, will be covered in detail later in this chapter.

The Operations Tree displays the zones you have defined for the current
operation set. With each new operation set, ResSim creates a default set of
zones that includes Flood Control, Conservation, and Inactive. Beneath
each zone in the tree is a prioritized list of the rules that apply to that zone.
As you add zones and rules to the reservoir, the tree will expand to show
them.

The Edit Panel changes depending upon the element you have selected in
the operations tree. If you select a zone, the zone editor will appear. If you
select a rule, the specialized rule editor for that rule type will be displayed.
A mini-plot on the right side of the Edit Panel reflects the data you enter in
the table of the current editor. The mini-plot can be viewed in full size
when you double-click on it.

At the top of the Reservoir Editor, the Reservoir field contains a list of all
of the reservoirs in your network, with the name of the current reservoir
displayed. You can access all of the reservoirs in your network either from
this list or by using the VCR-style buttons to navigate through the available
reservoirs. Beside the Reservoir name list is the Description of the current
reservoir; this field is editable. Use the description field to keep notes on
decisions you made while developing the data for the reservoir, your plans,
intentions, references, etc. You can enter a longer description by using the
L button to access the full text editor for the description.

11.2 Reservoir Operation Sets

11.2.1

An Operation Set is the operation plan or scheme upon which a reservoir

bases its decisions regarding how much water to release at each time step of
a simulation run. You can define multiple operation sets for each reservoir,
but an individual alternative can follow only one operation set per reservoir.

This section describes how to create and edit an operation set. The next
section (Section 11.3) describes how to configure the zones within your
operation set.

Creating a New Operation Set
To create a new Operation Set:

1. Select New from the Operations menu of the Reservoir Editor.
The New Operation Set dialog box will open (Figure 11.2).
2. Give the new operation set a Name and a Description.

3. Click OK to complete the process and to close the dialog box.
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? Mew Operation Set @

Marme: || |

Description: -~

[ QK H Cancel ]

Figure 11.2 New Operation Set

The name you entered will now appear in the Operation Set list, and the
description will appear in the Description field. The Description field is
editable. Use the description to describe the purpose of the operation
set, the expected behavior the operation set should provide, and any
changes you had to make to accomplish your goal.

ResSim establishes a default set of zones within the new operation set.
These zones are Flood Control, Conservation, and Inactive. These
zones can be renamed or deleted. However, the Inactive zone is a
special zone in the operation set. It represents the “dead” storage of the
reservoir. The reservoir cannot release water from the Inactive pool and
rules cannot be added to this zone. If you delete the Inactive zone from
the operation set, it cannot be reestablished.

11.2.2 Renaming an Operation Set

To rename an operation set:

1. Select Rename from the Operations menu of the Reservoir
Editor. The Rename Operation Set dialog box will open
(Figure 11.3).

Give the operation set a new Name.

3. Click OK to complete the rename process and to close the dialog
box. A confirmation dialog box will appear asking if you really
want to rename the selected operation set.

Rename Operation Set E|

Marme: Diwenstream Regulation

DESEFiDTiDﬂ1| An atternpt at representing the operations L) |

[ Ok H Cancel ]

Figure 11.3 Rename Operation Set
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11.2.3  Copying an Operation Set
To copy (or duplicate) an operation set:
1. Select the Operation set you want to make a copy from the
Operation Set list on the Operations tab.

2. Select Duplicate from the Operations menu of the Reservoir
Editor. The Duplicate Operation Set dialog box will open
(Figure 11.4).

3. Give the operation set a new Name and a Description.
4. Click OK to complete the copy process and to close the dialog
box.

The new operation set will have a copy of all the zones that were in the
original operation set. Each zone in the new operation set will also list
the same rules that were used by the original operation set.

X Duplicate Operation Set §|

Mame:

Description: | ~

[ oK H Cancel l

Figure 11.4 Duplicate Operation Set

11.2.4  Deleting an Operation Set

To delete an operation set:

1. Select Delete from the Operations menu of the Reservoir Editor.
The Select Operation Set to Delete dialog box will open (Figure
11.5).

2. Highlight the operation set you wish to delete. Its name should
appear in the grey box at the bottom.

3. Click OK to complete the delete process and to close the dialog
box. A confirmation dialog box will appear asking if you really
want to delete the selected operation set.

Select Operation Set to Delete El
~

At Site Operation Only
Dawnstrearm Regulation
(Old BEDemo Ops
Typical Operations

v

Figure 11.5 Select Operation Set to Delete
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11.2.5

Editing an Operation Set

At the top of the Operations tab, the Operation Set field contains a list
of all of the operation sets for your reservoir, with the name of the
current operation set displayed. Use this list to select the operation set
you wish to edit. The Operations tab will fill with the data for the
selected operation set.

Beside the Operation Set name list is the Description of the current
operation set; this field is editable. Use the description to describe the
purpose of the operation set, the expected behavior the operation set

should provide, and any changes you had to make to accomplish your

goal. You can enter a much longer description by using the _I button to
access the full text editor for the description.

The remainder of this chapter will detail all the options available for
editing your operation set. Each section assumes that you have already
created an operation set. If you have not created an operation set, then
go back and do so (Section 11.2.1).

11.3 Reservoir Operation Zones

As illustrated in Figure 11.6, when you create a new Operation Set, ResSim
automatically creates a Zone-Rules tab that contains three default reservoir
operation zones: Flood Control, Conservation, and Inactive. You may
wish to rename these default zones and add descriptions. You may need to
define additional zones as well. This section will detail how to edit the zone
definitions of your operation set.

? Reservoir Editor @
Reservoir  Edit  Operations Zone Rule IF_Block
Resenoir [Sayers | Description | Sayers Resenoir O] (WG] 10t w])(m]

Physical| Dperations | ohsewed Data

Operation Set FES * | Description | this is a Mew Operations Set (for illustration purposes) G |

| Zone-Rules | 1

-
#& Conservation

Storage Zone | Flood Control Description Ll
o Inactive [ .

Date Top Elevation {fty
01JAN ~

= MW A thm ~omo@m D
v O

Elevation {undef)

] Allow Multi-year Geasonal Data
Starting Year

[ Define Zone with Time-Series

I oK I [ Anply ] [ Cancel

Figure 11.6 Reservoir Editor Showing New Operation Set
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11.3.1 Renaming and Describing Operation Zones

To change the name of a Zone as it appears in the operations tree and/or
edit its description:

1. Select the Zone (to be renamed) in the operations tree.

2. Select Rename from the Zone menu or select Rename from the
shortcut menu by right-clicking on the zone you wish to rename
in the operations tree. Enter the new name and/or description.
The Description field for the Storage Zone is also editable in the
Edit panel of the reservoir editor.

Any changes you make to the Storage Zone name will be reflected in
the operations tree.

inactive zone is still a special zone from which the reservoir

i Renaming the Inactive zone does not change its nature. The
cannot release water and no rules can be applied to this zone.

11.3.2 Adding a New Reservoir Storage Zone

To add a new Reservoir Storage Zone:
1. Select New from the Zone menu of the Reservoir Editor. The
New Zone dialog box will open (Figure 11.7).
2. Enter a Name and Description for the new zone.
3. Click OK to complete the zone creation and close the New Zone

dialog box.

?New Zone E|
Marne: |
Description: ~

[ Ol } [ Cancel

Figure 11.7 New Zone

The new zone you created now appears in the operations tree. Complete
the process of creating the zone by defining the curve that represents the
top of the zone, as explained in the next section.
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11.3.3  Defining Operation Zones

You will need to define the curves representing the top of each zone you
have created. A table of dates and elevations defines each curve. The
first date in the table is always O1Jan. The curve is defined by straight
lines connecting the points defined in the table. By default, the table
represents one year, so the last point connects back to the first as the
year repeats. If the top of zone varies from year to year, it can be
defined with a time-series instead using the table. For such a case,
follow the instructions in Step 3 below for reading the top of zone from
HEC-DSS.

When the selected feature in the operations tree is a Zone, the Zone
Editor is displayed in the Edit Panel and the mini-plot at the right will
illustrate the curves representing the top of each zone. The color of the
selected zone’s curve will be red. All other zones will be black.

Figure 11.8 shows the curve definition for a zone named Conservation.

i Reservoir Editor @

Reservoir  Edit  Operations Zone Rule IF_Block

Resenoir |Sayers _v| Description | Sayers Reservoir O [W(e] 1 of 1 [ ](m]

Physical| Operations | Ohserved Data |
Operation Set At Site Operation Only |+ | Description .:No Daownstream Operations D

Zone-Rules

@ Top of Dam

i Maximum Pool
[@ Maintain Peak Release 7
[@ IndSurch-EmergencyRegulation || | Lt Top Elevation ()
@ ninAQ(250) |01.Jan 625.0
W MaxReleaselNDSUR |15Feb 625.0 680

# Flood Contral :D1Mar 610.0 |
18 Incr RROG |01Apr 610.0 660

G40

Storage Zons | Conserration | Description | A2 described on Plate 7-01 UfD!E

>

[ Dec RROC {1 SMay 8301
[ IndSurch-EmergencyRegulation 515NDV 630.0
1B MinWa(250) |01Dec 625.0
@ MaxReleaseFLDCON |

| ower Flood Control
M@ Incr RROC

6200\ /

Elevation ()

GO0

(@ Dec RROC 580 T T T T
gmin\f\f@(%ﬂ) | Jan Mar May Jul Sep Mov
haxReleaseFLOCON I
-
(@ MinAQ(250)
I8 Dec RROC L %
[@ Incr RROC
1 MaxReleaseFLOGON ] Allow Multi-year Seasanal Data
[@ Fower Time Series 1
@ Power Guide Curve
o inactive

Starting Year |

[] Define Zone with Time-Seties

[ OK I [ Apply ] [ Cancel

Figure 11.8 Reservoir Editor--Operations Tab: Zone Editor

To define the top of zone curves, do the following for each zone:

1. Select the Zone in the operations tree to access the Zone Editor
containing the data for that zone.

2. Enter the Date and Top Elevation values in the table to define
the curve for the zone. You can either copy and paste data from
a spreadsheet application or type in the values manually. Note
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that dates often do not copy and paste correctly and must be
entered manually.

A

Be careful when copying “Date”” data from a spreadsheet.
Most spreadsheet applications use their own specialized
numeric format for dates. Only ‘text’ can be pasted into a
date cell in ResSim.

Dates are entered in a ddmmm format with the month as a three-
letter abbreviation. Dates can also be entered with the calendar
tool (which can be accessed by double-clicking in a date cell and
then clicking the small ellipse button that appears on the right
side of the cell).

If you wish to define the zone with a HEC-DSS time-series
record, select the Define Zone with Time Series check box.
You will still need to define a default zone in the table, but that
zone definition will be overridden by the time series that you will
later select for the zone on the time-series tab of the Alternative
Editor (Chapter 13, Section 13.7).

When you have finished entering top of zone curves for a zone,
be sure to click the Apply button before moving on to the next
zone.

A

Be careful when defining each zone curve — zones MUST NOT
cross each other.

11.3.4  Deleting Operation Zones

To delete a zone from an operation set:

1.
2.

Select the Zone you wish to delete from the operations tree.
Select Delete from the Zone menu or select Delete from the
shortcut menu by right-clicking on the zone you wish to delete in
the operations tree.

Click OK in the Delete Storage Zone dialog box to complete the
delete process.

A

The Inactive Zone is a special zone in the operation set. If you
delete the Inactive Zone from the operation set, it cannot be
reestablished.
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11.4 Understanding Reservoir Operation Rules

Operation Rules represent the flow goals and constraints upon the releases
for each zone of the operation set. Each zone can contain a different set of
rules depending on the flow limits and requirements of that zone within the
regulation plan. As previously described in Section 11.3.3 and illustrated in
Figure 11.8, the rules and zones appear in the Operations Tree on the left
side of the Reservoir Editor’s Operations tab window.

11.4.1 Release Decision Process

When a set of rules exist within a reservoir zone, the decision logic first
determines what the release would be for Guide Curve operation
(Section 11.7). Then, working from the “lowest to the highest” priority
rule, the program adjusts the release to meet each rule. If two rules
contradict each other, the higher priority rule applies (see Section 11.4.5
for a description of prioritizing rules).

The release decision process has 3 basic steps:

1. Identify the maximum and minimum physical limits on the
release. This is the allowable release range.

2. Narrow the allowable release range by applying the rules in the
current zone, starting with the highest priority rule (see Section
11.4.5 for a description of prioritizing rules). For example, if a
higher priority rule defines a more restrictive limit on the range
than is currently defined by a lower priority rule, then the more
restrictive limit is applied. However, if a higher priority rule
defines a release limit which allows all the releases in the current
release range defined by lower priority rules, then the higher
priority rule has no effect on the release range.

3. Evaluate the desired release for the basic Guide Curve operation
(Section 11.7). This is the release needed to get the reservoir to
the guide curve in the current time step (computation interval)
based on the starting pool elevation, the prior release, and the
current inflow.

If the desired release falls within the allowable release range, then the
release decision will be the desired release determined in Step 3 above.
However, if the desired release is outside the allowable release range
determined in the first two steps above, the release will be set to the limit
closest to the desired value.

11.4.2  Using Existing Rules

Once you have defined a rule, you can include it in more than one zone
by selecting Use Existing from the Rule menu of the Reservoir Editor.
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a zone or to an operation set. Therefore, any given rule can
be used in more than one zone and in more than one
operation set. So, be careful — a change to a reservoir’s rule
in one operation set carries through all operation sets in the
current Network that use that rule.

i Rules belong to the Reservoir in the current Network, not to

11.4.3 Removing Rules

You can remove a rule from a zone by highlighting the rule in the
operations tree and then selecting Remove from the shortcut menu (or
select Remove from Zone from the Rule menu of the Reservoir Editor).
You can also remove the rule from “all zones” by selecting Remove
Rule From All Zones from the shortcut menu (or select Remove from
All Zones from the Rule menu). Similarly, you can remove “all rules”
from a zone by highlighting the zone and then select Remove All Rules
in this Zone from the shortcut menu (or from the Zone menu, select
Remove all Rules). Removing a rule from a zone does not delete the
rule. The rule still exists in the reservoir for inclusion in other zones and
operation sets.

11.4.4  Deleting Rules

To delete a rule from the reservoir, you can use the Delete option from
the Rule menu. Use caution when deleting rules. When you delete a
rule, it will no longer be available in any of the zones in this, or any
other, operation set for this reservoir in the current reservoir network.

11.4.5 Prioritizing Rules

You must prioritize the rules within a zone, with the highest priority rule
being at the top of the list. To raise or lower the priority of a rule within
the rule list for the current zone, use the Increase/Decrease Priority or
Move to Top/Bottom options in the rule’s shortcut menu or from the
Rule menu. In Section 11.5, pay special attention to the discussion for
each rule type. Some rules, such as the Induced Surcharge rule (Section
11.5.6), may need to be the highest priority rule in a zone.

11.4.6  Renaming Rules

To rename a rule, highlight the rule in the operations tree and select
Rename from the shortcut menu (or select Rename from the Rule menu
of the Reservoir Editor). Use caution when renaming rules. If you
rename a rule, all instances of the rule will be renamed (i.¢., the rule’s
existence within all reservoir zones and operations sets for the reservoir
in the current reservoir network).
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11.5 Defining Reservoir Operation Rules

This section explains how to define a variety of rules using the different rule
types available in ResSim for reservoir Pools, Outlets, and Outlet Groups.
Rule types differ depending on whether you apply the rule to the reservoir
Pool, a Dam (or Diverted Outlet), an Outlet Group, a Controlled Outlet,
a Power Plant, or a Pump. The Operations tab of the Reservoir Editor
provides a separate editor for each rule type, as listed below and described
in subsequent sub-sections.

Rules for the Reservoir Pool include:

e Release Function

e Downstream Control Function
e Tandem Operation

e Induced Surcharge

e Flow Rate of Change Limit

e FElevation Rate of Change Limit
e Script

Rules for the Dam (and for Diverted Outlets and for Outlet Groups and
for Controlled Outlets) are as follows:

¢ Release Function
¢ Flow Rate of Change Limit
e Script

Rules for Power Plants are as follows:

Release Function
Flow Rate of Change Limit
Hydropower Requirements:
0 Hydropower Schedule — Regular
0 Hydropower Schedule — Time Series
0 Hydropower Schedule — System
0 Power Guide Curve
Script

Rule for a Pump is as follows:

e Pump Schedule
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11.5.1 Adding a New Operation Rule to a Zone

When you create a rule, you must name it, assign the rule to a specific
sub-element of the reservoir, and select the rule type. The list of
available sub-elements includes: the reservoir Pool (identified by the
name of the reservoir); the Dam (identified by the reservoir name
hyphenated with the dam name); Diverted Outlets; Outlet Groups,
Controlled Outlets; Power Plants; and Pumps.

To add a new operation rule to a zone:

1. Highlight the appropriate Zone in the operations tree.

2. Select New from the Rule menu of the Reservoir Editor. The
New Operating Rule dialog box will open.

3. Select the control element of the reservoir to which you will

assign this rule (reservoir pool, dam, outlet group, outlet) from
the Operates Release from list (Figure 11.9).

X New Operating Rule E|
Rule Mame:
Qperates Release From: w

Rule Type:

Savers-Dam
Savers-Main Gates

Savers-Spillway Diversion

[ Ok H Cancel J

Figure 11.9 New Operating Rule

4. Select the Rule Type from the list. The available rule types will
depend upon whether you have selected a pool, dam, outlet, etc.,
as listed in Section 11.5

5. Enter a Name for the new rule.
6. Click OK to close the New Operating Rule dialog box.

The new rule will appear, highlighted, in the operations tree and the edit
panel will display the rule editor based on the rule type. The first two
fields for each rule editor contain the name of the rule and its
description. A description of the rule can be added or changed whenever
the rule editor is displayed in the edit panel. See the following sections
to determine how to define the appropriate data for your new rule.
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11.5.2 Adding an Existing Rule to a Zone

Once you have created a rule in a zone, you may want to use that same
rule in another zone.

To add an existing operation rule to a zone:

1. Highlight the appropriate Zone in the operations tree.

2. Select Use Existing from the Rule menu of the Reservoir Editor
or Use Existing Rule from the zone’s shortcut menu. The Select
Existing Rule dialog box will open (similar to Figure 11.10
which shows an example list of existing rules).

X, Select Existing Rule @

Rule Mame Operates Rule Type Downstream
Release From Location
MaxRel_BeechCkStation Sayers Downstream Contral Function |Beech Ck Station
MaxCC(4531)_BeechCkStation Sayers Downstream Contral Function |Beech Ck Statian
MinRel(1 30i_AtSite Sayers-Dam Release Function
ROC_Incr Sayers-main Gates Flow Rate of Change Limit
ROC_Decr Sayers-hain Gates Flow Rate of Change Limit
MaxRel FLDCOM Sayers-hain Gates Release Function
Dec RROC Sayers-Main Gates Flow Rate of Change Limit
Incr RROC Sayers-hain Gates Flow Rate of Change Limit
IndSurch-ErmergencyRegulation Sayers Induced Surcharge
MaxRel INDSUR Sayers Release Function
Maintain Peak Release Sayers-hain Gates Flow Rate of Change Limit
MintWQ(250) Sayers-hain Gates Release Function
[] Add Rule To &ll Zones
Ol l [ Cancel

Figure 11.10 Select Existing Rule

3. Select the rule you want to add from the list. Only those rules
defined for the current reservoir but not yet used in the current
zone will be available for selection. Rules that are being used in
the current zone are included in the list, but they are grayed-out.
If you want to add the selected rule to all of the zones, then you
can check the box labeled Add Rule To All Zones.

4. Click OK to complete the Use Existing process and close the
dialog box.
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11.5.3 Defining a Release Function Rule

The Release Function rule type is one of the two most powerful rule
types available (the other being the Downstream Control Function
rule). With this rule type, you can define a wide array of “function of”
rules, meaning release is a function of date or pool elevation, etc. This
rule can be assigned to any of the release elements (pool, dam, or outlet)
and it allows you to specify the maximum, minimum, or specified flow
to be released through the release element.

Use specified limit type rules with caution. Most

A operation rules describe either a minimum or maximum
limit. Specified rules describe the precise amount of flow
to be released, neither more or less, making them
effectively both a minimum and a maximum limit at the
same time. Therefore, a specified release rule is very
restrictive because it sets the allowable range of the
release to a single value.

The simplest rules defined with this rule type are those where the release
limit is a function of date. Rules of this type are seasonally-varying
release limits. For example: “the maximum release from the reservoir
during the growing season is 6500 cfs and 8500 cfs during the non-
growing season”.

The more complex rules that can be created with the Release Function
rule type are those where the release limit is a function of an internal
(model) variable or an external variable or a state variable. For example,
a complex rule might be where the minimum release is a function of the
inflow to the reservoir. Inflow to the reservoir is just one of many
internal or “model” variables that can be used to create a “function of
model variable” rule. The “function of external variable” rule is also
very powerful, limited only by your imagination and the time-series data
available. An example of an “external variable” rule might be one
where the minimum release is a function of dissolved oxygen at a
specific gage. Since ResSim cannot compute dissolved oxygen, a time-
series record that describes the predicted or observed values for that
variable would be used to influence the release based on the function
you define. Using a “state variable” within a release function rule opens
up an endless possibility of options available for describing the
operation of a reservoir.
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To define a Release Function rule:

1. To create a new Release Function rule, follow the instructions in
Section 11.5.1. Be sure to select Release Function for the Rule
Type in the New Operating Rule editor.

2. Highlight the appropriate rule in the operations tree to access the
Release Function rule editor (Figure 11.11). The name and
description of the rule will appear in the Rule Name and
Description fields.

—‘(‘ Reservoir Editor @

Reservoir Edit  Operations Zone Rule IF_Black

Resennir |Sayers :‘ Description | Sayers Reservoir Dl @@M@@
Ehvsica\i_gmmgi Observed Data |
Operation Set 1:5_1__E_§_i_lla_Q_pg_a_[ﬁ_t\__u_l_wmo_rl_l}f___v_i Description \ Mo Downstream Cperations D\
[ Zone-Rules |7zl
8 Top of Dam Operates Release From: Sayers-Main Gates

g ‘h;llii\l:ggsEUTergeanegu\atiu Function of. | Function Mot Defined | [ Defne ]

[@ MarReleaselnDSUR
@ Flood Control
@ Incr RROC
[l Dec RROC
@ IndSurch-EmergencyRegulatio
T8 Mina(250)
(@ MaxReleaseFLDCON

Limit Type: |Maximurm | Interp.: |Linear + |

Release (undef)
=
|

T
500 700 9.00

o Lower Flood Control
[@ Incr RROG

T
1.00 3.00

[@ Dec RROC undefx
T8 Minwa(250)
@ MaxReleaseFLDCOMN Rule Function Not Defined [ Period Average Limit
L [C] Hour of Day Multiplier

B Minwia(250 % [ Day of ifeek Multiplier
g Eifgggg [ Rising/Falling Condition
@ MaxReleaseFLDCON aasnnal Varatio

o [naciive

A |

l OK l I Apply ] I Cancel

Figure 11.11 Reservoir Editor--Operations Tab:
New Release Function Rule

3. Define the Release Function. Click the “Function of:” Define...
button. The Independent Variable Definition editor will open
(Figure 11.12).

? Independent Variable Definition

Release is a Function of . |Date w

x]

Date and Time

Madel Variable
External Yariable
State Variahle

(014 Cancel

Figure 11.12 Release Function Rule, Selecting a Function
from Independent Variable Definition Editor
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4. Select the function type from the “Release is a Function of” list:
Date, Date and Time, Model Variable, External Variable, or
State Variable.

If the function type is Model Variable, select the independent
variable using the Filter chooser (Figure 11.13).

= Independent Variable Definition E(\
le

Release is a Function of

Filter

Sayers v‘ ‘ v| | v‘ Time Series Options

Tirme-Series Element Type variahle Function:
Savers Inflow junction |Known Flow

Sayers-Pool resenvoir |Luukback Elevation e (o) l:l
Sayers-Main Gates reservoir Lookback Release Period (hours): l:l
Sayers Inflow Jet junction F iy

Sayers-Dam Tailwater resenvair Flow

Sayers-Dam L&D IN reservaoir F oy

Sayers-Dam L&D reservoir F oy

Sayers Inflow junction F iy

Sayers-Spiltway Diversion Tailwater |reservair Flow

Sayers-Spillway Diversion Reach reservaoir F oy

Sayers-Main Gates IN reservoir F oy

Sayers-Main Gates reservoir F iy

Sayers-Uncontrolled Outlet IN resenvair Flow

Sayers-Uncontrolled Outlet reservaoir F oy

Sayers-Pool reservoir Elevation

Sayers-Pool reservoir Storage

Sayers-Pool resenvair Area

Sayers-Pool reservoir |Inflowy

Sayers-Pool reservoir Met Inflow

Sayers-Pool reservoir Cutilow

Sayers-Pool resemair FPurnped Vaolurme

Sayers-Pool reservoir FPumped Yolume Capactiy

Sayers-Main Gates reservoir Gate Opening

Sayers-Main Gates reservoir Capacity Factor

Selected Model Time-Series

Figure 11.13 Release Function Rule, Select an Independent
Variable from the Model Variable List

If the function type is External Variable, identify the independent
variable in the name field (Figure 11.14). This name will appear on
the time-series tab of the Alternative Editor (Chapter 13, Section
13.7).

= Independent ¥ariable Definition @

Release is a Function of

variakle Marme: | | Time Series Options

Function: CurrentValue ¥

Qs Cancel
Figure 11.14 Release Function Rule, Defining an External
Variable as the Independent Variable
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If the function type is State Variable, select the State Variable from
the list (Figure 11.15). The state variable must be defined prior to
creating a release function rule that uses it (see documentation of
State Variables in Section 11.12.1).

? Independent Variable Definition @
Release is a Function of | Gtate Variable -
State Variable Pararneter Name Pararneter Type
e Time Seties Optiohs
Function: Current Value
Lag thours)
Period (hoursy:
Selected Model Time-Seties [}\
hiyStateariable
OK Cancel

Figure 11.15 Release Function Rule, Select a State Variable
as the Independent Variable

If desired, for either the Model Time Sefies Options
Variable, or the External Eumelion
Variable, or the

CurrentValue A

Lag (hours): Current Value
1 1 Previ Wal
Stqte Varlabl_e, select' from their BN L;Z“;ZL;SVS?UZE
editors the Time Series Period Average
OptlonS (Flgure 1 116) to Feriod Maximum
define the independent variable Perind Minirmurn

with respect to each time step.
From the Function list, you can
select: Current Value,
Previous Value, Lagged
Value, Period Average, Period Maximum, or Period Minimum.
The Lag (in hours) can be specified (for all but Current and Previous
value) along with the appropriate Period (in hours).

Figure 11.16 Time Series Options
for Model, External,
and State Variables

5. Click OK to complete the definition of the independent variable
of your function.

6. Set the Limit Type as Minimum, Maximum or Specified.

Use specified limit type rules with caution. Most

A operation rules describe either a minimum or maximum
limit. Specified rules describe the precise amount of flow
to be released, neither more or less, making them
effectively both a minimum and a maximum limit at the
same time. Therefore, a specified release rule is very
restrictive because it sets the allowable range of the
release to a single value.

7. Select the Interpolation Type as Linear, Cubic, or Step (see
Section 11.6.1 for a description of how the interpolation types
work).

11-18



ResSim User’'s Manual

Chapter 11 — Defining Reservoir Operations Data

8. Define the function using the table in the release function rule

editor (Figure 11.17). You can either copy and paste data from a
spreadsheet application or type in the values manually.

j Be careful when copying date data from a spreadsheet. Most

spreadsheet applications use their own specialized numeric format
for dates. Only ‘text’ can be pasted into a date cell in ResSim.

The mini-plot will reflect the values you enter and can be viewed in
full size when you double-click on it.

» If using a function of date, you can enter a single value for

01 Jan to describe a constant release limit throughout the year
or enter multiple dates to define a seasonally varying release
limit rule. Dates can also be entered with the calendar tool,
which can be accessed by double-clicking in a date cell then
clicking the ellipse button that appears. As a date entry
option, use the calendar tool to set day and month for the date;
although the year appears in the calendar tool, it is ignored in
setting the date.

If your rule is a function of a variable, you can make your rule
seasonally varying by using the Seasonal Variation option.
Refer to Section 11.6.6 for more details.

If you wish to use Hour of Day or Day of the Week
Multipliers, refer to Sections 11.6.3 and 11.6.4 for more
details.

To make your rule applicable only under rising (or falling)
conditions, use the Rising/Falling Condition option. Refer to
Section 11.6.5 for details.

9. Check the position of your new rule with respect to the other

rules in this zone. To raise or lower the priority of a rule within
the rule list for the current zone, use the Increase/Decrease
Priority or Move to Top/Bottom options in the rule’s shortcut
menu or from the Rule menu.

An example of a completed Release Function rule is shown in Figure
11.17. When you have finished entering data for the Release Function rule,
be sure to click the Apply button before moving on to the next rule.
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X Reservoir Editor @

Reservoir  Edit  Operations Zone Rule IF_Block

Reservair iSa\;ers + | Description | Sayers Resemvoir E]| E]@ 10f1 ]@E]
:.Ehysical |_Qm“0¥| Ohserved Data |
Operation Set !AtSite Cperation Only v| Description | Mo Downstream Operations C] |

™ Top of Dam Operates Release From: Sayers-Main Gates
™ Maximum Pool

@ Maintain Peak Release

] IndSurch-EmergencyRegulation || Description | Increasing Release Rate-of- Change as a function of the prior release. (2 |
B Mintai2s0

Release Rate of Change Limit | Incr RROC

B MaxReleaselNDSUR Function Of. |Release v
o Flood Control
@ Incr RROC Type Increasing ~|
[ Dec RROC Interpolate  |Step ]
[ IndSurch-EmergencyRegulation
g m:]xvgeglfassnéFLDCON Felease (cfs) | Rate Change (cfs!hr)] =
0.0 1000 =
o | ovwer Flood Control T T ﬁ
[ Dec RROGC 400.0 340.0 n
o =
@ MaxReleaseFLDCON L = -
[ MaxRel fram MainGates : d =
# Conservation 3000.0 1200.0 o
B MinWaizs0 A000.0 1300.0 4 5
ﬁ Dec RROC B500.0 1400.0 ok B el oF ok
B Incr RROC 2000.0 400.0 i} 3000 BOO0 3000
@ MaxReleaseFLDCON 9000.0 400.0 Release (cfs)
o [nactive
A

’ Ok ] [ Apply ‘ [ Cancel

Figure 11.17 Example of Completed Release Function Rule
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11.5.4 Defining a Downstream Control Function Rule

This rule type (and its editor) is an extension of the Release Function
rule described in Section 11.5.3. Downstream control rules describe the
minimum or maximum flow (e.g., flow requirement or channel capacity)
or stage at a control point rather than an explicit limit on the release.

The final release limit will be determined based on the influence of
routing and cumulative local flows at the downstream control point.

In addition, the Downstream Control rules can be used to create system
operation (where two or more parallel reservoirs are operated to have
balanced storages while controlling for common downstream
requirements). Once created for one reservoir, the Downstream Control
rule will also be available in the List of Existing Rules (refer to Section
11.5.2) for other reservoirs in the network. To establish a system
operation, the same downstream control rule must be used in each
applicable reservoir’s operation set. Chapter 12 discusses ResSim’s
methodology for system operation and storage balancing.

When creating the Downstream Control rule, it can be assigned only to
the reservoir (pool), not to a specific outlet or outlet group, because only
the reservoir can account for all releases from the reservoir’s outlets that
could influence the flow at the downstream control point.

To enter operations data for a Downstream Control Function rule:

1. To create a downstream control rule, follow the instructions for
creating a new rule as described in Section 11.5.1. After
selecting the Operate Release From to be the reservoir and the
Rule Type to be Downstream Control Function, be sure to
select the downstream control point from the Downstream
Location list that appears when you select the Downstream
Control Function rule type. Figure 11.18 illustrates the creation
of'a Downstream Control Function rule.

X New Operating Rule @

Rule Mame: My DS Cantrol Rule

Operates Release From:  |Sayars e

Rule Type: Downstream Control Function

Downstream Location: Beech Ck Station 4
[ Qg ] [ Cancel ]

Figure 11.18 Reservoir Editor--New Operating Rule:
Downstream Control Function
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2. To define your downstream control rule, refer to Section 11.5.3
detailing how to define a Release Function rule. The
Downstream Control Function rule editor is essentially the same
as the Release Function rule editor. The only significant
difference is that you have the option of defining the rule as a
minimum or maximum Flow or Stage parameter limit at the
downstream control point (see example in Figure 11.19).

i Reservoir Editor @

Reservoir Edit  Operations Zone Rule  IF_Block

Resenvoir |Sayers +| Description | Sayers Reservair O] [W]la] 1or1 [w](m]

Physical | Operations Observed Data |
Operation Set 1At Silg Orperaliruﬂ iny ~ | Description :VNU Duwﬂisrtrearn Orperaliruﬂ’s G

Zone-Rules |

i Top of Dam
Maximum Paoal ; 1 e T —

- T8 Maintain Peak Release Rule Name: | My DS Cantral Rule Deseription: | Example of DS Contral Rule [
[@ IndSurch-EmergencyRegulation |

[ MinWa(250) Function of. | Date

,gﬂﬁifj“'”mw Limit Tyoe: [Maximum v Intety. |Linear v

Operates Release From: Sayers

@ Incr RROC Downstream Location: | Beech Ck Station
[@ Dec RROC P " r — 2t
B IndSurch-EmergencyRegulation || 2 2el Flow i
@ MinkG{250) =
1B MaxReleaseFLDCON O Al |
o Lower Flaod Control 01dan 32480
@ Incr RROC | 1
[ De: RROC [ P W |
W MinwQ250) | U Mey =i
[@ MaxReleaseFLDCON
@ MaxRel fram MainGates
[~ My DS Contral Rule |
# Conservation [ [ Hour of Day Muttinlier
g ggy}?séﬂm I [] Day of week Multiplier
[\ IncrRROC | i | Wariatior t

@ MaxReleaseFLDCON
i Inachive

3280

3260

>

3240

Flowy (ef)

I Ok H Apnly H Cancel I

Figure 11.19 Reservoir Editor--Example of a Downstream Control
Function Rule

3. Check the position of your new rule with respect to other rules in
the zone it is placed. To raise or lower the priority of a rule
within the rule list for a particular zone, use the
Increase/Decrease Priority or Move to Top/Bottom options in
the rule’s shortcut menu or from the Rule menu.

4. When you have finished entering data for the Downstream
Control Function rule, be sure to click the Apply button before
moving on to the next rule.

-
Q After a downstream control rule has been defined, the downstream

location in the display area (i.e., the watershed map) will have a box
drawn around the junction symbol.
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11.5.5 Defining a Tandem Operation Rule

A Tandem Operation rule establishes a tandem system operation where
an upstream reservoir operates for a downstream reservoir to achieve a
storage balance. Unlike the Downstream Control rule (which is the only
other rule type used for system operation and must be included in the
operation sets of all reservoirs in the system), the Tandem Operation rule
is created and included in the operation set at the upstream reservoir
only. The Tandem Operation rule simply identifies the downstream
reservoir that is the object of tandem operation. An implicit (default)
storage balance scheme is invoked by the Tandem Operation rule, and
an optional explicit (user-defined) storage balance scheme can be
defined and used instead of the default (refer to Chapter 12 for more
discussion on system operation).

When creating the Tandem Operation rule, it can be assigned only to the
reservoir (pool), not to a specific outlet or outlet group, because only the
reservoir can account for all releases from the reservoir’s outlets that
could influence the flow into the downstream reservoir.

To enter operations data for a Tandem Operation rule:

1. To create a Tandem Operation rule, follow the instructions for
creating a new rule as described in Section 11.5.1. Be sure to
select the reservoir for the release component (Operates Release
from) and Tandem Operation for the Rule Type in the New
Operating Rule editor. Figure 11.20 illustrates the creation of a
Tandem Operation rule.

X New Operating Rule E

Rule Marng: Wy Tandem Operation Rule

Operates Release From:  |Sayers W

Rule Type: Tandermn Operatian

I O H Cancel J

Figure 11.20 Reservoir Editor--New Operating Rule:
Tandem Operation

2. To define your Tandem Operation rule, highlight the rule in the
operations tree of the reservoir editor (Figure 11.21). In the Edit
Panel, you can enter a Description, and most importantly select
the Downstream Reservoir for which the current (upstream)
reservoir is operating.
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? Reservoir Editor @
Reservair Edit  Operations Zone Rule IF_Block

Resemoir |Sayers + | Description | Savers Resenvoir 2] [}(a]) 1 orz[p](n]

Physical| Operations | Opserved Data

Operation Set |System OpSet ~ | Description | [=]

Zone-Rules

@ Flood Contral || perates Release Fram: Sayers

# Conservation Tand o Rl

[ Wiy Tandem Operation Rule andem Operation Rule | My Tandem Operation Rule |
o nactive Description [:]
Downstream Reservair Millhouse |

Figure 11.21 Reservoir Editor--Example of a Tandem Operation Rule

3. Check the position of your new rule with respect to other rules in
the zone it is placed. To raise or lower the priority of a rule
within the rule list for a particular zone, use the
Increase/Decrease Priority or Move to Top/Bottom options in
the rule’s shortcut menu or from the Rule menu.

4. When you have finished setting up the Tandem Operation rule,

be sure to click the Apply button before moving on to the next
rule.

11.5.6  Defining an Induced Surcharge Rule

Induced Surcharge is a flood control operation that specifies
emergency releases when the current pool elevation and rate of increase
in inflow (or change in pool elevation) threaten to overtop the dam. This
operation may necessitate releases that exceed channel capacity

constraints. A reservoir must have a gated outlet to employ induced
surcharge operations.

Induced Surcharge operation is achieved by physically regulating the
position of spillway gates. When the gate opening is reduced to limit
release to less than free overflow (the fully-open position), water is
intentionally surcharged—or stored—behind the gates. For this reason,
induced surcharge is also referred to as a gate regulation operation.
Induced Surcharge operation allows operators to better manage a flood

event by using additional reservoir storage volume above the spillway
crest.

11-24



ResSim User’'s Manual Chapter 11 — Defining Reservoir Operations Data

In HEC-ResSim, the Induced Surcharge rule must be defined and
entered as the highest priority rule in every zone spanning elevations
between the top of the dam and the lowest elevation from which the gate
can be regulated, generally, the controlled spillway crest. Additionally,
a Release Function rule (Section 11.5.3) with Limit Type set to
Maximum must be defined and entered as a lower priority rule in each
of the applicable zones (below the induced surcharge rule). This
maximum flow corresponds to the maximum discharge when surcharge
operations are not in effect. It is essential to enter this maximum flow
limit to guide releases back towards flood control operations after
surcharge operations finish. Note that when creating a new rule, the
Induced Surcharge option is only available if the “reservoir itself” is
selected for Operates Release from: (“Sayers” in Figure 11.22, not
“Sayers-Dam” or “Sayers-Gate”).

X New Operating Rule @

Rule Mame: InducedSurch-EmergReq
Operates Release From: |Sayers w
Rule Type: Induced Surcharge

[ Ok H Cancel

Figure 11.22 Reservoir Editor--Operations Tab:
Create Induced Surcharge Rule

Within the Induced Surcharge rule editor (Figure 11.23), the Induced
Surcharge Curve, Time of Recession, and Falling Pool Options
determine the magnitude and duration of gate-regulated releases, and
how emergency release should transition back to normal flood control
releases. The mini-plot will reflect the Elevation vs. Release values you
enter for the Induced Surcharge Envelope and can be viewed in full size
when you double-click on it.
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Operates Release From: Sayers

Induced Surcharge Rule | InducedSurch-EmeraReq

Description | Emergency Reservoir Regulation - based on info on Plate 7-07 of Reg Manual, Gate Regulation Curves

Interpolation Type Linear w
661.5
Induced Surcharge Envelope Curve:
661.0
Elevation (ft) Release (cfs) 660.5
6570 0.0] A 660.0
Ga7.5 1000.0 i
B58.0 2000 | & 5995
G58.9 3800.0 £ 659.07
f59.0 5900.0 T pogs-
i)
659.5 8600.0 T gsgnA
GE0.0 12300.0 i
BBOL5 16800.0 B8
G61.0 23300.0 65707
fifi1.25 28000.0 656 .5 +——1—T—1—
1] 10000 20000 30000
b Release (cfs)
Time of Recession thrs): [=}

Falling Pool Options

l Inflowe Time Series Options ..

Figure 11.23 Induced Surcharge Rule Editor

To enter operational data for an Induced Surcharge rule:

1.

Highlight the appropriate rule in the operations tree to access the
Induced Surcharge rule editor (Figure 11.23). The name and
description of the rule will appear in the Induced Surcharge
Rule and Description fields.

Select the Interpolation Type as Linear or Cubic (Section
11.6.1).

Enter Elevation and Release data into the table to describe the
Induced Surcharge Envelope. This envelope defines the lower
limit of allowable regulated release when the pool is at a certain
elevation. The rule will compute a higher release as described in
EM 1110-2-3600 (USACE, 1987). You can either copy and
paste data from a spreadsheet application or type in the values
manually.

Enter the Time of Recession in hours. This constant describes
the length of time an incoming flood is expected to take to
recede. The program uses this time to compute the volume of
water that must be evacuated to prevent overtopping the dam.
See discussion in EM 1110-2-3600 (USACE, 1987) for further
documentation regarding the Recession Time constant parameter
(Ts).
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5. To see a plot containing the computed Induced Surcharge
Curves (Figure 11.24) based on the data you have entered,
double-click on the mini-plot located to the right of the table (or,
you can right-click on the mini-plot and select Show popup).

? Induced Surcharge Curves Plot EJ@E|

File Edit Wiew Options

580 E———

EED‘W"--_{_
g40 |

g20

Eles (i)

500

S60 T T T T T
o] 50000 100000 150000 200000 230000 300000

Flowe (cfs)

—  Surchargs Enwelope 10,000
——  zo00 30,000
40000 50,000
70,000
Discharge Capacity Discharge Curve

Figure 11.24 Plot of Computed Induced Surcharge Curves
(with the Discharge Capacity Discharge Curve)

— 60,000
— 80,000

The Induced Surcharge Curves Plot menu bar consists of the
“generic” File, Edit, and View menus that are described in Chapter
14 (Section 14.5.2) and in Appendix F.

The Options menu (Figure 11.25) is Cptiarns

specific to the Induced Surcharge Curve 30 i Y oo
Plot and contains the following options to Plot Rate OF Rise

allow access to the Inflow and Rate of Rise
editors: Figure 11.25 Options
Menu (from Induced
Surcharge Curves Plot)

v Show Discharge Capacity

» Edit Inflows for Curves...
Allows for specifying the inflow values
which may be used in displaying an

example plot of induced surcharge

release curves in the zone below the ooting
envelope curve. Figure 11.26 shows 5 e
the inflow values corresponding to : o000
the inflow curves. zoons
> Plot Rate Of Rise will generate a st
plot of the rate of rise curves (if
given). When this option is Figure 11.26 Edit Inflow

checked, the “Edit Rate of Rise for ¢,/ curves. . (from
Curves ...” option appears in place Options Menu of Induced
of the “Edit Inflows for Curves...” Surcharge Curves Plot)
option.
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» Show Discharge Capacity is a toggle to indicate whether or not
to include the Discharge Capacity Discharge Curve in the plot.
Figure 11.27 shows the Induced Surcharge Curves Plot without
the Discharge Capacity Discharge Curve.

R Induced Surcharge Curves Plot g@]g‘
File Edit View Options
]
BE2
@]

GG

B55

BSE

~
G547

Elev(

- o
) e
" ,/”

B 7

Ed4 T T T T T
a000 10000 16000 20000 28000 30000

Flow §
0.5

Surcharge Envelope 05 —

‘— 1.5

Figure 11.27 Plot of Computed Induced Surcharge Curves
(without the Discharge Capacity Discharge Curve)

6. Next, select Falling Pool Options by clicking the Edit button
beside the Falling Pool Options label. The Falling Pool
Options dialog box will open (Figure 11.28).

= Induced Surcharge - Falling Pool Options g|
Time for Pool Decrease thrs) a
Falling Pool Transition Elev ift): 655.0
Release Options
() Ratio of Inflaw
Release times Inflow averaged over hours

O Mg of Inflowe and Previous Release
Inflowy averaged aver hours

Figure 11.28 Induced Surcharge--
Falling Pool Options

> Enter the Time for Pool Decrease in hours. This parameter
describes the required number of successive hours the reservoir
pool level must be falling before transitioning from rising pool
emergency spillway releases to falling pool releases.
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» Enter the Falling Pool Transition Elevation in feet (meters).

This parameter represents the pool elevation above which Falling
Pool releases will be made. Once the pool elevation falls below
this elevation, the Induced Surcharge rule will no longer operate,
and ResSim will resume releases based on other rules in the
active zone.

For Release Options, choose Ratio of Inflow, Average of Inflow
and Previous Release, or Maintain Peak Release to designate the
method for computing falling pool releases. Falling Pool
Releases will be made after the pool begins to fall and until the
pool level returns to the Falling Pool Transition Elevation.

e For Ratio of Inflow, enter the Release ratio times inflow
averaged over number of hours.

e For Average of Inflow and Previous Release, enter the
number of hours for the Inflow to be averaged over.

Click OK to close the Falling Pool Options dialog and a
checkmark will display in the box beside Falling Pool Options in
the Reservoir Editor.

Pressing the Inflow Time Series Options button activates the
Inflow Time Series Options editor (Figure 11.29). This editor
defines how the reservoir inflow time series is interpreted and
used in making induced surcharge operation release decisions.

? Inflow Time Series Options @

Functian: Previous Walue

Lag (hours):

Feriod fhours):

(0]:4 Cancel

Figure 11.29 Induced Surcharge--
Inflow Time Series Options

The Function list includes Current Value, Previous Value,
Lagged Value, Period Average, Period Maximum and Period
Minimum.

Enter the optional Lag (in hours) for all functions except Current
and Previous.

The Period (in hours) is applicable for Period Average, Period
Maximum and Period Minimum functions.
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11.5.7

9. Check the position of your new rule with respect to the other
rules in this zone. To raise or lower the priority of a rule within
the rule list for the current zone, use the Increase/Decrease
Priority or Move to Top/Bottom options in the rule’s shortcut
menu or from the Rule menu.

10. When you have finished entering data for the Induced Surcharge
rule, be sure to click the Apply button before moving on to the
next rule.

Defining a Flow Rate of Change Limit Rule

A Flow Rate of Change Limit rule specifies the allowable change when
increasing or decreasing release values (i.e., “ramping rates”). A single
rule of this type will only limit a rising release or a falling release, but
not both. To describe both increasing and decreasing limits, you must
define two rules and set the type of one to increasing and the other to
decreasing. A rule of this type can be assigned to any release element to
influence the behavior of that element.

To enter operations data for a Flow Rate of Change Limit rule:

1. To create a new rule, follow the instructions in Section 11.5.1.
Be sure to select Flow Rate of Change Limit for the Rule Type
in the New Operating Rule editor.

Operates Release From: Sayers
Release Rate of Change Limit | PoolFlowlncrRoOC_500cfs

Description | Paal rule: Increasing Release Rate of Change of 800 ofs per haur ]
Function Of. Caonstant 4
Type Increasing w
Max Rate of Change (cfsihr) 500

Figure 11.30 Reservoir Editor--Operations Tab:
Flow Rate of Change Limit Rule

2. Highlight the appropriate rule in the operations tree to access the
Flow Rate of Change Limit rule editor (Figure 11.30). The
name and description of the rule will appear in the Release Rate
of Change Limit rule and Description fields.

3. For Function Of:, select either Constant, Reservoir Inflow,
Release, or Pool Elevation.
For Type, select either Increasing or Decreasing.

5. Enter the Max Rate of Change value. The limit is described in
units of flow (cms or cfs) per hour, regardless of the compute
interval. For example, if you enter 500 cfs/hr with a compute
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interval of 12 hours, then this rule describes the maximum flow
change per time step as 6000 cfs.

If your Function Of: selection is Constant, enter a single value
for the limit.

If your Function Of: selection is Reservoir Inflow, Release, or
Pool Elevation, then a table will appear to allow you to describe
how the rate of change is influenced by the selected independent
variable. Additionally, select the type of Interpolation to apply
to the curve as either Linear, Cubic, or Step (Section 11.6.1).

Check the position of your new rule with respect to the other
rules in this zone. To raise or lower the priority of a rule within
the rule list for the current zone, use the Increase/Decrease
Priority or Move to Top/Bottom options in the rule’s shortcut
menu or from the Rule menu.

When you have finished entering data for the Flow Rate of
Change rule, be sure to click the Apply button before moving on
to the next rule.

11.5.8 Defining an Elevation Rate of Change Limit Rule

An Elevation Rate of Change Limit rule describes the allowable
change when increasing or decreasing pool elevation values. A single
rule of this type will only limit a rising pool or a falling pool, but not
both. To describe both increasing and decreasing limits, you must
define two rules and set the type of one to increasing and the other to
decreasing. Since this rule watches the pool elevation, you can assign
this rule only to the pool (reservoir), not to the dam or to a discrete

outlet.

To enter operations data for an Elevation Rate of Change Limit rule:

I.

To create a new rule, follow the instructions in Section 11.5.1.
Be sure to select the reservoir for the Release Element and Elev
Rate of Change Limit for the Rule Type in the New Operating
Rule editor.

Highlight the appropriate rule in the operations tree to access the
Elevation Rate of Change Limit rule editor (Figure 11.31).

The name and description of the rule will appear in the Elevation
Rate of Change Limit Rule and Description fields.
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QOperates Release From: Sayers
Elevation Rate of Change Limit | PoolElevincrROC_3f

Description | Poal rule; Increasing Elevation Rate of Change of 3 feet per hour ]
Function Of |Caonstant b
Type Increasing 4

#) Instantaneous
() Period Average
Max Rate of Change (ft'hr) 3

Figure 11.31 Reservoir Editor--Operations Tab:
Elevation Rate of Change Limit Rule (Pool)

3. For Function Of:, select either Constant, Reservoir Inflow, or
Release.

4. For Type, select either Increasing or Decreasing.
5. Choose either Instantaneous or Period Average.

» For Instantaneous, enter the Max Rate of Change value in
units of meters (feet) per hour.

» For Period Average, specify the Max Change and the
number of Hours over which the change is allowed.

6. Check the position of your new rule with respect to the other
rules in this zone. To raise or lower the priority of a rule within
the rule list for the current zone, use the Increase/Decrease
Priority or Move to Top/Bottom options in the rule’s shortcut
menu or from the Rule menu.

7. When you have finished entering data for the Elevation Rate of
Change Limit rule, be sure to click the Apply button before
moving on to the next rule.
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11.5.9 Defining Hydropower Rules

Hydropower rules specify the minimum releases needed from a
reservoir’s power plant (or from the power plants in a reservoir system)
to meet a power generation requirement and schedule. The desired
release is a function of the plant’s generation capacity, the hydraulic
head, and the required energy. In the various hydropower rules, the
generation requirement can be specified as a function of storage, season,
or be directly specified as an external time series.

There are four different Hydropower rule types (Figure 11.32) available
for you to create a rule that describes a Hydropower Requirement:
Schedule, Time Series, Power Guide Curve and System Schedule.
Data entry for these rules will be described in the following sub-

sections.
X New Operating Rule @
Fule Mame: SchedPower
Operates Release From: |Sayers-Power Plant b
Fule Type: Release Function

Release Function
Flow Rate of Change Limit
Hydropower - Power Guide Curve

Hydropower - Schedule

Hydropower - Systermn Schedule
Hydropower - Time Series Reguirement
Script

I (0]4 H Cancel ]

Figure 11.32 Hydropower Rule Types

11.5.9.1 Hydropower — Schedule

The Hydropower — Schedule rule allows you to define a regular
monthly or user specified seasonally varying hydropower
requirements. The various options on this rule editor allow you to
define each month’s power generation requirement, the type of the
requirement (megawatt-hours or plant factor), and the hours of the
day and days of the week during which the plant can generate.

To define a Hydropower — Schedule Requirement rule:

1. To create a new rule, follow the instructions in Section 11.5.1.
Be sure to select the power plant for the Release Element and
then select Hydropower — Schedule for the Rule Type in the
New Operating Rule editor.
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2. Highlight the appropriate rule in the operations tree to access the
Hydropower — Schedule rule editor (Figure 11.33). The name
and description of the rule will appear in the Hydropower —
Schedule rule and Description fields.

? Reservoir Editor
Reservair  Edit  Operations Zone Rule IF_Block
Reserair Sayers 7v Description | Sayers Reservoir ] E@ 10of2 @@
Physical| Operations | opserved Data
Operation Set At Site Operation Only | Destription | No Downsirearm Operations ]
| Zone-Rules ||
¥ Top ofDam Operates Release From: Sayers-Power Plant
& Maximum Pool I §
[@ Maintain Peak Release Hydropower - Sthedule Rule | SchedPower |
@ InducedSurch-EmergRey —
B MinWasn Description |
8 MaxRelzaselNDSUR
& Flood Contral Power Generation Reguirement
[@ Incr RROG - - 1.0
[l Dec RROC Monthly Requirement 0 8:
@ InducedSurch-EmergReg Manth (hib) o
B Miniva(250) T oo o 06
@ MaxReleaseFLDCON Fon 00| 4]
™ Lower Flood Control Mar ool £ 4
@ Incr RROC Apr 0o 0,24
@ Dec RROC WMay 0o 0 u_
@ Mina(250) Jun 0o ! L
B MaxReleaseFLDCON g 00 el g L
[@ SchedPower Aug 00
& Consenvation 520 ] Power Generation Pattern
[E Min¥o(260) Oct ]
[@ De: RROC oY 0o
@ Incr RROC Dioe 0o
[l MaxReleaseFLDCON
chedPower]
o inactive
[ ok J[ meey | cancel
Figure 11.33 Hydropower — Schedule Rule Editor
3. Click the Options button to S ———— =
Open the Power Generat|0n Requirement Varies (Il M

Requirement editor (Figure
11.34).

» From the Requirement
Varies list select either
Monthly or Seasonally.

» From the Requirement
Specified as list you can
select Plant Factor,
Daily Total MWH,

Weekly Total MWH, or

Monthly Total MWH.

Reguirement Specification
Reguirement Specified as:
Starting Day:

Week belongs to a month
when this day is in the manth:

Feriod over which Generation Reguirement is satisfied

Period: Each Time-Step hd

Starting Day of Period: |Sunday

Monthly Total MWH v
Sunday

Sunday

l

Ok H Cancel ]

Requ

Figure 11.34 Power Generation

irement Options

If Weekly Total MWH is selected from the Requirement
Specified as list, then you must select the Starting Day of
the power week as one of the seven days of the calendar
week. You will also need to select a day of the week, which
by its inclusion in both a power week and a month,
determines which month to include that power week.
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> Finally, select the Period over which the requirement will be
satisfied as being Each Time-Step, Daily, or Weekly. If
Weekly is selected, then you will need to select the Starting
Day of Period.

Complete the power requirement table as appropriate, depending
on the options selected in the previous step. For example, if
Monthly Requirement in MWH was selected, then enter the total
monthly requirement for each month of the year.

Click the Power Generation Pattern button to open the Power
Generation Pattern editor. Please see Section 11.5.9.5 for a full
description of the purpose and use of the Power Generation
Pattern editor.

Check the position of your new rule with respect to the other
rules in the zone. To raise or lower the priority of your rule
within the rule list for the current zone, use the
Increase/Decrease Priority or Move to Top/Bottom options in
the rule’s shortcut menu or from the Rule menu.

When you have finished entering data for the Hydropower -
Schedule rule, be sure to click the Apply button before moving
on to the next rule.

11.5.9.2 Hydropower — Time Series Requirement

The Hydropower — Time Series Requirement rule allows you to
define an irregular schedule of Hydropower requirements through
the use of a DSS time-series record. There are no options in this rule
editor. Instead, a message is placed there to remind you that you will
need to specify a time series of required power in units of megawatts
when you devel